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1. Introduction
This manual covers all current editions of Business Accountz. Features that 
are unique to certain versions are marked as such. For example, the Supplier 
Records component is only available in Business Accountz Enterprise, where-
as the simpler Supplier Table is available in all three editions. Likewise, the 
Customer Table component is available universally, but the more sophisti-
cated Customer Records is available in Professional and Enterprise only. 

Business Accountz Basic is a bookkeeper's dream. It covers all main transac-
tion types and all reports can be viewed or exported to a spreadsheet from 
where they can be further manipulated and emailed or printed. 

Business Accountz Professional adds the documents feature to Basic. This lets 
you design invoices and all reports using the Accountz Designer so you can 
also print direct from the software. It also includes full customer tracking. 

Business Accountz Enterprise unlocks full supplier tracking, automated en-
tries, events and reminders and much more and includes the ability to add new 
modules as they become available. 

About this manual
The manual consists of 2 main parts:

Introduction and Tutorial (chapters 1 to 4)

User Manual (chapters 5 to 14) 

The tutorial takes you step by step through the most common business proc-
esses, from entering a sale to producing a VAT return. The tutorial is intended 
to be read from beginning to end to give you a good idea of how the software 
can be made to work for your business. This manual is searchable when viewed 
on-screen and there is further help via the user forums and online videos (via 
the Help > Online Help menu option) that will show you how to do most of the 
things required to help you run the financial side of your business. 

•

•
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The user guide explains every window and every button. Business Accountz 
is constantly being updated and refined. The user guide is intended for you 
to be able to browse or read the relevant help as and when you need it. The 
component descriptions are laid out in the same structure as the Accountz 
menu bar.

Welcome
Welcome to the Accountz user manual. You have made a wise decision in 
your choice of software. Accountz has made a great deal of effort to produce 
the most sophisticated and intelligent, yet user-friendly accounting software 
system seen on any computer platform. 

Installation details follow, but we would urge you to read this short introduc-
tion first.

Accountz is based on the world professional standard of double-entry ac-
counting. However, Accountz differs from other professional software in the 
way double-entry is presented to you, the user. We have removed the jargon 
and transformed the process. Instead of Credit and Debit, you now have From 
and To. Here is an example of how this simple transformation turns double-
entry from difficult to easy: 

Suppose we pay business rates by direct debit from our bank. In a typical 
double-entry software system you would make 2 entries. The first would debit 
your business rates account. The second would credit the bank (yes, credit). 
Both entries would be for the same amount, hence the books would balance 
and all is well.

Account Debit Credit

Business Rates 100  

Bank  100

Fig. 1. Traditional double-entry journal 
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The problem is, what exactly does a ‘credit’ mean when we are taking money 
from the bank? How does taking your money from your bank result in a credit 
entry? And worse, how can we remember that without taking a course in ac-
countancy? 

Well, you don’t need to!

Here is how this same transaction looks given the Accountz treatment: 

From To Amount
Bank Business Rates 100

Fig. 2. Accountz alternative transaction 

Replacing Credit with From and Debit with To simplifies everything. Having 
a single amount column guarantees the transaction balances. The point is this: 
accounting for your business means tracking the flow of money in, around and 
out of your business.

When you make any payment the money flows from your bank (or credit card 
etc.) to some expense or other account. This from and to concept is all you 
need to remember. It will enable you to logically understand and enter any 
type of transaction. 

When you pay off your business credit card each month from your bank, the 
money flows from  your bank to your credit card account. 

From To Amount
Bank Credit Card 100
Fig. 3 

When you make a sale, the money flows from a sales account to your bank. 

From To Amount
Sales Bank 100
Fig. 4 
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Once you have this single rule fixed in your mind, accounting with Accountz 
will become a pleasure. 

And if you want to impress your accountant/bank manager/tax inspector, just 
remember the rule: 

	 Credit = From

	 Debit = To 

Alphabetically they are in the same order (C before D, F before T) so it is even 
easier to remember should you need it. 

Accountz is unique amongst accounting software. It has simplified the dou-
ble-entry accounting system. Use it with confidence and it will pay dividends 
by saving you time, giving you better financial control, and therefore saving 
you money. 

�

•

•
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2. Installation and Backing Up
Place the CD into your CD/DVD Rom drive then follow the instructions de-
pending on which computer system you are installing it on. 

Windows XP and Vista
The Business Accountz installation wizard should run automatically. If noth-
ing happens after 10 seconds, it may be that your auto-run option is turned off. 
In this case click on My Computer, then right click on your CD/DVD Rom 
drive and choose the Run option to start the installation wizard. 

Mac 
Before installing Business Accountz please make sure you run the 
Mac Software Update option (from the Apple menu on the top left of 
the screen). It is important you at least ensure any Java updates are in-
stalled.

After ensuring your system is up to date, insert the Business Accountz 
CD (or go straight to step 3 if you downloaded it). A window should 
open displaying a file called Business Accountz.dmg. If it does not, 
please click on the Go button (from the system menu at the top), then 
Computer then your CD Rom icon.

Double-click the Business Accountz.dmg file to open the Business Ac-
countz package installer.

Double-click the Business Accountz.pkg installer file (that has just 
opened from step 3) to run the installer. 

Linux
Different distributions of Linux have different installation processes, so please 
also refer to the instructions in your Linux distribution for installing applica-
tions.

1.

2.

3.

4.
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Open the CD

Double-click on the Linux folder

Double-click on the install_accountz.bin file

Choose run in terminal or any option you have to run the file

It is important that you set the permissions correctly in your installation 
folder and for the application itself. 

If your Linux distribution does not have a way of installing directly, then 
you will need to install from the command line (also known as shell or bash). 
Please see your Linux distribution manual for further details of using the com-
mand line to set permissions and install and run binary files. 

Installation Web Welcome Page
After a successful installation, the installer will attempt to open your internet 
browser and display a welcome page. This will give you up to date informa-
tion in case anything has changed since this manual went to press. 

Running Accountz and Licence Registration
After you have installed Accountz, assuming you accepted the installation 
default settings, you should have a shortcut to it on your desktop (you may 
have to create your own if you are using Linux). Double-click the shortcut to 
run Accountz. 

Accountz first starts with the Company Setup Wizard. It is very important 
you complete this before registering your licence or applying any updates that 
have may be ready. 

Once you have completed the setup pages, you have up to 30 days of limited 
use before you must register the product. The Set Licence Wizard is available 
from the Help menu. Your licence registration number is printed on the CD 
case (or will be sent by email if you downloaded the software). Note that if 

1.

2.

3.

4.

5.
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you have Business Accountz Basic or Professional, some of the features of 
Enterprise will initially be available. Once you have registered, these features 
will no longer be available. Upgrades are available direct from Accountz. See 
the website (www.accountz.com) for details. 

Please also note that your licence key can only be used once, and so it is 
important to make a back-up (see below) of your datafile once you have reg-
istered the software.

Troubleshooting
If you experience a problem installing Accountz or registering your software, 
please contact Accountz support by email:  

support@accountz.com  

Backing up your data
Accountz can be set to automatically backup your data (see Chapter 5). How-
ever, backups are no guarantee if they are only made within the database in 
your installation folder. If your hard disc becomes faulty or unusable, you will 
still lose all your data. And that includes all the files you have created with 
other software too. 

This has nothing to do with Accountz. It is the nature of hard drives to become 
faulty over time. Therefore, if you value your data (ask yourself if you could 
continue running your business if you were to lose access to the data in your 
computer) you must make regular backups of the important files on your hard 
disc. 

For Accountz, all of it is kept in the folder you installed Accountz into. The 
default folder varies on each system. It is vital you keep a note of where this 
folder is. 

In Windows it will usually be in a folder named BAK within the Business 
Accountz folder in Program Files.

•
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On a Mac you may have chosen to install it in Applications, in which case 
the BAK folder will be inside the Business Accountz folder therein.

On a Linux machine you may have installed it in the root or opt directory, 
or maybe in your home directory. Again the default installation will have 
placed it in the BAK folder within the Business Accountz folder. 

To back up your entire accounts, all you need to do is make a copy of that 
folder. You can make this on to a CD, DVD, memory stick, removable hard 
drive or any other sort of removable and writable media. Remember that these 
too can also become faulty over time. Therefore we urge you to use, for exam-
ple, a new CD every time. Or, at the very least, use 3 or more CD-RW discs 
and rotate them, replacing each as it gets full. 

We highly recommend you do this often. How often depends entirely on how 
much data you have entered since the last major backup, and how much it 
would cost you in time (or aggravate you) to re-input the lost data. 

Mac Java Update or Install
In order for Business Accountz to run you need to have Java installed on your 
Mac.

When you install Business Accountz we recommend that you do a system 
Software Update (described next) to make sure that you have installed or up-
dated the latest release of Java. 

If you need to install Java manually (because your software update does not 
have the latest version of Java) then you can do this by visiting the Mac web 
site (see installing J2SE Latest release at the end of this section). 

•

•
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Mac Software Update
Click the apple icon on the top left hand corner of the screen.

Select Software Update… from the menu.  
 

Wait for the Software Update to Check for new software.

Select J2SE (Latest release) update from the list and click install.

Follow the instructions on the screen to complete the java installation. 

1.

2.

3.

4.

5.
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Mac Java Install (Latest release) 
Get Java from http://www.apple.com/macosx/features/java/ (located on 
the right of the page)

Double-click the “J2SE(Latest release).dmg” disk image file that you 
downloaded, and it will appear as a disk in the Finder. 

Open the disk, then double-click the Installer icon. 

Follow the onscreen instructions to complete the installation 
 

1.

2.

3.

4.
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3. Accounting Overview
There are only 2 reasons to account for your business: 

To keep Her Majesty’s Revenue and Customs happy

To keep you in control of your business 

This overview is designed to bring the dark and mystical secrets of account-
ancy firmly into view. This will give you confidence, not only in using this 
software, but also by being able to talk to your financial advisers in their 
language. Accounting is simple. Money comes in. Money goes out. Money is 
what you are tracking. 

When you record where money came from and where it went to, you are 
recording a transaction. In Accountz, this is represented as a single row in a 
transaction table. 

All versions of Accountz have these three major tables: 

Sales Transactions

Purchase Transactions

Transfer Transactions 

This is all you need to record every financial transaction you make in your 
business.

1.

2.

1.

2.

3.
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Every time you sell something, you will need to enter it as a transaction in 
Sales Transactions. These can be entered directly, or via some other way such 
as an invoice. Each transaction you make affects the balance of one or more 
accounts in the Chart of Accounts. 

Every time you buy something, the same thing happens, but this time it is 
entered in Purchase Transactions. 

If you transfer some money within your business, eg topping up your till from 
the bank if you run a retail business, it is entered in Transfer Transactions.

Every transaction that you enter must come from a source document. Here are 
a few common examples of source documents: 

An invoice you issued for a sale

A petrol receipt

A paying in slip from your bank

A purchase order to a supplier

A petty cash slip 

Why do you need a source document? There are 2 reasons: 

Without it you will never remember the date, amount and details of the 
transaction

You will not be able to prove that your accounts are real and accurate to 
HMRC 

One golden rule of accounting therefore is to always remember to ask for a 
receipt for anything you buy. Even paying for something by debit card and 
showing the statement to HMRC is not proof that it was a genuine business 
purchase. A receipt is a must. If you are VAT registered, and you wish to 
claim the VAT back on a purchase, the receipt must also show the amount of 
VAT charged, or at least the supplier’s VAT number (on small purchases, you 

1.

2.

3.

4.

5.

1.

2.
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may only get a till receipt without a VAT breakdown, it is then up to you to 
check and prove how much of that receipt is VAT). 

So, armed with a bunch of source documents, you enter them into the system, 
then what happens? This is where our software is at its best. It adds up your 
transactions for you. It sorts them into date (or any other) order. It analyses 
the accounts used so you can see how much you have in the bank. It enables 
you to see at a glance precisely how much money you are making, who owes 
who what, how much VAT is due (if you are VAT registered), and finally, it 
produces a set of reports ready for your accountant (or yourself if you are a 
small business) to sign off. 

The only thing that matters is that the software is genuinely easy to use, you 
can get at and edit all your data, you can see the results immediately, at any 
time, without having to go through the monthly rituals of traditional book-
keeping. Accountz does all this and more. 

Note to Accountants and Bookkeepers
WARNING: This short section of the manual is full of jargon. Please skip 
unless you want to know a little more about accounting processes and the 
terminology. 

There is no posting or period closing in Accountz other than at year end. All 
data is live all the time. The Chart of Accounts component is a fully fledged 
Trial Balance, Profit and Loss and Balance Sheet all rolled into one (see be-
low). Make any transaction anywhere in the system and all relevant accounts 
are updated immediately. 

The entire company history is kept, so you can view previous years’ results 
simply by changing the accounting start and end dates in the Chart of Ac-
counts. 

Each row in a transaction table represents a complete transaction. All the ac-
counts specified in that transaction including VAT Control (if relevant) are 
debited and credited immediately. Eg. create an invoice (or enter it direct into 
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Sales Transactions) and the Sales account, Debtors account and VAT Control 
are updated as you type. 

Click on the VAT button and choose which period you want to see for an im-
mediate and always up to date VAT return. 

The Customer (Professional, Enterprise only) and Supplier Records (Enter-
prise only) components are your Sales and Purchase Ledgers. Open any da-
tabase, locate the trader, then click on the Transaction table to see just the 
transactions for that trader. It is from these ledgers that you can create invoices 
and credit notes, but with Accountz, you can also create an invoice direct from 
an entry in Sales Transactions (you can also drill down to the original source 
document direct from any transaction table). 

Accountz also includes a Journal Transactions component with access to 
every account. 

Note to ALL USERS

Please, please read the previous Chapter (2) on making BACKUPS of your 
data (it is at the end of that chapter). 

What would you do if you lost important files on your computer due to a hard-
ware failure? How much would it cost you to recover or re-input that data? 
(and that’s if you could gather it all together again). 

Making backups costs very little time and money if done regularly.
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4. Tutorial

Accountz Look and Feel
After the splash screen finishes, the company setup wizard will start. You 
will see that it is contained within a framework that includes a menu bar and 
toolbar. 

Accountz consists of a number of different components. 

Some of the components (e.g. Chart of Accounts) include horizontal panels. 
The size of these can be adjusted.

All the settings you make are remembered, so the next time you run Accountz, 
it will open exactly where you left it. 

If you wish to view the software in a different language, now would be the 
time to set it to your preference. Go to Tools>Language Selection. Choose the 
appropriate language from those available in the drop-down list, then click 
Ok. Please restart the program for the changes to take effect.
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Setup Wizard

Setting up Your Business
The setup wizard asks you a variety of questions to do with your business. 
When you have finished, Accountz will be setup to include all the components 
you need to match your answers. This includes a Chart of Accounts relevant 
to your needs. 

Each question in the wizard includes a help panel above it. This may also con-
tain Internet links for further relevant information. When you are happy with 
each answer, click on the Next button on the bottom right of the screen. 

When you reach the last page, finish the wizard by clicking on the Process 
Wizard Data button (on the bottom right of the window).

This will fill in the Your Business database record. You can edit and add de-
tails such as your address and company contacts at any time. 
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Chart of Accounts

 The Chart of Accounts is the heart of your accounts. It will already be 
setup with a suitable set of accounts for your business. This is done automati-
cally when you answered questions in the Setup Wizard. Click on the Chart of 
Accounts button in the main toolbar to open it.  

The Chart of Accounts has 2 panels. On the left are the account groups that 
contain further groups and accounts. 

The green folder icon represents a group, the pile of coins icon an account. 
You can open and close any and all of the groups. This lets you see as much 
detail as you need. There are two columns to the right of each group and 
account. These show the current balance and statement balance of each ac-
count. 

It is important to understand that these balances exactly reflect the transac-
tions in the system depending on the Start and End Date settings in the two 
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fields just above the accounts. If these are grayed out, then the balance will 
reflect all the transactions from day 1 to now. 

If you look at an un-opened group, e.g  the Liability group, all you will see is 
the current balance of that group; ie. your overall liability. You can open or 
close any group (and sub-group) by double-clicking on the group. 

The default chart of accounts has been setup as a ready to use and complete 
Balance Sheet. Every transaction you make in the system will show immedi-
ately in the chart of accounts. Eg. add a sales transaction and your profit will 
increase immediately. This happens entirely automatically. 

This concept of every transaction updating your final accounts instantly is 
completely unique to Accountz. You will find it very intuitive since you can 
monitor the effects of your transactions as they happen. 

If you double-click on any group it will open a detailed view of that group in 
a tab in the right hand panel. From here you can see the sub-accounts it may 
contain, or the entries that relate to it. You can also move accounts around, 
even to another group, and hide accounts that you no longer use. 

Reconciling (Clearing)
This is also the place to be if you want to reconcile a bank account against a 
printed bank statement. Open the Current Assets group, then double-click on 
your bank account. A new tab is created in the right hand panel. 

Click on the Entries tab at the bottom of the panel. This will display just the 
entries for the bank so you can clear those entries which match with your bank 
statement. 
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Take a look at the account’s Statement balance in the left hand panel and 
you will see it change each time you clear an entry by clicking in the Cleared 
column (you can unclear entries anytime by clicking in the Cleared column 
again). 

If the Cleared column is not showing, right click on any column header. Move 
your mouse pointer over the Columns option and select the Cleared column 
from the list. You can also hide columns you don’t use or want to see in the 
same way. 

You can filter the entries by selecting one of the default filters from the toolbar 
(see above). 
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Choose the Cleared Entries filter to produce a look-alike bank statement com-
plete with running balance. Click on the Print (if available) or Export buttons 
in the toolbar to print the statement or to import it into a spreadsheet. 

Account Properties
Click on the Properties tab at the bottom of the detailed account view in the 
right panel. 

This is where you can rename an account, add a reference code for it (this 
may be useful for those used to older systems where a nominal code was a 
mandatory requirement). There is also a Reconcilable option here. By default, 
the Reconcilable option is only set if the account is of Type Bank Account. 
There is space in the Notes section to add further details about an account, 
eg. you may like to record your bank’s telephone number here, or perhaps an 
overdraft limit. 

The account properties of an account group (eg. Assets) contains an area that 
tells you what type of accounts and account groups it can hold. 

Adding a new account
Double-click on the account group in the left panel that you want to add a 
new account to. Account groups are shown as green folders. This will open a 
detailed view of the group in the right panel. You can see the types of group or 
account it can contain in the Can Contain section of the account’s Properties 
tab (the tab is at the bottom of the panel). Click on the Sub-accounts tab to the 
right of the Properties tab. 

 Now click on the Add new Account button. This opens a dialogue box 
where you can Name the new account, give it a Reference Code if you wish 
(this is not a requirement), select its Type and finally set it to be Reconcilable 
or not (these terms are explained earlier on in this chapter, and also in the User 
Guide). When you are happy, click on the Yes button and the account will be 
created. 
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It is very easy to accidentally open another group instead of an account if you 
simply click on the add button. Make sure you are selecting an account type 
that ends with the word account if that is what you want (eg. if you want to add 
another Sales Account to a Sales Group make sure you select it from the drop 
down (the default when adding an account is to use the same type).

Account Types and the Balance Sheet
Each account has an account type. This helps the program (and you) decide 
where a particular account belongs in the chart of accounts. Every account 
belongs to a group. The overall containing group is the balance sheet. 

A balance sheet contains 3 groups: Assets, Liabili-
ties and Equity. It is called a balance sheet because 
all the money coming in will equal all the money 
going out. You are accounting for every penny, and 
if you have done this correctly, the books will bal-
ance. There is an equation you can use to work this 
out: 

A = L + E. If you like a drink, think of beer and ac-
counting, and since the 2 seem such unlikely part-
ners, you will probably  remember it. 

Assets represent accounts such as your bank, cash, 
money owed to you (debtors), stock for sale, build-

ings and equipment used to run your business. It is the place where money that 
has come into your business or is owed to your business is stored. 

On the other side of the equation we have Liabilities and Equity. Add these 
together and they should equal your assets. 

Liabilities represent the money the business owes other people. These include 
accounts for loans the business has taken out, money the business owes its 
suppliers (creditors) including HMRC in the form of VAT (assuming you are 
in the majority of businesses that pay VAT back to HMRC rather than receive 
refunds). 
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Equity represents the money the business owes you (or its shareholders if a 
limited company, or partners if a partnership). The Profit and Loss account is 
held here for example (any profit is distributed to the owner(s) of the business, 
therefore it is owed to the owner(s) rather to some other supplier). 

Since liabilities and equity are so similar (money owed by the business) it 
is good practice to understand the distinction and view your business as an 
entity in its own right. That is, there is you and there is your business. They 
are separate things. 

Looked at this way, it becomes much easier to understand how a financial 
transaction works. That is, how each transaction affects (at least) 2 accounts; 
where the money came from and where it went to. If you made a sale for 100 
and it came from a sales account and went to your bank, you would have ac-
counted for the complete transaction. 

Let's analyse that. Sales accounts are held in the Profit and Loss account 
group, which is held in the Equity account group. Bank accounts are held in 
the Assets account group. Therefore we end up with 100 in Equity and 100 in 
Assets....A = L + E...100 = 0 + 100. Spot on. 

Taking a look at the chart of accounts that has been setup for you and famil-
iarising yourself with its structure and accounts will help you understand the 
way the finances of a business works. 

The more transactions you add, the clearer it will become as you note the ef-
fect each transaction has on your chart of accounts. If you are new to account-
ing, I would urge you to bookmark this section so you can return to it again 
in the future. It may not make a lot of sense right now, but I guarantee it will 
become crystal clear later. 

There is another good reason to view yourself and your business as separate 
things: it will help you make more rational (ie. less emotional) decisions about 
your business, and that is a good thing. If something doesn’t go as planned, it 
should affect your business, not you. Easy to say, I know, but if you see your 
business as something separate that needs help, you have a better chance of 
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helping it if emotions are kept to the minimum. Seeing your business as a 
thing helps this enormously. 

OK, back to accounting. An account group (eg. Assets) can contain further 
groups (eg. Current Assets, Fixed Assets) and it can also contain accounts (eg. 
Bank Account, Cash Account). As you can see from your chart of accounts, 
there are many account groups within the basic 3 (Assets, Liabilities and Equi-
ty) and a few of those contain further groups (eg. Equity -> Profit and Loss). 

You can restructure your chart of accounts in any way you like, but there are 
a few rules: 

1. You can add groups to groups and accounts to groups.

2. You cannot add a group to an account. 

Groups are shown as green folders. Accounts are shown as a pile of coins. 

Moving an account up or down within a group

 Select an account in the Sub-accounts view in the right hand panel. Click 
on the Move Account up or Move Account down buttons to the right of the 
Add an Account button. They are represented by a green folder with an up or 
down arrow. This will move the selected account up or down the list of ac-
counts within the group. 

Moving an account to a different group

 Select an account in the Sub-accounts view in the right hand side panel. 
Click on the Move Account to different group button. It is represented by a 
green folder with an a diagonal arrow. This will open a dialogue box allowing 
you to pick a new group from a relevant selection in a drop down list. Impor-
tant Note: you can only move individual accounts or account groups that di-
rectly contain individual accounts (ie. you cannot move a group that contains 
other groups, in this case you would need to move those other groups first). 
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Hiding an account

 You can hide any account by selecting it in the Sub-accounts tab and 
clicking on the Hide/Show Account button. You will see that it disappears 
from the accounts view in the left hand panel, but remains on view in the right 
hand panel. This is so you can make it visible again if you wish. 

Searching for an account

 If you have a large chart of accounts and are not sure which group a par-
ticular account is in, you can use the search bar below the accounts view in the 
left hand panel to search for it. Type in the first part of the name (or reference 
code if you have used one) and click on the search button on the right hand 
side of the search field. If a match or partial match is found, the accounts view 
will open the necessary groups to display it. It will also be opened as a new tab 
in the detailed view in the right hand panel. If more than one match is found, 
all will be shown in the right hand panel.

Close all Tabs

  If you have a number of tabs open on the right panel of the Chart of Ac-
counts , this button will enable you to close them all at once.

Reports

   You can view, print or export a whole variety of reports includ-
ing user-definable ones from the chart of accounts. Trial balance, profit and 
loss and balance sheet reports can be produced directly from the buttons in the 
left hand panel toolbar (Professional, Enterprise only). 
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Click on any of those buttons to Edit/View your document as shown in the 
screenshot (see below). Select a template from the drop down list. Click on 
the Design/Print tab at the bottom of the window to preview the report before 
printing. There are various options for each report type. For example, you can 
restrict the date range of the report and add a description. Full details on de-
signing and using report templates can be found in Chapter 14 Appendix C.

Entries
As well as account balance reports, you can also get reports of the entries from 
particular accounts. 
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This is available from the right hand panel in the Chart of Accounts. Double-
click on any account that is not a group to open it in the right hand panel. 
Click on the Entry tab at the bottom of the panel. Click on the filter button 
if you want a different view, then on the Print or Export buttons to produce 
your report. 

Opening Balances
Opening balances are best entered into the Journal as you can enter one bal-
ance at a time. That is, each line represents a single account with its opening 
balance. Choose the menu option General > Journal Transactions. If you have 
something called a Trial Balance from your last set of accounts it will make 
this task very simple. Failing that, a balance sheet and profit and loss will do. 
Either way, you should ensure the structure of your accounts is the same or 
similar to your previous set of accounts (ie. include all the accounts shown in 
your trial balance). 

Once that is done, add new journal transactions for each account placing the 
amount in the correct column. If you have a positive bank balance, then enter 
the amount in the To column (debit in accountancy terminology). If it is over-
drawn then enter it in the From column (credit). 

You are also likely to have an account called Retained Earnings. This carries 
forward all the profits and losses from previous years. It is normally a credit 
balance (the From column) assuming you have made an overall profit. 

A balance sheet is called a balance sheet because all the debits equal the cred-
its. That is, all the money coming into the business From somewhere (eg. 
Sales) matches all the money going To somewhere (eg. the bank). For exam-
ple, in the simplest case, if the business made a profit last year of 100,000 paid 
up in full and all that money went direct to the bank, you would have 2 open-
ing balances. The first would be for the bank with a debit (To) of 100,000 and 
the 2nd would be From Retained Earnings with a credit of 100,000. 

If you are entering your accounts from the day you started, there will not be 
any opening balances. Putting money in to start the business is often miscon-



Business Accountz User Manual

39

strued as some kind of opening balance. It isn't, it is just another everyday 
transaction. To do that you would make a new Transfer Transaction From 
Loans To Bank on the day it was made. 
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Customers
There are two customer components. The first, called Customer Table, is a 
spreadsheet view of all customers where you can also add new ones. This 
is present in all versions of Business Accountz. Adding new customers here 
makes them available in all other areas of Accountz. The second, called Cus-
tomer Records, shows a detailed breakdown of each customer's activity. This 
is available in the Professional and Enterprise editions. 

Customer Table

 Click on the Sales menu option and choose Customer Table.

This opens the table showing all your customers. Add a new customer by 

clicking the  button in the toolbar. You can add their address, notes and 
main email amongst other things. You can export this list to a spreadsheet (eg. 

to email all customers) using the export button  in the toolbar.

The customers listed here can be associated with a sales transaction by select-
ing them in the Customer field for any entry in the Sales Transactions Table.
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Customer Records (Professional, Enterprise only)

Click on the Sales menu option and choose Customer Records. This consists 
of 2 panels:  

The left panel contains the main details of a customer, eg. the name, address 
and any useful notes. 

The right panel contains the following tabs:

Contact: You can add as many contacts for each customer as you like

Delivery: You can add as many delivery addresses for each customer as 
you like

Statement: Shows how much  customer owes you and over what period 
or time

Sales: A filterable list of a customer’s sales transactions

Transfers: A filterable list of a customer’s transfer transactions

•

•

•

•

•
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Quotations: A filterable list of quotations and estimates produced for a 
customer 

Adding a new customer

 Click on the Add a new record button on the left hand panel’s lower tool-
bar. This will clear the data fields for you to enter your new customer’s details 
(please note that your entry is automatically saved). If the name is Fred Smith 
you will be able to find Fred easily by searching for anything beginning with 
F. You may also want to find Fred by his surname, Smith. Type Smith and you 
will be able to locate him using either name.

Hiding a customer record

 If a customer is no longer active you can hide the record by clicking on 
the Show/Hide button in the left hand panel lower toolbar. 

Showing hidden customer records
To show a customer’s record again, select Tools>Configuration from the main 
menu. Open the ‘Customers’ folder by double clicking it, and select ‘Custom-
ers Show/Hide’ by clicking it once. Uncheck the ‘Yes/No (Yes if selected)’ 
tick box, and return to the Customer Records component. Now you can see all 
your customers, including those you have previously hidden.

Next, locate the record you want to unhide and click on the  Show/Hide 
button again.

Finally, return to the ‘Customers Show/Hide’ section within the Configura-
tion panel and check the Yes/No tickbox to re-hide the remaining customers.

•
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Finding a customer
Use the alphabetical search tool on the left of the customer name and address 
panel to locate any customer. Either click on one of the alphabetical letters in 
the panel, type something into the search field at the top of the panel, or click 
on the ? (question mark) above the first letter (A). These actions will bring up 
a list that has been filtered according to what you have clicked on or typed. 
The more you type the nearer you will get to an exact match. You can select 
any of the choices from the list using the up or down buttons then pressing the 
Enter key, or select with the mouse. 

If a customer record has been created but not yet given a name, it will be 
shown with its unique internal ID number instead (eg. cs.142536479.123).  
You can fill in the name whenever you like. Records like this are displayed 
by clicking on the ? button in the customer lookup bar on the left hand side 
of the record. 

The ? button is also used to display customers whose names start with a 
number or a punctuation mark. You can also search for these direct using the 
search field above the alphabetical search tool. 

Customer History

 Click on the Recently viewed records button on the lower toolbar to pick 
from an alphabetical list of customers you have recently viewed.  
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Designing an invoice

From the File > Documents option, select the Invoices tab. 

 Choose one of the default templates, then click on the Create Template 
Document button on the bottom right of the screen.  

This will open the Document Editor with a copy of the selected template ready 
for you to make your own. 
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Here are the steps: 

Give the new template a name in the field at the top. Eg. Default In-
voice 

Make sure you include all the columns you need in the transaction table 
in the middle of the screen by right clicking on any column header and 
adding or removing any of the available columns from the drop down 
list. Add or remove all the columns you want before dragging them into 
position on the table. 
 
You can now drag them into position and adjust the column widths. 
This is not how they will appear on the invoice itself. This is purely 
to make it simple for you to add transactions to invoices in the future 
(we are currently designing an invoice, not creating a new one for a cus-
tomer at the moment). 
 
If you sell quantities of things (eg. goods or your hours charged for 
some service)  then include the Price less VAT and Quantity columns 
(use the Price column instead if you are VAT registered or quote VAT 
inclusive prices). 
 
You may want to drag the Total less VAT or Price less VAT column to 
the left and move the Total Amount to the right if you use ex VAT pric-
ing (eg. if you quoted, say, 400 + VAT). Three of the columns (named 
in this sentence) are required if you want the invoice to include a Total 
less VAT, VAT Amount and Total Amount summaries at the bottom of 
the invoice

Specify which of the table columns you want on the invoice itself, and 
the order in which you want them. This is done in the check box section 
at the bottom of the window. Double click on any check box to include 
and exclude a column 
  
Note: if you added or removed any columns, you may need to click on 

1.

2.

3.
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the blue refresh button at the bottom right for those columns to show in 
the list. 
 
Move the columns in order of preference by selecting and clicking on 
the arrow buttons on the right. 

Click on the Design/Print tab at the bottom. This is the front end of the 
invoice, i.e. how it will look.

To add a logo, click on the Picture button on the left, then click anywhere 
on the document window. A filer window will open letting you navigate to 
whever your logo file is on your computer. 

Text can be added by clicking on the Text button on the left and then clicking 
anywhere on the document. You will see a red outline box appear wherever 
you clicked. To add text to the box, click in the Text Box on the right of the 
window and start typing.

Other items can also be added in the same way. 

Any element on the page can be edited by first selecting it, then editing any of 
the attributes shown in the right hand panel.

Column widths can be adjusted by selecting the table, then dragging the slider 
in the Position and Size attribute panel on the top right. If you find the existing 
column header text is too wide for the column width you want to create, either 
adjust the font size in the attribute panel on the right (you may need to scroll 
down) or do the following work-around: 

Make sure you have selected all the columns you need and are happy 
with their position and the overall size of the table 

Change the header font size to zero. They will all now be hidden. Add 
new Text items to each column header and select the font and font size 
you need as well as the required text (eg. the 'Total less VAT' column 
header text could be changed to 'Ex VAT'). 

4.

1.

2.
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Creating a New Invoice
Add or select an existing customer in the Customer Records component. 

 Click on the New Invoice button in the left hand panel’s upper toolbar. 
This will open the New Invoice window. Every time you do this a new in-
voice will be created with a new invoice number auto-generated (described 
shortly).

If you want to edit or add to an existing invoice, use the main menu File > 
Document Editor option or find the transaction in Sales Transactions and dou-
ble-click on the Sales Document field from there. 

Invoice Numbers
The Reference field in the invoice holds the invoice number. You can choose 
the computer generated number, this is incremented automatically, or you can 
enter your own. 

Setting an automatically incrementing invoice number
To change the incrementing number go to File > Documents > Invoices and 
edit the Last Document Number field.

Invoice Table
The invoice table is where you enter the work, services and/or goods the in-
voice is for. 

Each row you create in an invoice will create a new transaction row in Sales 
Transactions (see the next part of this tutorial). This gives you total control 
over invoice sales analysis, allowing for different VAT codes to be mixed and 
even whether part (or all) of an invoice was paid and when it was issued.
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Invoice Table Columns
The Description column is the description of the row, eg. ‘To services done on 
the 20th July’, or ‘32 LCD Television Panel’. Note that the description field 
can be as long as you like. It will automatically word-wrap, so is perfect for 
invoicing services that need long descriptions of the work done. To create a 
new paragraph with a blank line in between, press Shift + Enter twice. 

Specify the From Account. This will normally be a Sales account. By default, 
Accountz is initialised with a sales account called Sales. You can add as many 
as you like if you want to breakdown your sales for deeper analysis in the 
Chart of Accounts (sales accounts are within the Sales group in the Profit and 
Loss account in the Equity section). 

You will also need to specify an account to debit (the Account To field). This 
will either be Unpaid Invoices (a.k.a. Debtors) if the invoice is on credit (un-
paid) or Undeposited Funds, Bank or Cash if it is paid.

You can enter default accounts specifically for any customer in the relevant 
fields in the customer’s record. If you do that, they will automatically appear 
in the invoice so you don’t need to enter them every time you produce a new 
invoice. 

Enter the quantity, price or amount, and VAT code (if you are VAT regis-
tered). 

Add as many extra lines to the invoice as required using the Create transac-
tion button.

Printing an Invoice

 When you are happy with your invoice you can either leave it for further 
editing or additions (great for account customers who you invoice at the end 
of the month) or click on the Design/Print tab at the bottom of the window and 
print it by clicking the print icon .
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Creating a Credit Note

 Click on the New Credit Note button in the left hand panel. This works 
in exactly the same way as creating an invoice (see previous section). The 
only difference is that sales transactions are created with a negative amount 
to reflect the credit. 

Like invoices, credit notes can be paid or unpaid. This is determined by the 
accounts affected and the Paid column (eg. If you use Unpaid Invoices, the 
transaction will be flagged as unpaid, see Sales Transactions in the next sec-
tion for further details on the Paid column). 

Reference numbers for credit notes have a separate incrementing number, or 
you can override this by entering your own reference (see the menu option 
File > Documents > Credit Notes and edit the Last Document Number field. 

Creating a Quotation/Estimate

 Click on the New Quotation button in the left hand panel. This will open 
a new quotation window. It works exactly like invoicing (see earlier section 
for details) except transactions created from quotations are held in their own 
table, not in Sales Transactions. This is because quotations and estimates have 
no bearing on your accounts. They do not affect your profit and loss or bal-
ance sheet. 

Quotations, just like invoices and credit notes are based on templates designed 
using Accountz Designer (see Chapter 14 Appendix C). By creating 2 tem-
plates, you can choose between a quotation and an estimate any time you need 
them.

Quotations are a firm commitment to sell or do something for a fixed price. 
The price is usually limited by a time limit (eg. ‘We will honour the prices 
quoted for 30 days from issue date’). Estimates, on the other hand, are exactly 
that. You are not committing yourself to a price, just an approximation of what 
the invoice may eventually come to. 
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Note: To save you time, quotations can be turned directly into invoices (which 
can be edited if there are changes), and invoices can be turned into credit notes 
using the buttons available in the toolbar in any of the tables where they are 
displayed. 

Contacts Tab

Adding a new contact
Click on the first tab in the right hand panel named Contact.

 Click on the Add a new contact button. This clear the Name field for you 
to enter your new contact’s name. This will add another contact to the current 
customer (and save it automatically for you). 

Removing a contact

 Click on the Remove a contact button and the current contact record will 
be deleted. Note that this cannot be undone. 

Viewing different contacts
In the Contact tab in the right hand panel, click on the drop down button on 
the right of the Name field. Select the contact details you want to view from 
the list. 

Delivery Addresses Tab

Adding/Deleting/Viewing delivery addresses

Click on the Delivery tab in the right hand panel, then click on the  Add a 
new delivery address button (in the lower toolbar) to add alternative delivery 
addresses for the current customer. You can select different addresses and re-
move them in the same way just described for Contacts. Note there is a button, 
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labelled Copy from Customer that will insert the customer’s name and address 
into the delivery address. 

Statement Tab

 This shows the credit history of a customer. You can change the credit 
terms for individual customers using the Edit buttons to the right of each Pe-
riod field. The main point of this tab is to let you view or print a statement of 
account for a customer. You can see all the unpaid transactions in the table. 
Click on the report button marked with an S to view and print a statement. 

Sales Tab
The Sales tab shows you the complete history of a customer’s sales transac-
tions. You can filter the transactions to get more detailed reports using the 

Add Filter button . 

Almost any report is possible. For example, you could create a filter that 
shows you only sales with an amount over 1,000 during the last 3 months. The 
filter is saved, so you can also reuse it at anytime. See Chapter 14 Appendix B 
for details of how to create new filters. 

Transfers Tab
The Transfers tab shows you the complete history of a customer’s transfer 
transactions. Transfer transactions are those made when a customer pays an 
outstanding invoice or other money owed to your business. You can filter 
these transactions to get more detailed reports using the Add Filter button. Al-
most any report is possible. For example, you could create a filter that shows 
you only payments over 500 during the lifetime of a customer. See Chapter 14 
Appendix B for details of how to create new filters. 



Business Accountz User Manual

52

Quotations Tab
When you create a quotation or an estimate for any customer (see Creating a 
Quotation earlier in this section), it is saved and shown in this tab. Quotations 
for all customers can be seen in the quotations component available from the 
Sales > Quotations menu). 

The Quotations tab in the customer database shows just the quotations or esti-
mates for the current customer you are viewing. You can filter these transac-
tions just like any others using the filter selector in the toolbar. For example, 
you may only want to see quotes and estimates for the last 60 days that have a 
value above some threshold. See Chapter 14 Appendix B - Query Builder, for 
details of how to create new filters. 

Printing and exporting customer reports

  All transactions shown in the tables within Customer Records can 
be printed or exported using the Print or Export buttons in the right hand 
panel’s toolbar. The Print button opens the Document window. Here you can 
name the document and choose a transaction report layout template (templates 
are designed using the Accountz Designer. See Chapter 14 Appendix C for 
details of how to design report layouts). 
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Transactions

Overview
The most important area in any accounting software is transactions and the 
way they are entered. A transaction affects the chart of accounts, and therefore 
impacts directly on your business. 

There are 4 transaction areas in Accountz, each is described in detail over the 
next few pages, but an overview will give you a clearer picture of why there 
are 4 and what each one does. 

 Sales transactions overview 
Sales transactions (blue books) record new money coming into the business. 
These have a direct effect on your profit and loss account. Whenever you sell 
anything, it will end up as a transaction recorded in Sales Transactions. 

 Purchase transactions overview 
Purchase transactions (red books) record money going out of the business on 
all kinds of purchases, whether it is buying stock to resell, business expenses 
such as rent and rates, or purchases of equipment to help you run your busi-
ness such as a new computer. All these types of transaction are recorded in 
Purchase Transactions. 

 Transfer transactions overview 
Transfer transactions (green books) record money being passed around the 
business or being loaned into or out of it, such as topping up petty cash from 
your bank, or injecting some money into the business. These are all recorded 
in Transfer Transactions. 

 Journal transactions overview 
Finally, there is the Journal (black books). It is not necessary within a pack-
age like Accountz since all transactions can be handled just as easily with 
the 3 transaction areas just covered. However, it is one of those things that 
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trained bookkeepers and accountants prefer for certain bookkeeping opera-
tions. Rather than using a single row in a table to describe a complete trans-
action (which is one of the really great things about Accountz) the Journal 
lets you change balances on accounts, one account at a time. For this reason 
it is most often used to close and open a set of books and correct mistakes. 
Accountz makes use of it for its year end procedure, but since this is done 
automatically for you, unless you really need it (or fancy learning about it) 
there is little need for you to understand how it works. 

Transaction Tables
All transactions are entered, edited and displayed in a table with columns to 
analyse them. Each transaction is contained in a single row (except in the 
Journal where a transaction can consist of multiple rows). The tables within 
Accountz have been designed with ease of use and maximum functionality 
to make data entry simple and fast. The Rapid Data Entry system used in 
Accountz is the fastest in the world and is described in detail in Chapter 14 
Appendix A. 

Table Customization
Tables in Accountz have a very high degree of customization including the 
ability to turn columns on and off, swap them around, resize individual col-
umns, resize the whole table, sort ascending/descending and back to the origi-
nal order of entry, plus the data can be filtered in almost any way you need. 

 The filters can be named and stored for repeated use and the results they pro-
duce can be printed via the Accountz Designer (Professional and Enterprise 
only) or exported to a spreadsheet for further manipulation or printing. 
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Sales
Sales can be entered in 3 ways into Accountz:

 Directly into the Sales Transactions component table (Business Ac-
countz Basic has this option only) 

 Via invoicing within Customer Records 

 Directly into a customer’s Sales Tab within Customer Records

Either way, all sales end up in Sales Transactions. This is a good thing. It 
means you can see everything you have done. Unlike other systems where 
periods are ‘closed’ on a regular basis and difficult to access afterwards, Ac-
countz lets you see everything you have done from day one onwards. 

Of course, you may not want to see older transactions all the time, that’s fine 
too. You just use a filter (see Chapter 14 Appendix B). You could set a default 
filter to show you just the last 3 months' transactions for example.  

You can change the filter to view another aspect of your sales with just 2 
clicks of the mouse.  

In summary, you can always see everything you have done, and you can see 
it in one place without having to produce a report. For example, if you issue 5 
invoices on Monday and add 10 direct sales on Tuesday, you can open Sales 
Transactions and see the lot in one table. You can edit them all, and you can 
even open the original invoices directly from the table by double clicking 

1.

2.

3.
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on any transaction’s Document field (you may have to turn on this column 
if it is not showing, see Chapter 14 Appendix A - Rapid Data Entry Column 
hide/show). 

Sales Transactions

 Click on the Sales button or select Sales Transactions from the Sales 
menu in the main menu bar at the top of the main Accountz window. 

All your sales transactions are shown in the table in this component. All tables 
within Accountz are extremely customizable. Learn the attributes of just one 
table, and you will understand the way all the other tables work too. 

One important aspect of tables is the Accountz Rapid Data Entry system. It is 
designed to help you complete transactions with the minimum of effort. From 
drop down calendars for date selection to auto-filtering lists for customer and 
account names, auto-VAT calculation and one click entry insertion (using 
Presets, more on that later in this section). Accountz has the fastest data entry 
system in the world. There is a complete description of Rapid Data Entry in 
Chapter 14 Appendix A. 

By default, only certain columns are showing in the transaction tables. These 
are the most commonly used. Full details of every possible column can be 
found in Chapter 14, Appendix D. For the purposes of this tutorial, we will 
cover the basics. But before we continue, there are a few things you should 
know. 

All transactions should have a supporting source document. Eg. an invoice or 
till receipt if you sell something, or a bill if you purchase something. You will 
need these original documents if you ever need to prove your accounts. 

If you sell something for cash it is possible you have no documentary evidence 
at all, however, you must still record it as a sale. Use the Description field to 
leave yourself a memo of what you sold. If you are registered for VAT there 
are legal issues on sales and documentation. It is advisable therefore to find 
out about this via the www.hmrc.gov.uk website. 
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Entering a new transaction

 To start a new transaction click the Create a new transaction button. A 
new row will be created in the table and the flashing cursor will appear in the 
first row under the first column ready for you to enter the transaction date. 

The date you enter for the transaction is called the Tax Point. It is the date on 
which the transaction was conducted and therefore the date used by HMRC 
(and yourself) to decide which tax year the transaction belongs to. 

The UK tax system is based on the accrual method. That is, a transaction be-
comes liable for tax on the date it occurred, not on the date it was paid. 

Do not confuse this with the VAT Cash Accounting scheme, which applies 
to the VAT part of transactions only and allows you to withhold the return 
of VAT until the transaction has been paid – the transaction itself regardless 
of whether you are on this special scheme still becomes liable for (income or 
corporation) tax on its tax point. The VAT portion of any transaction becomes 
due according to another date field: VAT Date. This is automatically copied 
from the Tax Point you enter when you first enter it. After that it can be edited 
independently. 
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To enter a date, start typing it. As soon as you press the first key a popup cal-
endar will show. The calendar is interactive and will change date as you type. 
You can continue typing or you can select a date from the calendar. 

The calendar will also base the date on the previous entry. This speeds things 
up. If your first entry has a date of 25/04/08 and your next transaction is a few 
days later on the 28th, just enter 28 and press the Enter key. The rest of the 
date will be copied automatically. If the next entry is dated 4th May, enter 4/5 
and hit Enter. The rest of the date will be entered for you. 

This is a great time saver and is often overlooked. Note also that you can use 
any separator you like. It does not have to be a forward slash. Use a space 
or a dot if you like. The finished date will be auto-formatted for you accord-
ing to the preferences set in the Configuration settings (see Chapter 12 Tools 
Configuration). 

The Customer field comes next. If you have entered any customers into the 
system, then typing the first part of their name (or alternative lookup text) will 
immediately display a popup menu. The menu will show you just the match-
ing records. The more you type, the narrower the choice will become. If you 
delete what you have typed, eventually you will end up with the complete 
list. Whilst the popup is displayed you can use the up and down arrow keys 
on your keyboard to navigate through the list. If the customer you want is 
there, select it and press Enter. This transaction will now be associated with 
the selected customer. You can press the Space bar first if you want to see the 
complete list, then type to narrow it down. 

If you later edit the customer’s name in Customer Table or Records, all related 
transactions will update automatically. 

Associating a customer with a transaction also means you can view that trans-
action directly from the customer’s record. If it was unpaid, you will also be 
able to send a statement to the customer too. 

Next is the Reference field. It is there for a reference to the transaction to be 
added. This could be the invoice number, or some other identifier. 
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Accountz includes an automated transaction identifier with each transaction 
in a column named Transaction Number. You will need to turn this column 
on (see Chapter 14 Appendix A -Rapid Data Entry Column hide/show) to 
view it. The number auto-increments every time you enter a new transaction. 
The field is not editable. If you write this number on the source document 
you will always be able to match up the transaction with the document. The 
number runs through all transaction tables, so transaction number 1 may be in 
sales and transaction number 2 may be in purchases. What matters is that the 
number is a unique identifier and cannot be edited. 

The next two fields are the two most important to understand. They give the 
transaction life. They describe precisely what happened. They tell the system 
where the money came from and where it went to (known as a credit and 
a debit in a traditional double-entry system, but much easier to understand 
in Accountz, please read Chapter 1 Introduction if you haven’t already done 
so). 

The From Account field specifies where the money came from. In the case of 
sales transactions it will almost always be from a sales account. By default a 
sales account called Sales is part of your chart of accounts. Enter an ‘s’ in this 
field and a popup menu will open with this account already selected. Just press 
Enter to insert it into the transaction. 
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This popup menu works in the same way as selecting a customer (covered 
earlier). Once you have narrowed down the list by typing part of the account 
name (or just pressing space to see the complete list), use the up/down arrow 
keys to highlight the account you want and press Enter to insert it (delete any 
characters you have typed to get the complete list). 

The To Account field specifies where the money went to. It could be the bank, 
cash, an undeposited funds account or if unpaid, the debtors account (i.e. Un-
paid Invoices). Start typing the name of the account the money went to and the 
popup menu will appear ready for you to select the correct match. 

Different scenarios for the To account
If the sales transaction has been paid and you put the money direct into the 
bank, the To account will be your bank. 

If the sales transaction has been paid (cash, cheque or manual credit card sale), 
but you will not be paying it into the bank until you have other things to pay in 
as well, then the To account should be Undeposited Funds. This is an account 
in the Assets area of your chart of accounts that stores money until you are 
ready to bank it (hence the term undeposited). 

When you do eventually pay the money into the bank, you will record it as 
another transaction in Transfer Transactions (discussed in detail later). The 
reason for this seemingly over-complicated procedure is to make it easier to 
reconcile (ie. check) your bank statement. It is much easier to check a sin-
gle transaction amount against a bank statement rather than, say, 5 individual 
sales amounts that should add up to the single amount shown on the bank 
statement. This, incidentally, is one of those procedures that is easier to do 
than write about. 

If the sales transaction was unpaid (ie. you sold something on credit) then the 
To account will be your debtors account (this appears in Accountz as ‘Unpaid 
Invoices’). 

Account names can be anything you like. There is no UK law that states an 
account name must be this or that. Instead, what is required is that your ac-
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counts should reflect as true and accurate a statement of your business as 
they possibly can. So in giving an account a name that is really obvious, you 
are helping both yourself and any subsequent tax inspection should you be 
unlucky enough to get one. Thus by default here the account is called ‘Unpaid 
Invoices, but you could rename it to ‘Money owed to the business’, if you 
wished. 

Next we have Total Amount. This is the total amount you received for the 
transaction (including VAT if it contains a VAT element). If the sale was 
for 11.75 inclusive of VAT, then that is the total amount. If you are not VAT 
registered and the sale was for 10.00 then that is the total amount. 

If you need to enter a negative amount (eg. a credit note) you will need to 
empty the field before entering the minus sign. If the field changes to show a 
red border, it indicates a mistake and that is usually because of a leading zero 
(eg. 0-34.99, just delete the zero).

The VAT Code field is next. It is where you specify the VAT to be ap-
plied to the transaction. There are a number of VAT codes available. The 
most common is Standard, which at the time of writing is 17.5%. To enter 
a VAT code start typing its name. S will open the filtered popup menu with 
Standard highlighted ready for you to press Enter to confirm. As soon as you 
do this, Accountz will calculate the VAT for you and place the amount in the 
Vat Amount field.
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VAT Schemes
Accountz can handle the following 3 VAT schemes:

Standard Scheme

Cash Accounting Scheme

Flat Rate Scheme

VAT Standard Scheme
VAT is due on every transaction as soon as it is raised regardless of whether 
it is paid or not. The VAT Date field is used to decide which VAT period a 
transaction belongs to. This is the normal scheme given to all VAT registered 
businesses unless they specifically ask to be put on another scheme (which 
can only be done via HMRC).

VAT Cash Accounting Scheme
VAT is due on every transaction only when it is paid. The VAT Date field 
is used to decide which VAT period a transaction belongs to. The Paid field 
must also be ticked to set for the transaction to be included in the return. You 
may need to turn on the VAT Date column, please see Chapter 14 Appendix 
A - Rapid Data Entry Columns hide/show. 

It is very important that you edit the VAT Date field to the date the transaction 
was paid. When that is done you can tick the Paid tick box in the transaction. 
This is the only way the transaction will be included in the VAT return.

VAT Flat Rate Scheme
Output VAT is calculated under the flat rate on gross sales. Use the Flat Rate 
Scheme VAT code (available from the drop down list when you type F) for 
all sales transactions if you are on this scheme (this includes exempt, zero, 
reduced and standard rated plus sales to EC countries too). 

When you have finished a VAT period, run the VAT Return for the period. 
This will give you your total turnover in Box 1. Apply your flat rate VAT to 

1.

2.

3.
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this turnover (use the Calculator tool) and make a sales transaction for the total 
VAT using the 100% VAT in the VAT Code field. 

VAT rates under the flat rate scheme vary. Please ensure you use the correct 
rate for your industry. If your flat rate was 7.5% and the gross turnover for the 
period was £20,000 the amount of VAT would be £1,500 as shown below in 
the example entry. The example figures were taken from HMRC VAT Notice 
733 page 8. 

From To Total VAT Code VAT
Any Sales Any bank 1500 100% VAT 1500
 

The From and To accounts do not matter since the whole value of the trans-
action, being 100% VAT will only affect the VAT Control account (held in 
Current Liabilities in the Chart of Accounts). 

If your flat rate changes mid-period, you will need to apply the old and new 
rates to the separate turnovers for the part periods. You can then add the 2 
VAT due amounts together before making a single transaction as above, or 
you could enter 2 transactions to make it clear that you have followed the 
rules. Leave a comment in each transaction to describe the rate used and pe-
riod covered. 

You should check on www.hmrc.gov.uk that you are applying the correct rate 
and that the thresholds and rules are correct. Accountz cannot be held respon-
sible for incorrect returns.

Other VAT codes
If you make a sale to another EC country and they have a European VAT 
number (you will need to get this, verify it and store it in their customer record) 
then you can use the EC Sale VAT code (type an E to bring it up). 

As well as charging 0% VAT, this will also then be used to produce your VAT 
EC Sales list. 
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There are also the Reduced, Non VAT, Zero and Exempt rates. Just start typ-
ing the first letter and the popup will display the one you want. 

There are also 2 special rates:

100% VAT: use this if the transaction consists entirely of VAT. Typical case 
is where you forgot to add VAT to an earlier invoice and you are trying to 
collect just the missing VAT. 

Reverse Charge: HMRC recently introduced the idea of the reverse charge for 
certain items in the UK to combat 'carousel fraud'. Please check the legisla-
tion before following these instructions in its use, as things may have changed 
after this manual went to press. Reverse Charge works in the same way that 
EC Purchases work. The difference is that it applies to sales of certain goods 
to other VAT registered businesses in the UK. 

If you are VAT registered and sell goods (mostly electronic at the time of writ-
ing September 2006) to other VAT registered UK businesses then no VAT 
is charged provided the value of the total sales to that business in one day 
is £1,000 or more. To account for this requires 2 transactions to be made as 
follows: 

Amount VAT Code VAT Amount
1175.00 Reverse Charge 175.00
-175.00 100% VAT -175.00

  

The invoice needs to show the full amount including VAT, but the VAT it-
self is not collected (ie. the buyer will only send a cheque for £1,000 in this 
example). 

The VAT return will show no VAT (output tax) is payable if this were the 
only transaction for the period. Please do check with HMRC as the situation 
was not finalised and may be subject to change. 
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Once the VAT rate has been entered and Accountz has auto-calculated the 
VAT amount for you, you can then freely edit that amount if you need to. 
This applies more to purchase transactions than sales, since a supplier may 
round VAT differently to you. It is therefore important and necessary that you 
exactly reflect their invoice VAT amounts. 

VAT Date
You can set the VAT Date independently of the Tax Point. This is important 
if you are on the VAT Cash Accounting Scheme. Accountz uses the VAT 
Date to specify which VAT period each transaction is included in no matter 
which scheme you are on. If you are on Cash Accounting, it is important that 
you turn this column on, edit the VAT Date to the day it was paid and tick the 
Paid field. 

The Amount less VAT field is next. It shows you the net value of the transac-
tion. Some people like to see this column, others do not. If your screen display 
is limited in size, this may be one of the columns you choose to hide (see 
Chapter 14 Appendix A - Rapid Data Entry Column hide/show). If you edit 
this field, it will change the Total Amount field, so be careful. 

The Sales Document field follows and is a visual indication of whether this 
transaction is associated with a document produced from Accountz (eg. an 
invoice). It can also be used to generate a document if one doesn’t exist too. 

To generate a document for a transaction, double-click in this field.

The Description field is where you can add a comment for a transaction. It 
also forms the description field used in an invoice. If your business is a con-
sultancy and you issue an invoice describing the work done as, say ‘3 days’ 
marketing consultancy’ then that will show as the description for the transac-
tion created from the invoice. 
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The final default field is the Paid field. This determines if a transaction has 
been paid or not. And that, in turn, defines whether the transaction will be in-
cluded on a statement of account sent to the customer (if one has been associ-
ated with it). If you issue invoices on credit (ie. unpaid) you should ensure the 
To account is set to an account type of Unpaid Invoices (as stated earlier, you 
can rename it to something more meaningful). This ensures that transactions 
using it will automatically be marked as unpaid.

Updating Unpaid Invoices to Paid status
When the customer pays an invoice, it is important to remember to change 
the status of each transaction that has been paid in Sales Transactions. You 
will also need to make an entry in Transfer Transactions to transfer the money 
from debtors to the bank (or your uncleared funds account). 

If you wish, you can turn on the Paid Date column and edit the date to show 
when it was paid (see Chapter 14 Appendix A - Rapid Data Entry Columns 
show/hide). This can also be used as the cleared date if the transaction in-
cludes a bank (or other reconcilable type) account. 

Please see Appendix E for a guide to entering transactions.
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Automated Sales (Enterprise only)
This function can be accessed via the main menu by selecting Sales > Auto-
mated Sales.

Here you can set future, and if necessary, recurring transactions which will 
be inserted into the Sales Transaction Table on the specified date. Here we 
will set up a recurring Automated Sale, for a landlord collecting rent:

Click Sales>Automated Sales to open the component in your screen.

 Click the Create new transaction icon to add a new line to the table.

In the ‘Start Date’ field enter the date for the first transaction. For Period, 
select the regularity for the transaction to be inserted - hit the space bar to 
reveal your options. We will choose ‘Monthly - 1 Month’.

If you know the total number of times you wish the automated transaction to 
occur, enter this in the ‘Total Insertions’ field. If the recurring entry is ongo-
ing, enter ‘999’. In this instance the customer has a 12 month contract..

The ‘Next Date Due’ field will be completed automatically for you; skip to 
the ‘Customer’ field and select your customer.

For the ‘From Account’ field we will select ‘Rent’ as that is where the 
money is coming from, and ‘Bank Account’ for the ‘To Account’. Next, 
enter the Total Amount for each entry, say £600, and the VAT Code.

The description field is used if you wish to issue a document for this transac-
tion (the content of this field appears on the document).

Your automated entry should look like this:
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Preset Sales (Professional, Enterprise only)
This component enables you to enter regularly occurring complete transac-
tions with one click of the mouse, leaving you with only the Tax Point to 
enter.

To access the function, click Sales > Preset Sales from the main menu.

 Click the Create new transaction icon to add a new line to the table. We 
will create a Preset for some consutancy work that we do regularly.

In the Preset Name field, label the preset appropriately. We will name it 
‘Consultancy’. For ‘Customer’ we will leave the field blank in this instance 
as the preset will be used for. more than one customer. 

For the From Account, we will select the appropriate account. Here we will 
choose ‘Consultancy’. For the To Account we will choose ‘Bank Account’.

Fill the Total Amount (or Amount Less VAT) field and the VAT Code field 
as appropriate. We will charge £500 inc VAT, so we will enter ‘500’ in the 
Total Amount field, setting the VAT Code as Standard.

The Description field is used if you wish to issue a document for this trans-
action (the content of this field appears on the document). 

The Paid check box in this instance will be ticked as we will be paid imme-
diately for this work. Our Preset transaction looks like this:

The preset will now be available for selection from the top of the Sales 
Transactions Table (Sales > Sales Transactions). Select it from the drop 
down menu to insert it into the Sales Table with only the Tax Point to fill:
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Sales Reports
You can get a report on more or less anything you need from your accounts. 
Reports are created direct from any of the transaction tables. 

Either select a filter or create a new one (see Chapter 14 Appendix B for full 
details on how to create filters so you get only the transactions you need for 
the report) then click on the Print or Export button. 

 If you click the Print button, the report window will open where you 
can name your document and choose a template for its layout. Click on the 
Design/Print tab at the bottom of the window to preview the report before 
printing. 

 The Export button will open a filer window so you can save the data to 
your hard drive. You will then be able to load it into any spreadsheet. 

Creating filters for reports is the same no matter which area of Accountz you 
are in. This is why it has its own dedicated section at the back of this manual. 
The principles are simple; you set a series of ranges (eg. date) and options (eg. 
Cleared and Paid only, or sales greater than £30). There are almost no limits 
to what you can do. 
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Suppliers
There are two supplier components. The first, called Supplier Table, is a 
spreadsheet view of all suppliers where you can also add new ones. This 
is present in all versions of Business Accountz. Adding new suppliers here 
makes them available in all other areas of Accountz. The second, called Sup-
plier Records, shows a detailed breakdown of each supplier's activity. This is 
available in the  Enterprise edition. 

Supplier Table

 Click on the Payments menu option and choose Supplier Table. This 
opens the table showing all of your suppliers. 

 Add a new supplier by clicking the + button in the toolbar. You can add 
their address, notes and main email amongst other things. 

 You can export this list to a spreadsheet (eg. to email all suppliers) using 
the export button in the toolbar. 
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Supplier Records (Enterprise only)

 Click on the Payments menu option and choose Supplier Records. This 
consists of 2 panels: 

The left panel contains the main details of a supplier, eg. the name, address 
and any useful notes. The right panel contains a number of tabs including:

Contact: You can multiple contacts for each supplier

Delivery: You can add multiple delivery addresses for each supplier

Statement: Shows how much you owe the supplier and over what period 
of time

Purchases: A filterable list of your purchase transactions from the se-
lected supplier

•

•

•

•
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Transfers: A filterable list of your transfer transactions relating to this 
supplier

Orders: A filterable list of purchase orders produced for a supplier

Adding a new supplier

 Click on the Add a new record button on the left hand panel’s lower tool-
bar. This will clear the data fields for you to enter your new supplier’s details 
(please note that your entry is automatically saved). If the name is Jill Smith 
you will be able to find Jill easily by searching for anything beginning with 
J. You may also want to find Jill by her surname, Smith. Type Smith and you 
will be able to locate her using either name.

Hiding a supplier record

 If a supplier is no longer active you can hide the record by clicking on the 
Show/Hide button in the left hand panel lower toolbar.

Showing hidden supplier records
There is a setting in Configuration (from the Tools menu) that enables all sup-
plier records to be viewed even if they are hidden. This is described earlier in 
this chapter in ‘Showing hidden customer records’.

Finding a supplier 

Use the alphabetical search tool on the left of the supplier name and address 
panel to locate any supplier. Either click on one of the alphabetical letters in 
the panel, type something into the search field at the top of the panel, or click 
on the ? (question mark) above the first letter (A). These actions will bring up 
a list that has been filtered according to what you have clicked on or typed. 
The more you type the nearer you will get to an exact match. You can select 
any of the choices from the list using the up or down buttons then pressing the 
Enter key, or select with the mouse. 

•

•
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If a supplier record has been created but not yet given a name, it will be shown 
with its unique internal ID number instead (eg. cs.142536479.123).  You can 
fill in the name whenever you like. Records like this are displayed by clicking 
on the ? button in the supplier lookup bar on the left hand side of the record. 

The ? button is also used to display suppliers whose names start with a number 
or a punctuation mark. You can also search for these direct using the search 
field above the alphabetical search tool.

Supplier History

 Click on the Recently viewed records button on the lower toolbar to pick 
from an alphabetical list of suppliers you have recently viewed.  

Purchase Orders

Designing a Purchase Order

This process is very similar to ‘Designing an Invoice’ (see earlier in this chap-
ter). 

From the File > Documents option, select the Purchase Orders tab and  choose 
one of the default templates.
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 Click on the Create Template Document button on the bottom right of 
the screen. This will open the Document Editor window (opposite). Please see 
Chapter 14 Appendix C for full details of designing documents.

Creating a new Purchase Order

 Click on the New Purchase Order button in the left hand panel of Sup-
plier Records. This will open a new Purchase Order window in the Document 
Editor.

Editing an existing Purchase Order
Each time you click on the New Purchase Order button, you will be creat-
ing a new document. If you want to edit or add to an existing document, 
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use the main menu File > Document Editor option or find the transaction 
in Payments>Purchase Transactions and double-click on the Sales Document 
field from there. 

Purchase Order numbers
The Reference field holds the purchase order reference number. You can 
choose the computer generated number, this is incremented automatically, or 
you can enter your own. You can change the starting number via the File > 
Documents menu option, then choosing the document type from the tabs and 
editing the Last Document Number field. 

Purchase Order table

The purchase order table is where you enter the work, services and/or goods 
the purchase order is for. You can select the columns you want to use by 
right clicking on any column heading and choosing which you want to hide 
or show from the popup menu. You can turn on Quantity and Unit Price 
columns. The Unit Price column can be with or without VAT. Columns are 
auto-calculated as soon as you move to another field. 

Each row you create in a purchase order will create a new transaction row in 
Purchase Transactions (see the next part of this tutorial). This gives you total 
control over purchase order analysis.

If you wish, you can change the columns you see in the Purchase Order table 
by right clicking (or Ctrl+Click) on any column heading and choosing from 
the drop down list.
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The Description column adds a description to a row. Note that the description 
field can be as long as you like. It will automatically word-wrap. To create a 
new paragraph with a blank line in between, press Shift + Enter twice. 

Specify the From Account. This will be where the money will eventually 
come from to pay for this order. It will typically be Unpaid Bills (ie. a credi-
tor) or possibly a bank account. 

You will also need to specify an account to debit (the Account To field). This 
will typically be the Stock Bought account (or, say, the Consultancy account 
if you are ordering a service).

You can enter default accounts specifically for any supplier in the relevant 
fields in the supplier’s record. If you do that, they will automatically appear 
in the purchase order so you don’t need to enter them every time you produce 
a new one. 

Enter the Total Amount and VAT Code if you are VAT registered. 

Add as many extra lines as required using the Create transaction button or 
simply press the Enter key when you reach the end of the row. 

Printing a Purchase Order

 When you are happy with your order you can either leave it for further 
editing or additions or click on the Design/Print tab at the bottom of the win-
dow to review and print it. 

Contacts Tab

Adding a new contact

 Click on the first tab in the right hand panel named Contact. Click on the 
Add a new contact button. As per adding a new customer, this will clear the 
data fields ready for you to enter your new contact’s details. 
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Removing a contact

 Click on the Remove a contact button and the current contact record will 
be deleted. Note that this cannot be undone. 

Viewing different contacts
In the Contact tab in the right hand panel, click on the drop down button on 
the right of the Name field. Select the contact details you want to view from 
the list. 

Delivery Addresses Tab

Adding/Deleting/Viewing delivery addresses 

 Click on the Delivery tab in the right hand panel, then click on the Add a 
new delivery address button (in the lower toolbar) to add alternative delivery 
addresses for the current supplier. You can select different addresses and re-
move them in the same way just described for Contacts. 

Note there is a button, labelled ‘Copy your Address’, that will insert your 
name and address into the delivery address (this is copied from the first record 
in the Your Business component). 
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Statement Tab

This shows your credit history with the supplier. You can change the credit 
terms using the Edit buttons to the right of each Period field. You can see all 
the unpaid transactions in the table. Click on the report button marked with an 
S to view and print a statement. 

Purchases Tab
The Purchases tab shows you the complete history of transactions. You can 
filter the transactions to get more detailed reports using the Add Filter but-
ton.

Almost any report is possible. For example, you could create a filter that shows 
you only purchases with an amount over 1,000 during the last 3 months. The 
filter is saved, so you can also reuse it at anytime. See Chapter 14 Appendix B 
for details of how to create new filters. 
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Transfers Tab
The Transfers tab shows you the complete history of payments to this sup-
plier. You can filter these transactions to get more detailed reports using the 
Add Filter button. Almost any report is possible. For example, you could cre-
ate a filter that shows you only payments over 500. See Chapter 14 Appendix 
B for details of how to create new filters. 

Orders Tab
When you create a purchase order, it is saved and shown in the Orders tab. 
All orders for all suppliers are available from the Payments > Purchase Order 
Transactions menu. 

 If you wish to convert a purchase order into a transaction in the Purchases 
tab (i.e.when the purchase order is fulfilled) you can do so by selecting the 
aforementioned Purchase Order in this table, and then clicking the ‘Insert Pur-
chase Transaction based on this Purchase Order’ button.

Printing and exporting supplier reports
All transactions shown in the tables can be printed or exported using the Print 
(Professional, Enterprise only) or Export buttons in the right hand panel’s 
toolbar. The Print button opens the Document window. Here you can name 
the document and choose a transaction report layout template (templates are 
designed using the Accountz Designer). 
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Payments
Whenever you buy anything for the business, whether it is an asset like 
equipment, stock to resell or business expenses, they are all entered directly 
into the Purchase Transactions table. It means you can see everything you 
have bought in one place. Unlike other systems where periods are ‘closed’ 
on a regular basis and difficult to access afterwards, Accountz lets you see 
everything you have done from day one onwards.

If you do not need or want to see all your purchase transactions, set a filter 
(see Chapter 14 Appendix B) to limit the scope. You could set a default filter 
to show you just the last 3 months purchases for example. You can change 
the filter to view another aspect of your purchases with just 2 clicks of the 
mouse.

The point is, you can always see everything you have done, and you can see 
it in one place and without having to produce a report.
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Purchase Transactions

 Click on the Purchase button or select Purchase Transactions from the 
Payments menu.

All your purchase transactions are shown in the table in this component. All 
tables within Accountz are extremely customisable. Learn the attributes of 
just one table, and you will understand the way all the other tables work.

The Accountz Rapid Data Entry system is designed to help you complete 
transactions with the minimum of effort using drop down calendars for date 
selection and auto-filtering popup menus for account names as well as auto-
VAT calculation. There is a complete description of Rapid Data Entry in 
Chapter 14 Appendix A.

By default, only certain columns are showing in the transaction tables. These 
are the most commonly used. Full details of every possible column can be 
found in Appendix D. For the purposes of this tutorial, we will cover the 
basics. But before we do that, there are a few things you should know.

Just like sales transactions that we covered in the last section, purchase 
transactions should have a supporting source document. Eg. a bill, till receipt 
or petty cash slip. Without supporting evidence you will have no proof that 
what you bought was a legitimate business expense or capital purchase. You 
may then be liable for more tax.

It is just as important if you are registered for VAT too. Without a source 
document that contains at least the supplier’s VAT number you will not be 
able to reclaim the VAT (assuming you are VAT registered). You can find 
out more about VAT via the www.hmrc.gov.uk website.

Entering a new transaction

 To start a new transaction click the Create a new transaction button. A 
new row will be created in the table and the flashing cursor will appear in the 
first column ready for you to enter the transaction date.
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The date you enter for the transaction is called the Tax Point. It is the date on 
which the transaction was conducted and therefore the date used by HMRC 
(and yourself) to decide which tax year the transaction belongs to.

The UK tax system is based on the accrual method. That is, a transaction 
becomes liable for tax purposes on the date it occurred, not on the date it 
was paid (this has nothing to do with different VAT schemes such as VAT 
Cash Accounting, where you can only reclaim the VAT when the purchase 
has been paid for, please visit www.hmrc.gov.uk for further details of VAT 
schemes). The VAT portion of any transaction becomes due according to an-
other date field: VAT Date. This is automatically copied from the Tax Point 
you enter when you first enter it. After that it can be edited independently.

To enter a date, start typing it. As soon as you press the first key a popup 
calendar will show. The calendar is interactive and will change date as you 
type, you can continue typing or you can select a date from the calendar.

The calendar will also base the date on the previous entry. You do not need 
to enter the whole date everytime. If the following transaction is a day later, 
only enter the day and press Enter or Tab. This is a great time saver and is 
often overlooked. Note also that you can use any separator you like. It does 
not have to be a forward slash. Use a space or a dot if you like. The finished 
date will be auto-formatted for you according to the preferences set in the 
Configuration settings (see Chapter 12 Tools Configuration).

The Reference field is there so you can add a reference to a transaction. This 
could be the number on a receipt, or some other identifier.

Accountz includes a column named Transaction Number. An automated 
transaction identifier (number) is inserted into this column every time a 
transaction is entered. You will need to turn this column on (see Chapter 14 
Appendix A - Rapid Data Entry Column hide/show) to view it. The number 
auto-increments. The field is not editable. If you write this number on the 
source document you will always be able to match up the transaction with 
the document. The number runs through all transaction tables, so transaction 



Business Accountz User Manual

83

number 1 may be in sales and transaction number 2 may be in purchases. 
What matters is that the number is a unique identifier and cannot be edited.

The next 2 fields are the 2 most important to understand. They give the 
transaction life. They describe precisely what happened. They tell the system 
where the money came from and where it went to (known as a credit and a 
debit in a traditional double-entry system, please see Chapter 1 Introduction 
for a thorough explanation).

The From field specifies where the money came from. In the case of pur-
chase transactions it will be from a bank, credit card, cash account or bought 
on credit. By default a bank account called Bank is part of your chart of ac-
counts. Enter a B in this field and a popup menu will open with this account 
already selected. Just press Enter to insert it into the transaction (it is very 
likely you will have renamed it with your real bank’s name, in which case 
type the first letter of that name).

The more of the name you type into a field that includes a popup menu, the 
closer you will get to the account you are looking for. Once you have nar-
rowed down the list, use the up/down arrow keys to highlight the account 
you want and press Enter. To see the complete list, delete any characters you 
have already typed.

If you are entering an unpaid bill, then the From account should be Unpaid 
Bills (also known as Creditors or Trade Creditors). Typing a U into the field 
will make it appear in the list. Shortly we will cover what to do when you 
pay the bill.

The To field specifies where the money went to (ie. was spent on). It could 
be for some equipment you have just bought for the business, some station-
ery (eg. a ream of paper for your printer) or maybe your staffs’ wages. Start 
typing the name of the account the money went to and the popup menu will 
appear ready for you to select the correct account.

Next we have Total Amount. This is the total amount you paid (or owe) for 
the transaction (including VAT if it contains a VAT element).
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EC Acquisitions and VAT
If you are VAT registered and buying goods from another EC country where 
they are not adding VAT because you supplied your UK VAT number, you 
will need to manually add VAT at the current rate to the total and enter that 
into the Total Amount. You can use the Accountz calculator tool to  work it 
out (see Chapter 12 Tools Calculator). The equation is simple. Multiply the 
total by 1.175 (assuming the rate is 17.5%). Eg. if the VAT less total is 100, 
multiplying it by 1.175 increases it to 117.50, which is the price plus VAT 
at 17.5%. Or you can get Business Accountz to work it out for you by swap-
ping the Total Amount column with the Total less VAT column (just drag 
the columns across to move them). Entering, say, 100 in the Total less VAT 
column, then S into the VAT Code column will result in a Total Amount of 
117.50 in our example.

You must also make a second entry when accounting for EC acquisition 
VAT. Please see the EC Reverse Acquisition Box 4 paragraph a few pages 
further on. This is because the VAT you have manually added needs to be 
reversed back in the VAT return itself (box 4 of the return).

Entering Refunds
If you need to enter a negative amount (eg. you received a refund for an 
earlier payment) you will need to empty the field before entering the minus 
sign. If the field changes to show a red border, it indicates a mistake and that 
is usually because of a leading zero (eg. 0-34.99, just delete the zero).

The VAT Code column is next and is where you specify the VAT to be 
applied to the transaction. There are a number of VAT codes available. The 
most common is Standard, which at the time of writing is 17.5% To enter a 
VAT code start typing its name. S will open the filtered popup menu with 
Standard highlighted ready for you to press Enter to confirm. As soon as you 
do this, Accountz will calculate the VAT for you and place the amount in 
the Vat Amount field. If this is an EC Acquisition purchase then type E and 
select EC Acquisition Box 2 from the VAT code popup menu.
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Important Warning: Auto-calculated VAT may be a different amount than 
specified on the source document (eg. your receipt). If so, it is very impor-
tant you edit the amount of VAT so it matches that shown on the document. 
Claiming more VAT than the document shows is VAT fraud, so do not rely 
on any automated procedure for calculating the VAT unless the VAT is not 
specified on the source document (eg. a shop till receipt). In all cases you 
should be quite sure the item bought contains VAT at the specified rate and 
the receipt also includes the seller’s VAT number.

VAT Schemes
Accountz can handle the following 3 VAT schemes:

1.	 Standard Scheme

2.	 Cash Accounting Scheme

3.	 Flat Rate Scheme

VAT Standard Scheme
VAT is due on every transaction as soon as it is raised regardless of whether 
it is paid or not. The VAT Date field is used to decide which VAT period a 
transaction belongs to. This is the normal scheme given to all VAT regis-
tered businesses unless they specifically ask to be put on another scheme 
(which can only be done via HMRC).

VAT Cash Accounting Scheme
VAT is due on every transaction only when it is paid. The VAT Date field 
is used to decide which VAT period a transaction belongs to. The Paid field 
must also be ticked for the transaction to be included in the return. You may 
need to turn on the VAT Date column, please see Chapter 14 Appendix A 
- Rapid Data Entry Columns hide/show.
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VAT Flat Rate Scheme
VAT is calculated only on gross sales. This is covered in detail in the Sales 
Transactions section of this tutorial. However, there are some purchases 
where you can claim the input VAT back direct. In these cases, treat the 
transactions as normal VAT purchases using the Standard or other applicable 
rate (at the time of writing the threshold for this was a  £2,000 or greater 
purchase inclusive of VAT for capital items only, but you must check with 
HMRC to see if this is still applicable).

For your other normal purchases you can use the Flat Rate Scheme VAT 
code if you like, otherwise you should use the Non VAT code. Whatever you 
choose, the Total Amount should be the gross total and the VAT Amount 
should be zero (you cannot claim VAT input tax back under this scheme un-
less it is for an expensive capital item as outlined above).

If you choose to mark purchases using the Flat Rate Scheme VAT Code 
please ensure you follow the guidelines in HMRC publications Notice 733 
on which boxes of the return should be filled in. Entering the VAT payable 
and how it affects the VAT Return in Accountz is covered in detail in the 
Sales Transactions section of this tutorial.

Other VAT codes
There are also the Reduced, Non VAT, Zero and Exempt rates. Just start typ-
ing the first letter and the popup will display the one you want.

There are also 2 special rates:

100% VAT: use this if the transaction consists entirely of VAT. A typical 
example is where you have imported something and HMRC have sent you a 
bill for the unpaid VAT.

EC Reverse Acquisition Box 4: If you have entered an EC Acquisition 
purchase (see the earlier section EC Acquisitions and VAT) you will need to 
make a second entry to reclaim the VAT back. This second entry will be a 
mirror of the original but the Total Amount will be negative and will cover 
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the VAT element only. The VAT Code will be EC Reverse Acquisition Box 
4 (type an E in the VAT Code field and the popup will include it in the list 
ready for you to select it). Here is what the core part of the two transactions 
will look like:

Amount VAT Code VAT Amount
117.50 EC Acquisition Box 2 17.50
-17.50 EC Reverse Acquisition -17.50

The next field in a purchase transaction is called Amount less VAT. It shows 
the net value of the transaction. Some people like to see this column, oth-
ers do not. If your screen display is limited in size, this may be one of the 
columns you choose to hide (see Chapter 14 Appendix A - Rapid Data Entry 
Column hide/show).

VAT Date: You can set the VAT Date independently of the Tax Point. This 
is important if you are on the VAT Cash Accounting Scheme. Accountz uses 
the VAT Date to specify which VAT period each transaction is included in 
no matter which scheme you are on. If you are on Cash Accounting, it is 
important that you turn this column on, edit the VAT Date to the day it was 
paid and tick the Paid field.

The Description field is where you can add a comment for a transaction. 
There is also a separate Notes field available for each transaction.

The final (default) field is the Paid field. This determines if a transaction has 
been paid or not. If you enter a bill you have not yet paid you should ensure 
the From account is set to an account of type Creditors (you can rename it 
to something more meaningful if you wish). This ensures that transactions 
using it will automatically be marked as unpaid.
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Updating Unpaid Bills to Paid status

When you pay a bill, it is important to remember to change the status of the 
transaction by altering the Paid field of the relevant transaction in Purchase 
Transactions. You will also need to make an entry in Transfer Transactions 
(see section below) to transfer the money from bank (or from whichever ac-
count the money is coming from) to Unpaid Bills (aka Trade Creditors).

Please see Appendix E for a guide to entering transactions.

Capital Purchase or Business Expense?
A common problem for many people is deciding which account to use for 
purchases. If you have bought some stamps and you have an account named 
Postage, this is not a problem, but what if you buy a book to help you under-
stand some aspect of running your business? Where do you record this?

You could open a new account in the expenses section of your profit and loss 
and call it ‘Books purchased’. But this would be wrong. Why? Well, a book 
that you intend to keep and use for your business is not an expense. It is an 
asset. You cannot offset all its value immediately against tax (which you 
can do with expense accounts). The reason is that the book will outlast your 
financial year. An expense is something that you use once and cannot use 
again. The book on the other hand retains a value until you dispose of it.

So, any items you buy for use within the business that you still have after 
the end of your financial year and therefore still has a value to the business 
is termed a Capital item. Typical examples are tools and equipment, fixtures 
and fittings for your office, IT purchases, business vehicles and buildings.

All these items will be held in accounts in the Fixed Assets section of the 
Chart of Accounts.
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The value of most capital items varies with time. There is usually a decrease 
in value. This is called depreciation. You do need to account for this, but it 
is something that is typically done at your financial year end. It is covered in 
detail at the end of this tutorial in the Year End section.

Purchasing goods or stock for resale
If you ticked the box in the company setup wizard stating that you bought 
goods for resale, some extra accounts will have been added to the Chart of 
Accounts:

A Stock Bought account in the in Assets > Current Assets

A Stock Sold account in Equity > P&L > Sales > Cost of Sales

When you purchase stock to resell, you enter a new transaction in Purchase 
Transactions. The money will come From your bank or creditors account if it 
is unpaid. It will go To the Stock Bought account.

Assuming this is your first year’s set of accounts, at your financial year end 
you will need to do a stock take to work out the value of stock you have left. 
You can then add a new transaction in Transfer Transactions. The money 
will come From Stock Bought and go To Stock Sold.

Buying raw materials for manufacturing
If you ticked the box in the company setup wizard stating that you manu-
factured goods, some extra accounts will have been added to the Chart of 
Accounts:

A Raw Materials Bought account in Assets > Current Assets

A Finished Goods account in Assets > Current Assets

A Finished Goods Sold account in Equity > P&L > Sales > Cost of Sales

When you purchase raw materials to manufacture stock, you enter a new 
transaction in Purchase Transactions. The money will come From your 
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bank or Unpaid Bills account if it is unpaid. It will go To the Raw Materials 
Bought account.

At your financial year end you will need to do a stock take to work out the 
value of raw materials you have used up. You can then add a new transac-
tion in Transfer Transactions. The money will come From the Raw Materials 
Bought account and go to the Finished Goods account in Assets > Current 
Assets. Finally, assuming you sold some of the finished goods, you make 
another Transfer Transaction From Finished Goods To Finished Goods Sold. 
This updates the profit and loss account.

The point of all these accounts is that at any time, you will have a stock of 
raw material and a stock of unsold but finished goods. You can only claim 
for these when you actually sell them, which is represented in the last trans-
action in the previous paragraph.

Automated Purchases (Enterprise only)
This component enables you to automatically insert future and recurring 
purchase transactions, such as direct debits. It follows the same logic as 
Automated Sales described on p.66 of this tutorial.

Preset Purchases (Professional, Enterprise only)
This function enables you to enter complete transactions (bar the date) into 
the Purchase Transactions Table with a single mouse click, useful if you 
have commonly occurring entries. Please see the description of Preset Sales 
(p.68) for how to use these.

Purchase Reports
You can get a report on more or less anything you need from your accounts. 
Reports are created direct from any of the transaction tables.

Either select a filter or create a new one (see Chapter 14 Appendix B) then 
click on the Print or Export button.
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If you click the Print button, the report window will open where you can 
name your document and choose a template for its layout. Click on the 
Design/Print tab at the bottom of the window to preview the report before 
printing.

The Export button will open a filer window so you can save the data to your 
hard drive. You will then be able to load it into any spreadsheet.
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Transfers
Transfer transactions record money being passed around the business or 
loaned into or out of it, such as topping up petty cash from your bank, or in-
jecting some money into the business. Paying taxes including VAT as well as 
tax rebates can all be entered as transfer transactions too. 

If you do not need or want to see all the transfer transactions, set a filter (see 
Chapter 14 Appendix B) to limit the scope. You could set a default filter to 
show you the transfers you have made in the last 3 months for example. You 
can change the filter to view another aspect of your transfers with just 2 clicks 
of the mouse. 

The point is, you can always see everything you have done, and you can see it 
in one place and without having to produce a report. 

Transfer Transactions

 

Click on the Transfer button or select Transfer Transactions from the General 
menu in the main menu bar at the top of the main Accountz window.

All your transfer transactions are shown in the table in this component. All ta-
bles within Accountz are extremely customizable. Learn the attributes of just 
one table, and you will understand the way all the other tables work. 
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The Accountz Rapid Data Entry system is designed to help you complete 
transactions with the minimum of effort using drop down calendars for date 
selection and auto-filtering popup menus for account names plus there are 
Preset Transfers that let you enter commonly occurring transfers such as pay-
ing money into the bank with a click of the mouse. There is a complete de-
scription of Rapid Data Entry in Chapter 14 Appendix A. 

By default, only certain columns are showing in the transaction tables. These 
are the most common ones used. Full details of every possible column can be 
found in Chapter 9. For the purposes of this tutorial, we will cover the basics. 
But before we do this, there are a few things you should know. 

Unlike sales and purchases, supporting or source documents for transfers are 
not quite so important unless they directly affect accounts in the profit and loss 
section or are for loans that may be affected by company law or other govern-
ment regulations. If, for example, you loan your business a sum of money 
and you are the sole proprietor (ie. owner) then there is no need to prove to 
anyone that you lent the business some money. However, if the business is a 
limited company, there is every reason for you to have some kind of formal 
documentation, and to tie that documentation into the transaction by way of a 
reference. If the company becomes insolvent, you may need this as proof that 
you have a claim on the company. 

The bottom line is that if you have some supporting documentation for any 
transactions you should keep that documentation and also give it and the 
transaction a unique reference so that you can tie the two together later on  if 
you should ever need to do so. 

Entering a new transaction

 To start a new transaction click the Create a new transaction button. A 
new row will be created in the table and the flashing cursor will appear in the 
first column ready for you to enter the transaction date. 
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The date you enter for the transaction is called the Tax Point. It is the date on 
which the transaction was conducted and therefore the date used by HMRC 
(and yourself) to decide which tax year the transaction belongs to.

To enter a date, start typing it. As soon as you press the first key a popup cal-
endar will show. The calendar is interactive and will change date as you type, 
you can continue typing or you can select a date from the calendar. 

The calendar will also base the date on the previous entry. This speeds things 
up. If your first entry was on the 25th and your next transaction is dated the 
28th, just enter 28 and press Return. The rest of the date will be copied auto-
matically.

This is a great time saver and is often overlooked. Note also that you can use 
any separator you like. It does not have to be a forward slash. Use a space 
or a dot if you like. The finished date will be auto-formatted for you accord-
ing to the preferences set in the Configuration settings (see Chapter 12 Tools 
Configuration).

The Customer field comes next. If you have entered any customers into the 
system, then typing the first part of their name (or alternative lookup text) will 
immediately display a popup menu. The menu will show you just the match-
ing records. The more you type, the narrower the choice will become. If you 
delete what you have typed, eventually you will end up with the complete list. 
Whilst the popup is displayed you can use the up/down arrow keys on your 
keyboard to navigate through the list. If the customer you want is there, select 
it and press Enter. This transaction will now be associated with the selected 
customer.

If you later edit the customer’s name in Customer Records, all related transac-
tions will update automatically. 

Associating a customer with a transaction also means you can view that trans-
action directly from the customer’s record. 

This field is mostly used to associate and update a customer’s account when 
they have paid off an invoice.
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The exact same applies to the Supplier field, except that associates the sup-
plier with a payment you have made to them. 

The Reference field is there so you can add a reference to a transaction. This 
could be the invoice number(s) or some other identifier.

Accountz includes a column named Transaction Number. An automated trans-
action identifier (number) is inserted into this column every time a transaction 
is entered. You will need to turn this column on (see Chapter 14 Appendix A 
- Rapid Data Entry Column hide/show) to view it. The number auto-incre-
ments. The field is not editable. If you write this number on the source docu-
ment you will always be able to match up the transaction with the document. 
The number runs through all transaction tables, so transaction number 1 may 
be in sales and transaction number 2 may be in transfers. What matters is that 
the number is a unique identifier, so cannot be edited and can therefore be as-
sociated with a single document. 

The next two fields are the two most important to understand. They give the 
transaction life. They describe precisely what happened. They tell the system 
where the money came from and where it went to (known as a credit and a 
debit in a traditional double-entry system, please see Chapter 1 Introduction 
for a thorough explanation). 

The From field specifies where the money came from. In the case of transfer 
transactions it could be from anywhere, but will almost always be from a 
bank, credit card, cash, debtors or undeposited funds account. 

The To field specifies where the money went to. 

Typical Transfer Examples
If a customer is paying an invoice, it should come from Unpaid Invoices and 
go to wherever it is paid (typically the bank).

If you are paying a bill, it will typically come from your bank to Unpaid 
Bills.



Business Accountz User Manual

96

If you are paying off a credit card, the flow of money will be from, typically, 
your bank to your credit card account.

Topping up petty cash would be from bank to petty cash.

Paying cash into the bank would be a transfer from cash to bank.

Next we have Total Amount. This is the total amount transferred. 

For more information on entering transactions, please see Appendix E.

Transfers and VAT
There are no VAT columns in the Transfer Transactions. All input (purchases) 
and output (sales) VAT is handled in Sales Transactions and Purchase Trans-
actions. However, there is one area of VAT that is handled in this area... 

Paying your VAT return (or receiving a refund)
After you have produced a VAT return you will need to make a transaction 
to cover the amount you owe HMRC (or the amount they owe you) for the 
period. Transfer Transactions is the place to make this entry. 

If you owe HMRC money, the transaction will be From your bank (or other 
money source) To a default account called VAT Control. This is held in the 
Liabilities Group  of your chart of accounts under Current Liabilities. Just type 
a V into the To field and it should show up on the list. 

If the VAT return shows that HMRC owe you money, then the transaction is 
exactly the same as for a payment, but the accounts are switched around (from 
VAT Control to bank). 

The Description field is next. This is where you can add a comment for a 
transaction. Like all transaction components, there is also a Notes field that 
you can use for further comment or reference. 
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Automated Transfers (Enterprise only)
This component enables you to automatically insert future and recurring 
transfer transactions. It follows the same logic as Automated Sales described 
on p.66 of this tutorial.

Preset Transfers (Professional, Enterprise only)
This function enables you to enter complete transactions (bar the date) into 
the Transfer Transactions Table with a single mouse click, useful if you have 
commonly occurring entries. Please see the description of Preset Sales (p.68) 
for how to use these.

Transfer Reports
You can get a report on more or less anything you need from your accounts. 
Reports are created direct from any of the transaction tables.

Either select a filter or create a new one (see Chapter 14 Appendix B) then 
click on the Print or Export button. 

If you click the Print button, the report window will open where you can name 
your document and choose a template for its layout. Click on the Design/Print 
tab at the bottom of the window to preview the report before printing. 

The Export button will open a filer window so you can save the data to your 
hard drive. You will then be able to load it into any spreadsheet. 

Creating filters for reports is the same throughout Business Accountz. This is 
why it has its own dedicated section at the back of this manual. The principles 
are simple; you set a series of ranges (eg. date) and options (eg. all payments 
from Debtors). There are almost no limits to what you can do. 
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Journal
The journal is an alternative way to do transfers (see previous section). It dif-
fers in that it follows traditional double-entry. That is, each row in the table 
affects just one account. So to achieve a minimal transaction you will need to 
make at least 2 entries (one states the account the money came from, a credit 
and the other states where it went to, a debit). 

Note that we said ‘at least 2’. This is because you can enter as many as you 
like. The golden rule with a journal is that the credits must equal the debits 
or your books will not balance (that is one of the reasons you have the safer 
alternative sales, purchase and transfer transaction tables, it is very difficult to 
go wrong without the system giving you a warning). 

The Accountz year end wizard uses the journal to transfer balances from the 
profit and loss account into the retained earnings account (so that your profit 
and loss starts at zero for the new year, but it could just as easily use transfer 
transactions instead). Unless you particularly want to use the journal, you can 
ignore it. 

Journal Transactions
If you do not need or want to see all the journal transactions, set a filter (see 
Chapter 14 Appendix B) to limit the scope. You could set a default filter to 
show you the journal entries just for the current year. You can change the filter 
to view another aspect of your journal entries with just 2 clicks of the mouse.

The point is, you can always see everything you have done, and you can see it 
in one place and without having to produce a report.

 Click on the Journal button or select Journal Transactions from the Gen-
eral menu in the main menu bar at the top of the main Accountz window.

All your journal transactions are shown in the table in this component. All ta-
bles within Accountz are extremely customizable. Learn the attributes of just 
one table, and you will understand the way all the other tables work.
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The Accountz Rapid Data Entry system is designed to help you complete 
transactions with the minimum of effort using drop down calendars for date 
selection and auto-filtering popup menus for account names. There is a com-
plete description of Rapid Data Entry in Chapter 14 Appendix A. 

By default, only certain columns are showing in the transaction tables. These 
are the most commonly used. Full details of every possible column can be 
found in Chapter 14, Appendix D. For the purposes of this tutorial, we will 
cover the basics. 

Making a new entry

 To start a new entry click the Create a new entry button. A new row will 
be created in the table and the flashing cursor will appear in the first column 
ready for you to enter the date. This field has all the attributes of other date 
fields within Accountz, please read the previous sections on transactions or 
take a look at Chapter 14 Appendix A - Rapid Data Entry. 

The date you enter for the transaction is called the Tax Point. It is the date on 
which the transaction was conducted and therefore the date used by HMRC 
(and yourself) to decide which tax year the transaction belongs to. 

The Reference field is there so you can add a reference to a transaction. This 
could be the invoice number(s) or some other identifier. 

Accountz includes a column named Transaction Number (see above). An au-
tomated transaction identifier (number) is inserted into this column every time 
a transaction is entered. You will need to turn this column on (see Chapter 14 
Appendix A - Rapid Data Entry Column hide/show) to view it. The number 
auto-increments. The field is not editable. If you write this number on the 
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source document you will always be able to match up the transaction with 
the document. The number runs through all transaction tables, so transaction 
number 1 may be in sales and transaction number 2 may be in transfers. What 
matters is that the number is a unique identifier, so cannot be edited and can 
therefore be associated with a single document. 

The Account field is next. This specifies which account is involved in the 
entry. To see examples, please refer to the previous section entitled Transfer 
Transactions. 

Next we have the To (Debit) amount. Fill this in with the amount if the money 
is going To the account named for this entry. Eg. if the account is bank and 
you are paying money into it, then place the amount in this field. 

If money is coming From the account, then place it in the next field: Credit. 

Account Debit Credit
Petty Cash 100  
Bank  100

Example of a double-entry in the journal: Transferring £100 from the bank to 
petty cash. 

The Description field is next. It is where you can add a comment for each 
entry.  

Journal Reports
You can get a report on more or less anything you need from your accounts. 
Reports are created direct from any of the transaction tables. 

Either select a filter or create a new one (see Chapter 14 Appendix B) then 
click on the Print or Export button. 
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If you click the Print button, the report window will open where you can name 
your document and choose a template for its layout. Click on the Design/Print 
tab at the bottom of the window to preview the report before printing. 

The Export button will open a filer window so you can save the data to your 
hard drive. You will then be able to load it into any spreadsheet. 

Creating filters for reports is the same no matter which area of Accountz you 
are. This is why it has its own dedicated section at the back of this manual. 
The principles are simple; you set a series of ranges (eg. date) and options (eg. 
all transfers marked ‘Close year’ in the description field). There are almost no 
limits to what you can do. 
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VAT

The VAT return is very simple in Accountz. You click on the VAT button 
in the main toolbar or click on VAT from the main menu and select VAT 
Return. 

It has 2 tabs: VAT Configuration and VAT Return. VAT Configuration lets 
you set or check certain options such as your VAT start date (when you first 
became VAT registered) and your VAT period (set to 3 months or quarterly 
by default). These options will have been set automatically for you when you 
first ran Accountz. So unless there are any changes, all you need to do is click 
on the VAT Return tab then choose the period you want to see from the drop 
down menu on the right.  By default that will always be the current return, so 
in most cases your VAT return is always just a single click away (and assum-
ing you have entered all your transactions, always up to date). 
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VAT Cash Accounting Scheme
If you are on the VAT Cash Accounting Scheme please ensure the Cash Ac-
counting box is ticked in the VAT Configuration tab. You must also ensure 
you understand which VAT related fields you need to fill in when making 
sales and purchase transactions. These are covered in detail in the Sales Trans-
actions and Purchase Transactions sections of this tutorial. There are two im-
portant fields for those on the Cash Accounting scheme to be aware of: 

VAT Date: The VAT Date determines which VAT return a transaction 
belongs to. This is different from the Tax Point which determines which 
Income Tax year the transaction belongs to. The VAT Date field is fully 

1.
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editable and works independently of the Tax Point, although unless set 
otherwise it will show the same date as the Tax Point.

Paid check box: This must be ticked of you want a transaction to appear 
on the VAT return (Cash Accounting scheme only).

 The VAT return shows you what to enter in each box. It also shows you the 
transaction tables for your outputs (sales) and inputs (purchases). You should 
check these transactions very carefully before committing yourself to the re-
turn since any mistakes will have to be rectified on the next return. 

Electronic Submission
HMRC are adding facilities for the electronic submission of VAT returns. 
Accountz is registered with HMRC for this and other electronic submissions. 
We have no date of availability at the time of writing, but if you didn’t opt-out 
of our newsletter when you registered Business Accountz, we will keep you 
informed of progress. 

Please revisit the earlier sections in this tutorial on Sales/Purchase and Trans-
fer Transactions for in depth details of how transactions and VAT work. 

You can select different VAT periods using the drop down list on the top right 
of the VAT Return tab. 

How to enter the box 5 total into your accounts
After you have produced a VAT return you will need to make a transaction 
to cover the amount you owe HMRC (or the amount they owe you) shown in 
box 5 of the return for the period. Transfer Transactions is the place to make 
this entry. 

If you owe HMRC money, the transaction will be From your bank (or credi-
tors if you are not paying it yet) To a default account called VAT Control. This 
is held in the Liabilities Group  of your chart of accounts under Current Li-
abilities. Just type a V into the To field and it should show up on the list. Add 
a description to remind you which VAT period this payment was for.

2.
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From To Amount Description
Bank VAT Control 1279.46 2008/1

 If the VAT return shows that HMRC owe you money, then the transaction is 
exactly the same as for a payment, but the accounts are switched around (from 
VAT Control to bank). 

Since the VAT becomes due at the end of the period, you can date the transac-
tion with the same date as the last day of the return. 

Exporting or printing your VAT Return

 If you click the Print button, the report window will open. Click on the 
Design/Print tab at the bottom of the window to preview the report before 
printing. Business Accountz Basic users should export the report to print from 
a spreadsheet. 

 The Export button will open a filer window so you can save the data to 
your hard drive. You will then be able to load it into any spreadsheet. 

It is very important that you make a hard copy of every VAT return. It is 
your only proof as to how you arrived at the VAT liability. 

Locking transactions
Once you are happy with your VAT and have printed a hard copy of the re-
turn, you can click on the Change Company option from the File menu in 
the Accountz main menu bar. From here, on the right panel, you can set the 
Transactions lock date. 
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This should be set to the last day of your last VAT return. This will stop you 
or anyone else altering your earlier data.

 Year End
First: do not panic. If you are a limited company, you have 9 months to com-
plete and send in your tax return. If you are self-employed you have until 
the January following the tax year ending the previous April to submit your 
self-assessment return (please do check the timings here, we have no control 
over them, so a visit to www.hmrc.gov.uk should be your first move if you 
are unsure of the law). 

Most businesses will continue for 3 months or more past their year end before 
finalising and closing a set of books. This allows them time to reconcile the 
bank account, check on bad debts (that may give further tax relief) and ensure 
that all transactions for the year have been entered and checked. 

With Accountz you just continue entering the new year transactions into the 
same tables as last year’s. You only need to run the year end wizard when 
you are satisfied that everything to do with the year you are closing has been 
entered and checked. 
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Monthly Reports
Note there is no monthly closing in Accountz. This is one of the advantages of 
an open system. It does not force you to close periods. Your data is available 
at all times. Use the Lock Transactions function from the menu option File > 
Change Company to ensure the integrity of previous periods. 

Producing monthly profit and loss or balance sheet reports is simple. Set up 
the dates in the Chart of Accounts. Set the Start and End dates for Profit and 
Loss reports. Set the End date only for Balance Sheet reports. For any other 
types of report, go to the relevant transaction table, use a filter or create a new 
one and click on the Print or Export button. 

Note if you do want a filtered report by date, then ensure you untick the In-
clude Year Closing Transfers box otherwise you are liable to include transac-
tions relating to another period. 

Also, see the End of Year Wizard section a little further on for year end re-
ports. 
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Debtors and Creditors
In the Chart of Accounts double-click on the Unpaid Invoices account in the 
Current Assets Group. This opens the account in the right hand panel. Click 
on the Entries tab at the bottom of the panel to view all transactions in the 
Unpaid Invoices account. Here you will see a complete breakdown of money 
owed to the business including invoices both paid and unpaid and a running 
balance. Choose or create an Unpaid filter to view, print or export just the 
existing debtors. Make sure you set the Chart of Accounts End date option to 
restrict the view to the year you are closing. Alternatively you could set those 
dates in the filter. 

The same applies for a list of outstanding bills. The account is called Unpaid 
Bills by default and is in the Current Liabilities Group section. 

Reconciling your bank

It is absolutely vital that you check that all the transactions are reconciled. 
With your bank, this means comparing them to a printed bank statement. 
This is done in the Chart of Accounts. Open Chart of Accounts, then Assets 
Group then Current Assets where you should see your bank. Double-click on 
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the bank to open its details in the right hand panel. Now click on Entries at 
the bottom of its tab. 

The last column (unless you have hidden it – in which case right click on the 
column header to turn it back on again) is called Cleared. Ticking this for any 
of the entries immediately affects the Statement Balance column in the left 
panel for the bank. 

The Statement Balance should match your printed bank statement. You can 
filter the entries to show just the cleared ones (which you can then print out for 
easy reference) or you could filter it to show just the uncleared entries. 

Reconciling bank statements is very simple and highly recommended if you 
want to be sure that you are really accounting for your business. 

Depreciation
Most capital items that the business purchases decline in value as time goes 
on. This is called depreciation in accountant-speak. The balance sheet of a 
business should give a true and fair picture of a business. That means you need 
to account for the changing values of the assets the business owns. 

These values are called book values. It is important to realise they have no 
bearing on tax computations (you can claim a percentage of asset cost against 
tax, but that is called a Capital Allowance and is an entirely separate issue to 
bookkeeping). What we are doing here is calculating a reasonable value for 
the depreciation in value of assets so the accounts reflect the most accurate 
picture of the business as we can make. 

The change in value is held in accounts called Accumulated Depreciation Ac-
counts. 

To account for depreciation you will need 2 accounts per fixed asset group. 
One records the original purchase (and any subsequent disposal) of assets (eg. 
Fixtures and Fittings). The other records the decline in value (eg. Fixtures and 
Fittings Accumulated Depreciation). 
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To see the original value of the asset you only need look at the original 
purchase account.

To see how much value it has lost, you look at the balance of its associ-
ated depreciation account.

To see its current value, you look at the combined balances of the 2 ac-
counts. 

Purchases of capital items are recorded in Purchase Transactions. This is so 
you can account for VAT if you are VAT registered (if you are not VAT 
registered you can record it in Transfer Transactions if you like, but either is 
fine). What is vital is that the To account is held somewhere in Assets and not 
in Equity (specifically, it must not be held in the profit and loss section). 

At each year end, you will need to add a number of transactions in Transfer 
Transactions to account for the depreciation. One transaction per fixed asset 
group. 

Here is an example, first, in Purchase Transactions we buy some equipment.

From To Total VAT Description
Bank Equipment 1175.00 175.00 Tools

Now for the depreciation at year end. Typically, depreciation is set at 25% per 
year of the previous value. We already know that one side of the transaction 
will affect our accumulated depreciation account for tools. So, what account 
do we use for the other side? 

The answer is another depreciation account! But, this account is held in the 
profit and loss section. Why? because its decrease in value affects our trading 
figures. We have suffered a loss. 

Because we cannot claim it as a taxable expense, depreciation accounts are 
held in their own group within the Profit and Loss account. This makes it 
easier to calculate the potential tax liability. 

•

•

•
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Here is the transaction for the tools we have bought. The value we depreci-
ate is less VAT. In this example it will be £1,000. At 25% the depreciation 
is £250. 

From To Total Description
Tools Accumulated P&L Depreciation 250.00 Tools

Monthly Depreciation
If you need to produce balance sheets on a monthly (or any other period) 
basis, enter that above transaction at the end of each period you need the bal-
ance sheet for. Remember to reduce the percentage accordingly (eg. monthly 
percentage based on 25% per year will be 25/12 = 2.08%. 

The only problem is that you will arrive at a different figure at year end if you 
apply the 2.08% to the previous balances reduced amount. The simplest way 
is to work out the reduction on the start of year value (1000 in this example) 
and apply it equally on a monthly basis. You will then end up with a £250 
annual depreciation. 

Obviously it is important to be accurate, but assessing values of assets is ex-
tremely difficult since you will only be able to work out its true market value 
by actually selling it! This is why it is generally accepted that 25% per year 
based on the previous balance is reasonably fair. 

As stated at the start of this section, an important point to remember is that we 
are talking about book value, not taxable values. Taxable values are dealt with 
separately. HMRC keeps track of your assets and how much capital allowance 
you have claimed against them (please visit www.hmrc.gov.uk and search for 
capital allowances). 

Stock valuation and COGS
If you said yes to the question ‘Do you buy goods for resale’ in the company 
setup wizard, you will find a Stock Bought account in Current Assets in the 
Chart of Accounts and an account called Stock Sold in a group called Cost of 
Sales in the Sales section of the Profit and Loss account. 
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Just like capital items, when you buy goods for resale, you cannot simply 
claim their cost as an expense. This is because it is very likely you will still 
have some of that stock left at year end (exactly the same principle as a capital 
item still having a value to the business at year end). 

What you can claim for though, is the difference in value between your open-
ing stock and your closing stock. Together with other costs incurred directly 
as a result of selling, these are held in a group within the sales section of your 
Profit and Loss account called Cost of goods sold (like all account names, 
there are lots of variations, but this is the most common. What matters is that 
you and anyone looking at the accounts can understand what it means). 

The simplest way to adjust the value of your stock at year end is to make a 
transaction in Transfer Transactions From the Stock Bought account To the 
Stock Sold account. You could do this every month instead. This will give you 
up to date monthly management reports. 

Manufacturing and Raw Materials valuation
If you clicked the manufacturing box in the company setup wizard, a Raw 
Materials Bought account within Current Assets would have been setup in the 
Chart of Accounts. 

This operates in the same way as stock. You buy in raw materials (exactly the 
same as buying goods for resale, see Payment Transactions described earlier 
in this tutorial for an example) and you use up those materials in the manu-
facturing of goods. 

At your financial year end you will need to do a stock take to work out the 
value of raw materials you have used up. You can then add a new transac-
tion in Transfer Transactions. The money will come From the Raw Materials 
Bought account and go to the Finished Goods account in Assets > Current As-
sets. Finally, assuming you sold some of the finished goods, you make another 
Transfer Transaction From Finished Goods To Finished Goods Sold. 

Like stock, you could also do this on a monthly basis. Larger businesses may 
choose to carry out these tasks more often for really up to date reporting. 
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Year End Wizard
When you are happy with the results, click the Chart of Accounts menu option 
and select Year End. This opens the Year End Wizard. 

Step through each section in turn. It is straightforward. The most important 
thing is to get your year end date correct. 

After the last step, the system will auto-create a number of entries in the Jour-
nal. These entries transfer all the balances out of the Profit and Loss account 
into the Retained Earnings account. This zeros your Profit and Loss ready to 
record the new year’s results. It will already have a balance in there if you 
have continued past your year end as recommended. 

Trial Balance Report
A trial balance is a complete list of your accounts that also shows each ac-
count's balance. Traditional systems require them, but they are not strictly 
necessary in open systems such as Accountz. However, if you use an account-
ant or bookkeeper, they may ask you for one. In which case: 

 Open all the accounts in the Chart of Accounts so you can see every ac-
count. Set the End Date in the Chart of Accounts to your financial year end 
date (leave the Start Date disabled). Then click on the Print Trial Balance but-
ton in the Chart of Accounts toolbar and click on the Design/Print tab at the 
bottom to view and print your report. 

Profit and Loss Report
The Profit and Loss account shows you how much money your business has 
made or lost. You can create reports for any period from a single day up to 
your whole financial year by setting the Start and End Date in the Chart of 
Accounts. 

Note that you cannot create a Profit and Loss report for periods longer than 
your financial year or for periods that cross over year boundaries by un-tick-
ing the Include Year Closing Transfers box.
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 To see your profit and loss for a complete financial year set the End Date 
in the Chart of Accounts to your financial year end date (leave the Start Date 
disabled or make sure it is set to the first day of the financial year you want 
the report for). Then click on the ‘Print Profit and Loss’ button in the Chart of 
Accounts toolbar, and click on the Design/Print tab at the bottom to view and 
print your report. 

Balance Sheet Report 
The Balance Sheet represents the financial state of your business as it was on 
a specific date. That is, how much money there is in the bank, how much the 
business owes, how much is owed to the business, how much equity there is 
in the business (ie. how much is owed to the owners of the business) and how 
much profit or loss the business has made for the current period up to the date 
of the report. As is often said, it is a snapshot of your business at a certain 
point in time. 

You can make as simple or as detailed a balance sheet as you need by opening 
or closing different groups in the Chart of Accounts. 

At the very simplest level, you could show just the Assets, Liabilities and 
Equity groups (ie. close all sub-groups within each of the main groups). You 
can prove that the balance sheet actually balances by applying the standard 
accounting equation: 

Assets = Liabilities + Equity 

If you want to memorise this, use the acronym ALE. 

A more detailed (and typical) balance sheet will show the current asset and 
liability accounts in full but only the overall Profit and Loss account balance 
(the Profit and Loss account report will show the detailed view) together with 
the other Equity accounts. 

What matters is that you have complete control over the level of detail of the 
report. 
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 To view the report, set the End Date in the Chart of Accounts to your 
financial year end date (Important: leave the Start Date disabled). Then click 
on the Print Balance Sheet button in the Chart of Accounts toolbar and click 
on the Design/Print tab at the bottom to view and print your report.

Nominal Ledger
Click on menu option Chart of Accounts > Nominal Ledger. This is the defini-
tive report your accountant will want to see. It is a complete list of all your 
accounts and their entries together with running balances. It is exportable so 
your accountant can load it directly into a spreadsheet. 

Like all the other transaction tables, you can set filters for the Nominal Ledg-
er. You only need to set the Tax Point filter for this report. That way you can 
view and export each year independently.
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5. File

Change Company
If you have a multi-company licence, this is where you would switch between 
companies, or change the name of the selected set of accounts. 

Transaction lock date enables you to protect your accounts to the last period 
you had cleared and checked, eg. after a VAT return. 

You can also enter some notes about your company here, for example your 
accountant’s name and address. 

Add New Company Button

 By default Business Accountz is only licensed for one company. Your 
licence can be updated to allow for more companies. Please contact Accountz 
on 08700 111747. Clicking this button starts the Company Setup Wizard. 
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Delete Existing Company Button

 Please use with GREAT CARE. Selecting a company from the list (and 
by default that will be your only company - eg. all your company accounts) 
and clicking this button will remove the company and all its data. Why is it 
here? It is because you may want to experiment first before using the program 
for your real accounts. When you are ready to go, use this button to remove 
your test accounts. Then use the Add New Company button to start the Com-
pany Setup Wizard for your real accounts. 

Load/Refresh Existing Company Button

 If you do have a licence for more than one company, select the company 
whose accounts you want to view/edit from the list and click this button to 
load them in. 

Transactions Lock date
Setting this will stop any transactions up to this date from being edited. It will 
also stop any transactions being dated before (and including) this date. If you 
are VAT registered, always set this date when you have completed a VAT 
return to stop accidental mistakes to earlier data. 

Accounting Year Ends Unlock Button

 After you run the Year End Wizard an entry will be made here. There is 
a button under the list that lets you delete the year end data. This lets you 'roll' 
back to the end of the year so you can edit it. Run the year end wizard again 
to finish. Note you must undo each in turn if for some reason you want to go 
back to earlier years. 

Important: unless you are really sure you want to do this and realise the conse-
quences, it is not recommended. Always make sure you make a backup before 
using this feature. 
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Backup
This shows all the backups that have been made by the user, automatically, 
and when the program is closed down. 

 To make your own backup, click the Save backup  button. 

You also have controls to set the: 

Time between automatic backups spinner - sets an automatic time inter-
val between backups.

Number of automatic backups spinner - sets how many automatic back-
ups to keep (so the backup folder does not get too full - each backup file 
is approximately 1MB).

Number of application closing backups spinner - sets the number of 
application closing backups to keep (for the same reason as above). 

•

•

•
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Making a backup onto other media
You can copy the complete Business Accountz installation folder (as ex-
plained at the start of this manual) or just copy the ‘existhome’ folder from 
within your Business Accountz application folder (usually in Program Files 
on Windows or Applications on Mac). You should also copy the BAK folder 
since this contains all your backup files. Copy this to a USB memory stick 
and/or write the folders to a CD so you have permanent backups should you 
need them. 

Important: It is vital you do this on a regular basis. If your computer's hard 
drive fails it is very likely you will lose all your data. Backups onto other me-
dia, and stored in a different place than your computer is very important and 
applies to all data you produce on the computer. Once it happens to you, you 
never forget again, so ensure it never happens in the first place. Please make 
regular backups. 

Restore 

The Restore tool allows you to revert back to a previous backup if the pro-
gram fails to run for some reason.  It holds all the backup files that are in the 
backup section of Business Accountz.  To restore a file, open the restore tool, 
select the backup file to restore and press the restore button. When the restore 
tool closes the file has been restored, and you can start Business Accountz as 
normal. 

Windows 
In Windows the restore tool is located in the Start > All Programs > Business 
Accountz folder. It is called BA Restore. It can also be accessed direct from 
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your hard drive (the default folder is: C:\Program Files\Business Accountz\
BA Restore) 

Mac 
The restore tool is located in the Business Accountz Install folder. By default 
this will be /Applications/Business Accountz/BA Restore 

Linux 
The restore tool is located in the Business Accountz Install folder. By default 
this will be (user install folder)/Business Accountz/BA Restore 

Documents (Professional, Enterprise only) 

This section provides template files and copies of documents created for the 
following reports: 

Balance Sheet•
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Trial Balance

Profit and Loss

Account Transactions

Sales Transactions

Purchase Transactions

Transfer Transactions

Journal Transactions

Invoices

Customer Statements

Supplier Statements

Credit Notes

Quotations

Quotation Transactions

Purchase Orders

Purchase Order Transactions

UK VAT Returns 

Click on any tab to view the documents. 

The 'Last Document Number' field reflects the number issued on your latest 
document. This number increases by one each time you issue a new docu-
ment. You can change this number to reflect your own Invoice numbers. 

Each document tab has a table with the following headings: 

Name - shows the saved name of the document.

•

•

•

•

•

•

•

•

•

•

•

•

•

•

•

•

•
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Description - this displays the description written when the report is be-
ing created.

Is Template - allows the document to be used as a template for other 
documents when box is ticked.

Created - this shows when the document was created. 

On the bottom right of the document panel are three buttons: 

 Send Document to Editor: This lets you view the selected document, 
which allows data within the selected document to be edited and customised 
using Accountz Designer. The document can also be printed from here. 

 Delete Document from Database: Select a document and click on this 
button to delete it. You cannot delete templates except those you have created 
yourself (provided you untick them as a template first). 

 Create Template Document: Select any document and use this button to 
create a template from that document. This is a simple way for you to create 
new invoice and report designs. 

See Chapter 14, Appendix C for more information on Accountz Designer. 

•

•

•
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Document Editor (Professional, Enterprise only)

Within this component you can view and edit the last 10 documents created. 
Whenever you create a new document, or go to edit an existing one, it will be 
launched in this screen for editing and printing.
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6. Chart of Accounts 

The Chart of Accounts represents the financial state of your business as it was 
on a specific date (ie. how much you have in the bank, how much the business 
owes, how much is owed to the business, your current profit and loss etc.). It 
is a live Balance Sheet. 

It consists of assets and liabilities. Assets consist of tangible assets (current 
and fixed assets like a bank account or company vehicles) and intangible as-
sets (e.g. goodwill). Assets (and asset groups) are often placed in order of 
liquidity (i.e. how easy it is to retrieve the money). 

The Chart of Accounts within Accountz has a Current Balance column and a 
Statement Balance column. 

The Current Balance of accounts and groups is made up from all transactions 
made between the Start Date and End Date set in the  Chart of Accounts. 
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The Statement Balance is made up of accounts and transactions that have been 
reconciled or cleared against a bank or credit card statement. 

You will find the following buttons above your Chart of Accounts: 

 Trial Balance (Professional, Enterprise only) – this opens the Trial 
Balance report/design window

 Profit & Loss (Professional, Enterprise only) – this opens the Profit 
and Loss report (includes all accounts within the P & L account group)

 Balance Sheet (Professional, Enterprise only) - this opens the Bal-
ance Sheet report/design window

 Spreadsheet File – lets you export the Chart of Accounts in a format 
suitable for loading into a spreadsheet.

At the bottom of the Chart of Accounts window is a search field and a search 
button. Type in any part of the account name you want to find and click this 
button to get a complete list of matching accounts on the right hand panel. 

Groups and Accounts Elements
 The Chart of Accounts consists of account groups that contain further account 
groups or accounts. You can re-arrange the groups, add more groups, add 
more accounts, hide accounts and rename accounts. 

Groups
Double clicking on an account group will open a new panel in the right hand 
pane. The panel has two tabs below it called Properties and Sub-accounts. 

Properties tab - allows the user to edit certain aspects of the account group 
including its name: 

Name - Here you can edit the account group name.

•

•

•

•

•
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Reference Code - Here you can add a reference code for the group. This 
could be some nominal code you are used to using from a previous sys-
tem. A nominal code is generally just a number that defines whether an 
account or group is an asset, liability or some other account type. It is a 
legacy thing dating back to earlier double-entry systems. It is not neces-
sary to know or use nominal codes in Accountz.

Reconcilable - Check this box if the group is reconcilable (for account 
groups, this is a visible indication only that the group contains one or 
more accounts that should be reconciled manually).

Type - Displays the group type. This is chosen when the account is cre-
ated and cannot be changed once set.

Can Contain - Displays the account types this group can contain.

Notes - Displays relevant information in regards to an account group. 
You can edit this information and add further notes of you wish. 

•

•

•

•

•
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Sub-accounts tab – displays a view of a group’s sub-groups and accounts 
with the following column headings:   

Name – the name of each account group and account contained in the 
group.

Reference Code – the reference for each account if one has been set.

Reconcilable – whether the account is reconcilable.

Type – what type the account group or account is.

Visible – whether the account has been hidden or is active (ie. visible). 

There are buttons at the bottom of the Sub-accounts tab which include: 

 Add - This opens the Add New Account dialogue box so that you 
can add a new account to the group (be sure to select the account type, 
especially if you want to add an account and not another group).

 Up - This moves the currently selected sub-account up the list.

•

•

•

•

•

•

•
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 Down - This moves the currently selected sub-account down the 
list.

 Move to a Different Account Group  – This moves a sub-account 
to another group.

 Hide/Show - This sets the account visibility on and off. If an ac-
count is hidden, neither it nor its balance will be included in the Chart 
of Accounts. 

Double clicking any of the sub accounts will open another tab in the right hand 
panel for that account. 

Accounts

Double clicking on an account will open a new panel in the right hand pane. 
The panel has two tabs below it called Properties and Entries. 

•

•

•
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Properties tab - allows the user to edit certain aspects of the account, includ-
ing its name: 

Name - the account name can be edited here.

Reference Code - add a reference code for the account.

Reconcilable - check this box if the account is reconcilable.

Type - displays the account’s type.

Information – displays any relevant information for this account type 
(eg. the box number for a self-assessment return that this account type 
belongs to)

Notes - add notes to the account. 

Entries (overleaf) – allows the user to view, edit and filter all entries that have 
been made in reference to the selected account. The column headings within 
this tab include: 

Tax Point

Reference

Amount From

Amount To 

Running Balance

Cleared (tick box) 

See Chapter 14, Appendix D for details of all the table columns.  

•

•

•

•

•

•

•

•

•

•

•

•
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The table has a toolbar above with the following buttons: 

 Print (Professional, Enterprise only) - launches the Accountz de-
signer whence you can edit and print this table

 Export as CSV File - opens a filer window so you can export the 
current table of filtered transactions in a format suitable for loading into 
a spreadsheet

 Filter Selector - this drop down menu will not have 
this text displayed in it, instead it will have the name of a filter (eg. Show 
All Transactions)

 Edit Report – if the filter is not one of the default filters, this button 
will let you edit it

 Add Report - click this if you want to add a new filter to the list (it 
opens the Report Builder covered in Appendix B)

•

•

•

•

•
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 Remove Report - deletes the currently selected filter (provided it is 
not one of the default filters)

 Reload Transactions - – there are occasions where the time taken to 
update various fields and balances is too much overhead for the system, 
use this button to ensure you can see all the data (e.g. where new Presets 
have been added, the reload button will ensure they are displayed in the 
Preset Selector drop-down menu) 

List of Account Types
All account groups and accounts are nested within the Chart of Accounts 
group. Therefore the Chart of Accounts is the base or root group for every-
thing else. 

The following is a list of all the major groups, accounts, and what each can 
contain (using bullet points for quick reference). 

A group can contain groups and accounts. Generally a group can also contain 
a group of the same type as itself. Eg. a Current Assets Group and contain 
Current Assets Groups to any depth. 

The architecture behind this system is to allow maximum flexibility at the 
simplest possible level. A chart of accounts can be as complex or as simple as 
required and it all starts with the Chart of Accounts: 

Chart of Accounts Group can contain:

Asset Groups

Liability Groups

Equity Groups 

It is important to know that these are just the labels used for the group types.

•

•

•

•

•
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 For example, two or more groups of type Asset Group could be opened and 
given any name. 

In the default setup, there is only one Asset Group (called Asset Group, but as 
stated, this can be renamed if required). It contains a number of sub-groups to 
differentiate between the asset accounts within the business. 

Assets
Asset Group can contain: 

Current Assets Group

Fixed Assets Group

Intangible Assets Group

Other Assets Group 

 

Current Assets Group can contain:

Current Assets Group

Inventory Group

Debtors Account Group

Asset Account

Bank Account

Cash Account

•

•

•

•

•

•

•

•

•

•
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Deposit Account

Debtors Account

Inventory Account

Raw Materials Account

Work in Progress Account

General Account

Suspense Account

 

Inventory Group can contain:

Inventory Account

Raw Materials Account

Work in Progress Account

 

Debtors Account Group can contain:

Debtors Account

 

Fixed Assets Group can contain:

Fixed Assets Group

Motor Pool Group

Asset Account

Fixtures and Fittings Account

Equipment and Tools Account

•

•

•

•

•

•

•

•

•

•

•

•

•

•

•

•
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Buildings Account

Accumulated Depreciation Account

General Account

Suspense Account

 

Motor Pool Group can contain:

Motor Pool Group

Vehicle Account

Accumulated Depreciation Account

 

Intangible Assets Group can contain:

Other Assets Group

Asset Account

General Account

Goodwill Account

Suspense Account

 

Other Assets Group can contain:

Other Assets Group

Asset Account

General Account

Suspense Account

•

•

•

•

•

•

•

•

•

•

•

•

•

•

•

•
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End of the Assets section. 

Liabilities
Liability Group can contain: 

Liability Group

Current Liabilities Group

Long Term Liabilities Group

Other Liabilities Group 

 

Current Liabilities Group can contain:

Current Liabilities Group

Creditors Group

Liability Account

Credit Card Account

Creditors Account

VAT Control Account

General Account

Suspense Account

•

•

•

•

•

•

•

•

•

•

•

•
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Client Fee Liability Account

 

Creditors Group can contain:

Creditors Account

 

Long Term Liabilities Group can contain:

Long Term Liabilities Group

Long Term Loan Account

Liability Account

General Account

Suspense Account

 

Other Liabilities Group can contain:

Other Liabilities Group

Liability Account

General Account

Suspense Account

 

End of the Liabilities section.

 

•

•

•

•

•

•

•

•

•

•

•
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Equity
Equity Group can contain: 

Equity Group

Profit and Loss Group

Shareholders Group

Partners Group

Retained Earnings Group

Appropriation Accounts Group

Other Group

Retained Earnings Account

Drawings Account

Capital Account 

 

Profit and Loss Group can contain:

Profit and Loss Group

Sales Group

Revenue Group

Expense Group

Depreciation Group

•

•

•

•

•

•

•

•

•

•

•

•

•

•

•
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Amortization Group

Tax Group

Sales Account

Other Income Account

Expense Account

Deprecation Account

Amortization Account

Tax Account

 

Sales Group can contain:

Sales Group

Cost of Sales Group

Sales Account

Interest Expense Account

General Account

 

Cost of Sales Group can contain:

Cost of Sales Group

Cost of Goods Sold Account

Construction Industry and Sub-contractor Costs Accounting

Inventory Adjustment Account

 

•

•

•

•

•

•

•

•

•

•

•

•

•

•

•

•

•
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Revenue Group can contain:

Revenue/Income Account

Interest Expense Account

 

Expense Group can contain:

Expense Group

Employees Group

Expense Account

Premises Costs Account

Repairs Account

General Administrative Expense Account

Motor Expense Account

Travel and Subsistence Account

Advertising, Promotion and Entertainment Account

Legal and Professional Costs Account

Bad Debts Account

Interest Expense Account

Other Finance Charges Account

Other Expenses Account

 

Employees Group can contain:

Employees Group

•

•

•

•

•

•

•

•

•

•

•

•

•

•

•

•

•
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Employee Wages Account

Employee TAX/NIC Account

 

Depreciation Group can contain:

Deprecation Group

Deprecation Account

 

Amortization Group can contain:

Amortization Group

Amortization Account

 

Tax Group can contain:

Tax Group

Tax Account

 

Shareholders Group can contain:

Shareholders Group

Shareholder Account

Shareholder Loan Account

 

Partners Group can contain:

Partners Group

•

•

•

•

•

•

•

•

•

•

•

•
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Partner Account

Partner Loan Account

Drawings Account

 

Retained Earnings Group can contain:

Retained Earnings Account

 

Appropriation Accounts Group can contain:

Reserve Account

 

Other Group can contain:

Other Group

General Account

Suspense Account

 

End of the Equity section.

Search

 You can search for an account by entering the name or part of the name 
in the search bar at the bottom of the Chart of Accounts and pressing the En-
ter key. The search will open tabs for any account that contains part of your 
search criteria. 

•

•

•

•

•

•

•

•
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Close all Tabs

 If you have a number of tabs open in the right panel of the Chart of Ac-
counts, this button will enable you to close them all at once.

Adding more accounts

 The Create new account button in the Sub account tab for any group will 
open a dialogue box similar to the following screenshot. 

Enter a Name for your new account, then a Reference Code (this is entirely 
optional, some people number their accounts, but it is not necessary in Busi-
ness Accountz, since accounts are chosen by their name, not by number). Now 
select an account Type from the drop down list. 

Note that accounts that can contain other accounts are called Groups, every-
thing else ends with the name Account. This is an important guide to remem-
ber. Only account types that end with  ‘Account’ can contain Transactions. 
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Nominal Ledger

This is the definitive report your accountant will want to see. It is a complete 
list of all your accounts and their entries together with running balances. It is 
exportable so your accountant can load it directly into a spreadsheet.

Like all the other transaction tables, you can set filters for the Nominal Ledg-
er. You only need to set the Tax Point filter for this report. That way you can 
view and export each year independently. 

The table consists of the following headings:

Account

Tax Point

VAT Date

Customer / Supplier

•

•

•

•
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Reference

Amount From

Amount To

Running Balance

VAT Code

Notes

Transaction Number 

See Chapter 14 Appendix D for a description of columns. 

Above the table are the following icons: 

 Export as CSV File - opens a filer window so you can export the 
current table of filtered transactions in a format suitable for loading into 
a spreadsheet

 Filter Selector - view a filtered list of transactions 
based on your selection from this drop down menu

 Edit Report – if the filter is not one of the default filters, this button 
will let you edit it

 Add Report - click this if you want to add a new filter to the list (it 
opens the Report Builder covered in Appendix B)

 Remove Report - deletes the currently selected filter (provided it is 
not one of the default filters)

 Reload Transactions - – there are occasions where the time taken to 
update various fields and balances is too much overhead for the system, 
use this button to ensure you can see all the data

•

•

•

•

•

•

•

•

•

•

•

•

•



Business Accountz User Manual

145

Year Closing

Closing an accounting year is a very simple process. It involves entering a 
number of transactions that do things such as zero all the Profit and Loss ac-
counts so they are ready to record the new year’s profits (or loss). 

There are a few things that should be done at this point. These are outlined in 
the bullet points in the opening page of the Year End Wizard. Please also see 
the tutorial in the first part of this manual for full details of what you need to 
do. 

One useful point is to realise that you can continue well into your new year 
before using this wizard. This is to give you time to check you have not missed 
anything, reconciled your bank balance and ensured you have accounted for 
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VAT for the year in full. Many businesses will continue 3 months into the new 
year before using the wizard. 

The other useful note is that the wizard creates a number of transactions for 
you. These are entered in the Journal. If you leave the Journal just for this 
purpose, it will make it easier to correct if you make a mistake. That is, you 
can delete (which actually only hides) the existing transactions in the Journal 
and use the wizard again after you have corrected any mistakes. 

 Click on the Next button in the wizard to start it, then fill in the fields as 
necessary.
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7. Sales

Customer Records (Professional, Enterprise only)
All your customers’ records are stored here. There are 2 panels. The left panel 
holds the customer’s name and address, the right panel has a set of tabs for 
contact, delivery and transaction details specific to the customer currently be-
ing viewed. 

Add a new record button

 Located at the bottom of the Customer Records panel. Clicking this will 
clear the data fields for you to enter your new customer’s details (please note 
that your entry is automatically saved). 
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Enter the relevant data into the following fields: 

Address

Postcode

Country

Notes

Reference

VAT Number

Account From

Account To

Other Lookup 

Other buttons at the bottom of the left panel include: 

 Hide Record - This will hide the current record. You can retrieve this 
information using the Customer options in the Configuration panel.

 Recently Viewed Records - This shows you a list of recently viewed 
customers.

There are more options above the table with the following buttons: 

 Invoice – Opens a new invoice

 Credit Note – Opens a new credit note

 Quotations – Opens a new quotation or estimate 

You can view existing or old invoices etc. from the File > Documents menu 
option (or directly from Sales Transactions). 

•

•

•

•

•

•

•

•

•

•

•

•
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There are more options on the right listed under the tabs Contact, Delivery, 
Statement, Sales, Transfers and Quotations. 

Contact Tab

Add Contact Button

 Located at the bottom of the Contact panel. Clicking this will clear the 
data fields for you to enter your new contact’s details (please note that your 
entry is automatically saved).

Each contact also has the following fields where you can enter extra details:

Position – The contact’s job (eg. sales, purchasing, admin etc.)

Telephone – The contact’s telephone number

Fax - The contact’s fax number

Mobile – The contact’s mobile phone number

•

•

•

•
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Email – The contact’s email address. Press the Email button to the right 
of it to open your default email editor

Internet – The contact’s website if they have one. View it by pressing 
the Internet button to the right of it

Link fields – There are 4 link fields so you can associate other web 
pages or folders on your computer or specific documents with a specific 
contact.

Notes – Add any notes specific to this contact here. 

•

•

•

•
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Delivery Tab

Add Delivery Address

 This button is located at the bottom of the Delivery tab. Clicking this 
will clear the data fields for you to enter your new delivery address (please 
note that your entry is automatically saved).  

The following fields are available for each delivery address you add:

Name

Address

Postcode

Country 

•

•

•

•
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Notes – Notes specific to this delivery address (eg. a contact phone 
number or directions)

Copy from Customer button - This button will copy the name and ad-
dress from the current customer record.

Statement Tab

In this tab you can see how much the customer owes you for each period 
as well as the current and overall balances. The table (showing the unpaid 
transactions) has the following columns:

Tax Point

Reference

Description

•

•

•

•

•
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Sales Amount

Paid Amount

Running Balance

Payment Completed

Other columns can also be selected for this table. See the screenshot for de-
tails. Right click on any column heading to open the column selection menu.

The following fields and buttons can also be found within the Statement tab:

Current 

Period 1 (1 Month) 

Period 2 (1 Month) 

Period 3 (1 Month) 

Edit button

Total 

Credit limit 

Credit left 

Statement button

There are 4 different periods associated with the age of unpaid transactions. 
Current are those not yet due. Period 1 by default is set for 1 month. It in-
cludes all unpaid transactions that are at least 1 month old, but that have not 
yet reached Period 2, and so forth through to Period 3. This includes all other 
unpaid transactions back to the start of your accounts.

•

•

•

•

•

•

•

•

•

•

•

•

•
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The Edit buttons to the right of each period let you alter the period for indi-
vidual customers. Clicking on any Edit button opens the Edit Credit Period 
dialogue. Where you can set your credit terms to Days or Months and also 
set how many (eg. 1 month or 60 days etc.).

Sales Tab

In this tab you can create and view all sales for a customer. 

 To create a new transaction click the add new transaction button 

You can choose which fields you want to see by right clicking on any col-
umn heading. There are a minimum number of fields that you must fill in to 
complete a transaction. These are:

●	 Tax Point 

●	 From Account 	

●	 To Account 

●	 Total Amount

●	 VAT Code

●	 VAT Amount

●	 Amount Less VAT
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Ignore the VAT fields if you are not VAT registered. You may want to turn 
them off.

See Chapter 14, Appendix D for an explanation of Table Columns.

There are more options above the table with the following buttons: 

 Copy Transaction – makes a copy of the currently selected transac-
tion to the same table (useful for creating a duplicate invoice or bill)

 Insert Credit Note Transaction based on this Sale - creates and adds 
a credit note to Sales Transactions based on a currently selected invoice

 Delete Transaction – hides the currently selected transaction from 
view (use the default filter drop-down menu option from the Filter Selec-
tor to show all deleted transactions again – where you can also un-delete 
them if you wish)

 Print (Professional, Enterprise only) - launches the Accountz de-
signer whence you can edit and print this table

 Export as CSV File - opens a filer window so you can export the 
current table of filtered transactions in a format suitable for loading into 
a spreadsheet

 Filter Selector - this drop down menu will not have 
this text displayed in it, instead it will have the name of a filter (eg. Show 
All Transactions)

 Edit Report – if the filter is not one of the default filters, this button 
will let you edit it

 Add Report - click this if you want to add a new filter to the list (it 
opens the Report Builder covered in Appendix B)

•

•

•

•

•

•

•

•
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 Remove Report - deletes the currently selected filter (provided it is 
not one of the default filters)

 Reload Transactions - – there are occasions where the time taken to 
update various fields and balances is too much overhead for the system, 
use this button to ensure you can see all the data (e.g. where new Presets 
have been added, the reload button will ensure they are displayed in the 
Preset Selector drop-down menu) 

Transfers Tab

In this tab you can see all the transfers that have been made by the selected 
customer. You can choose which fields you want to see by right clicking on 
any column heading. 

 To create a new transaction click the add new transaction button 

There are a minimum number of fields that you must fill in to complete a 
transaction. These are:

•	 Tax Point

•	 From Account

•	 To Account

•	 Total Amount

See Chapter 14, Appendix D for an explanation of Table Columns.

•

•
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There are more options above the table with the following buttons:

 Copy Transaction – makes a copy of the currently selected transac-
tion to the same table (useful for creating a duplicate invoice or bill)

 Preset Transaction Selector – lets you pick a preset from the 
drop-down menu to auto-insert commonly occurring transactions

 Delete Transaction – hides the currently selected transaction from 
view (use the default filter drop-down menu option from the Filter Selec-
tor to show all deleted transactions again – where you can also un-delete 
them if you wish)

 Print (Professional, Enterprise only) - launches the Accountz de-
signer whence you can edit and print this table

 Export as CSV File - opens a filer window so you can export the 
current table of filtered transactions in a format suitable for loading into 
a spreadsheet

 Filter Selector - this drop down menu will not have 
this text displayed in it, instead it will have the name of a filter (eg. Show 
All Transactions)

 Edit Report – if the filter is not one of the default filters, this button 
will let you edit it

 Add Report - click this if you want to add a new filter to the list (it 
opens the Report Builder covered in Appendix B)

 Remove Report - deletes the currently selected filter (provided it is 
not one of the default filters)

•

•

•

•

•

•

•

•

•



Business Accountz User Manual

158

 Reload Transactions - – there are occasions where the time taken to 
update various fields and balances is too much overhead for the system, 
use this button to ensure you can see all the data 

Quotations Tab

In this tab you can create and view all quotations and estimates for a cus-
tomer. 

 To create a new quotation click the create new transaction button.

You can choose which fields you want to see by right clicking on any col-
umn heading. There are a minimum number of fields that you must fill in to 
complete a transaction. These are:

Tax Point 

From Account 	

To Account 

Total Amount

VAT Code

VAT Amount

Amount Less VAT

Ignore the VAT fields if you are not VAT registered. You may want to turn 
them off.

•

•

•

•

•

•

•

•
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See Chapter 14, Appendix D for an explanation of Table Columns.

There are more options above the table with the following buttons:

 Copy Transaction – makes a copy of the currently selected transac-
tion to the same table (useful for creating a duplicate invoice or bill)

 Insert Sales Transaction based on this Quotation - this inserts a 
transaction in the Sales tab based on the selected quotation

 Preset Transaction Selector – lets you pick a preset from the 
drop-down menu to auto-insert commonly occurring transactions

 Delete Transaction – hides the currently selected transaction from 
view (use the default filter drop-down menu option from the Filter Selec-
tor to show all deleted transactions again – where you can also un-delete 
them if you wish)

 Print (Professional, Enterprise only) - launches the Accountz de-
signer whence you can edit and print this table

 Export as CSV File - opens a filer window so you can export the 
current table of filtered transactions in a format suitable for loading into 
a spreadsheet

 Filter Selector - this drop down menu will not have 
this text displayed in it, instead it will have the name of a filter (eg. Show 
All Transactions)

 Edit Report – if the filter is not one of the default filters, this button 
will let you edit it

•

•

•

•

•

•

•

•
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 Add Report - click this if you want to add a new filter to the list (it 
opens the Report Builder covered in Appendix B)

 Remove Report - deletes the currently selected filter (provided it is 
not one of the default filters)

 Reload Transactions - – there are occasions where the time taken to 
update various fields and balances is too much overhead for the system, 
use this button to ensure you can see all the data (e.g. where new Presets 
have been added, the reload button will ensure they are displayed in the 
Preset Selector drop-down menu) 

Customer Table 
Here you can see a sortable list of your customers and their details.  

Above the table are the following icons: 

 Add a new record

 Export all records –  exports this table as a CSV file

 Reload all records - clicking this updates the Customer Table

•

•

•

•

•

•



Business Accountz User Manual

161

 To create a new entry for a customer in this table, click the Add a new 
record icon and enter their details into the following fields, as required: 

Name

Address

Postcode 

Reference

VAT Number 

Other Lookup

Notes 

Show Customer (Professional, Enterprise only) – double click this icon 
to go to Customer Records

Sales Transactions
This is where all sales transactions are added, edited or deleted (hidden). Sell-
ing is what businesses are all about. Whether you sell goods (eg. you are in the 
retail trade and have a shop) or services (eg. you are a business consultant) all 
the money you receive from work you have done goes into this section. 

•

•

•

•

•

•

•

•
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Create Transaction button

 To create a new sales transaction, click on the Create Transaction button 
and enter data into the following fields: 

Tax Point

Customer  

From Account 

To Account 

Total Amount

VAT Code

VAT Amount

Amount Less VAT

Description 

Ignore the VAT fields if you are not VAT registered. You may want to turn 
them off by right clicking in any column heading and choosing from the menu. 
There are many more columns you can turn on. 

See Chapter 14, Appendix D for an explanation of Table Columns. 

There are more options above the table with the following buttons: 

 Copy Transaction – makes a copy of the currently selected transac-
tion to the same table (useful for creating a duplicate invoice or bill)

 Insert Credit Note Transaction based on this Sale - creates and adds 
a credit note to Sales Transactions based on a currently selected invoice

 Preset Transaction Selector – lets you pick a preset from the 
drop-down menu to auto-insert commonly occurring transactions

•

•

•

•

•

•

•

•

•

•

•

•
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 Delete Transaction – hides the currently selected transaction from 
view (use the default filter drop-down menu option from the Filter Selec-
tor to show all deleted transactions again – where you can also un-delete 
them if you wish)

 Print - (Professional, Enterprise only)– opens the Accountz Design-
er (see Appendix C) so you can select or design a suitable template for 
printing the current table of filtered transactions

 Export as CSV File - opens a filer window so you can export the 
current table of filtered transactions in a format suitable for loading into 
a spreadsheet (i.e. CSV)

 Filter Selector - view a filtered list of transactions 
based on your selection from this drop down menu

 Edit Report – if the filter is not one of the default filters, this button 
will let you edit it

 Add Report - click this if you want to add a new filter to the list (it 
opens the Report Builder covered in Appendix B)

 Remove Report - deletes the currently selected filter (provided it is 
not one of the default filters)

 Reload Transactions - – there are occasions where the time tak-
en to update various fields and balances is too much overhead for 
the system, use this button to ensure you can see all the data (e.g. 
where new Presets have been added, the reload button will en-
sure they are displayed in the Preset Selector drop-down menu)  

•

•

•

•

•

•

•

•
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Quotations (Professional, Enterprise only)
Select Quotations from the Sales menu. 

There are two ways to create a quotation (or estimate). Either click the Create 

a New Quotation button  in the Customer Records component , or 
follow the steps below (later you can convert the quote into an invoice once it 
has been accepted by your customer).  

 To create a quotation transaction directly in the table, press the Create a 
New Transaction button and enter data into the relevant fields:

Tax point

Customer

Reference

From Account

To Account

Total Amount

VAT Code

VAT Amount

Amount Less VAT

Quotation Document (double-click this field to launch the Accountz De-
signer)

•

•

•

•

•

•

•

•

•

•
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Description 

There are more options above the table with the following buttons: 

 Copy Transaction – makes a copy of the currently selected transac-
tion to the same table

 Insert Sales Transaction based on this Quotation - this inserts a 
transaction in the Sales tab based on the selected quotation

 Preset Transaction Selector – lets you pick a preset from the 
drop-down menu to auto-insert commonly occurring transactions

 Delete Transaction – hides the currently selected transaction from 
view (use the default filter drop-down menu option from the Filter Selec-
tor to show all deleted transactions again – where you can also un-delete 
them if you wish)

 Print - (Professional, Enterprise only)– opens the Accountz Design-
er (see Appendix C) so you can select or design a suitable template for 
printing the current table of filtered transactions

 Export as CSV File - opens a filer window so you can export the 
current table of filtered transactions in a format suitable for loading into 
a spreadsheet (i.e. CSV)

 Filter Selector - view a filtered list of transactions 
based on your selection from this drop down menu

 Edit Report – if the filter is not one of the default filters, this button 
will let you edit it

 Add Report - click this if you want to add a new filter to the list (it 
opens the Report Builder covered in Appendix B)

•

•

•

•

•

•

•

•

•

•
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 Remove Report - deletes the currently selected filter (provided it is 
not one of the default filters)

 Reload Transactions - – there are occasions where the time taken to 
update various fields and balances is too much overhead for the system, 
use this button to ensure you can see all the data

Automated Sales (Enterprise only) 
With Automated Sales you can create recurring entries (for example, direct 
debits) which will be automatically inserted into the Sales Transactions com-
ponent.

 Select the Create Transaction button and complete the following fields: 

Start Date

Period 

Total Insertions 

Customer 

From Account

To Account

Total Amount

VAT Code

Description

See Chapter 14, Appendix D for an explanation of Table Columns. 

•

•

•

•

•

•

•

•

•

•

•
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There are more options above the table with the following buttons: 

 Copy Transaction – makes a copy of the currently selected transac-
tion to the same table

 Delete Transaction – hides the currently selected transaction from 
view (use the default filter drop-down menu option from the Filter Selec-
tor to show all deleted transactions again – where you can also un-delete 
them if you wish)

 Filter Selector - view a filtered list of transactions 
based on your selection from this drop down menu

 Reload Transactions - – there are occasions where the time taken to 
update various fields and balances is too much overhead for the system, 
use this button to ensure you can see all the data

Preset Sales (Professional, Enterprise only) 
This is a labour-saving feature, enabling you to quickly enter transactions. 
Here you can create preset transactions, useful if you do the same type of 
work for people regularly. Then in either the Sales Transactions component, 
or the Sales Tab of the Customer Database you can choose the preset transac-
tion name (from the drop-down list) and a transaction will be inserted into the 
table, with just the date and amount fields remaining to complete the transac-
tion. 

 Select the Create Transaction button and enter data into the following 
fields: 

Preset Name

Customer (if you want it to be associated with a particular customer)

From Account

•

•

•

•

•

•

•
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To Account

Total Amount (this will usually be left blank)

VAT Code (as above)

Description 

See Chapter 14, Appendix D for an explanation of Table Columns. 

There are more options above the table with the following buttons: 

 Copy Transaction – makes a copy of the currently selected transac-
tion to the same table

 Delete Transaction – hides the currently selected transaction from 
view (use the default filter drop-down menu option from the Filter Selec-
tor to show all deleted transactions again – where you can also un-delete 
them if you wish)

 Filter Selector - view a filtered list of transactions 
based on your selection from this drop down menu

 Reload Transactions - – there are occasions where the time taken to 
update various fields and balances is too much overhead for the system, 
use this button to ensure you can see all the data

 

•

•

•

•

•

•

•

•



Business Accountz User Manual

169

8. Payments

Supplier Records (Enterprise only) 

All your suppliers' details are stored here. The left panel contains the suppli-
er's name and address, the right panel has a set of tabs for contact, delivery 
and transaction details specific to the supplier being viewed.

Add a new record button

 Located at the bottom of the Suppliers panel. Clicking this will clear the 
data fields for you to enter your new supplier’s details (please note that your 
new entry is automatically saved).

Enter the relevant data into the following fields: 

Address

Postcode

•

•
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Country

Notes

Reference

VAT Number

Account From

Account To

Other Lookup

Other buttons at the bottom of the left panel include: 

 Hide Record - This will hide the current record. You can retrieve 
this information using the Supplier options in the Configuration panel.

 Recently Viewed Records - This shows you a list of recently viewed 
suppliers. 

Above the table you will find this button: 

 Create an order – Opens a new purchase order 

You can view existing or old purchase orders etc. from the File > Documents 
menu option.

There are more options on the right listed under the tabs Contact, Delivery, 
Statement, Purchases, Transfers and Quotations. 

•

•

•

•

•

•

•

•

•

•
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Contact Tab 

 Add Contact Button - Located at the bottom of the Contact panel. 

Clicking this will clear the data fields for you to enter alternative contact 
details (please note that your entry is automatically saved).

You can add as many contacts as you like. 

Each contact also has the following fields where you can enter extra details: 

Position – The contact’s job (eg. sales, purchasing, admin etc.).

Telephone – The contact’s telephone number.

Fax – The contact’s fax number.

Mobile – The contact’s mobile phone number.

•

•

•

•
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Email – The contact’s email address. Press the Email button to the right 
of it to open your default email editor.

Internet – The contact’s website if they have one. View it by pressing the 
Internet button to the right of it.

Link fields – There are 4 link fields so you can associate other web pages 
or folders on your computer or specific documents with a specific con-
tact.

Notes – Add any notes specific to this contact here. 

Delivery Tab

 Add Delivery Address - This button, located at the bottom of the Deliv-
ery tab, clears the currently viewed data fields ready for you to add alternative 
delivery details.  

•

•

•

•
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The following fields are available for each delivery address you add for your 
company: 

Name

Address

Postcode

Country

Notes – Notes specific to your delivery address (eg. a contact phone 
number or directions)

Copy your address - This button will copy the name and address from 
Your Business Details. 

Statement Tab

•

•

•

•

•

•
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In this tab you can see how much the you owe the selected supplier for each 
period as well as the current and overall balances. The table (showing the 
unpaid transactions) has the following columns: 

Tax Point

Reference

Description

Sales Amount 

Paid Amount

Running Balance

Payment Completed (tick box) 

Other columns can also be selected for this table. See the screenshot for de-
tails. Right click on any column heading to open the column selection menu.

 The following fields and buttons can also be found within the Statement tab:

Current 

Period 1 (1 Month)

Period 2 (1 Month) 

Period 3 (1 Month) 

Edit button

Total 

Credit limit 

Credit left 

From End of Month (tick box)

Show Consolidated Transactions (tick box)

•

•

•

•

•

•

•

•

•

•

•

•

•

•

•

•

•
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 Statement button 

There are 4 different periods associated with the age of unpaid transactions. 
Current are those not yet due. Period 1 by default is set for 1 month. It in-
cludes all unpaid transactions that are at least 1 month old, but that have not 
yet reached Period 2, and so forth through to Period 3. This includes all other 
unpaid transactions back to the start of your accounts.

 The Edit buttons to the right of each period let you alter the period length for 
individual suppliers. Clicking on any Edit button opens the Edit Credit Period 
dialogue, where you can set your credit terms in Days or Months.

The Credit Limit field allows you to set a maximum limit for this supplier. 
Credit Left shows the difference between the Credit Limit and the Current 
total

The From End of Month box, if ticked, will set your period length to start from 
the end of the month. Otherwise they will start from the tax point.

Show Consolidated Transactions: If you have more than 1 row in an Invoice, 
setting this will consolidate all the rows into a single transaction for the total 
invoice amount. 

The  Statement button launches the Accountz document designer whence 
you can create and print off a statement for the selected supplier.

•
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Purchases Tab

In this tab you can create and view all purchases from a supplier. 

 To create a new transaction click the Create a new transaction button.

You can choose which fields you want to see by right clicking on any column 
heading. There are a minimum number of fields that you must fill in to com-
plete a transaction. These are: 

Tax Point 

From Account 

To Account 

Total Amount

VAT Code

VAT Amount

Amount Less VAT 

See Chapter 14, Appendix D for an explanation of Table Columns. 

There are more options above the table with the following buttons:

  Copy Transaction – makes a copy of the currently selected transac-
tion to the same table

•

•

•

•

•

•

•

•
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 Preset Transaction Selector – lets you pick a preset from the 
drop-down menu to auto-insert commonly occurring transactions

 Delete Transaction – hides the currently selected transaction from 
view (use the default filter drop-down menu option from the Filter Selec-
tor to show all deleted transactions again – where you can also un-delete 
them if you wish)

 Print - (Professional, Enterprise only)– opens the Accountz Design-
er (see Appendix C) so you can select or design a suitable template for 
printing the current table of filtered transactions

 Export as CSV File - opens a filer window so you can export the 
current table of filtered transactions in a format suitable for loading into 
a spreadsheet (i.e. CSV)

 Filter Selector - view a filtered list of transactions 
based on your selection from this drop down menu

 Edit Report – if the filter is not one of the default filters, this button 
will let you edit it

 Add Report - click this if you want to add a new filter to the list (it 
opens the Report Builder covered in Appendix B)

 Remove Report - deletes the currently selected filter (provided it is 
not one of the default filters)

 Reload Transactions - – there are occasions where the time taken to 
update various fields and balances is too much overhead for the system, 
use this button to ensure you can see all the data

•

•

•

•

•

•

•

•

•
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Transfers Tab

In this tab you can see all the transfers that have been made to the selected 
supplier. 

 To create a new transaction click the Create a new transaction button.

You can choose which fields you want to see by right clicking on any column 
heading. There are a minimum number of fields that you must fill in to com-
plete a transaction. These are: 

Tax Point

From Account

To Account

Total Amount

Description 

See Chapter 14, Appendix D for an explanation of Table Columns. 

There are more options above the table with the following buttons: 

 Copy Transaction – makes a copy of the currently selected transac-
tion to the same table

 Preset Transaction Selector – lets you pick a preset from the 
drop-down menu to auto-insert commonly occurring transactions

•

•

•

•

•

•

•
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 Delete Transaction – hides the currently selected transaction from 
view (use the default filter drop-down menu option from the Filter Selec-
tor to show all deleted transactions again – where you can also un-delete 
them if you wish)

 Print - (Professional, Enterprise only)– opens the Accountz Design-
er (see Appendix C) so you can select or design a suitable template for 
printing the current table of filtered transactions

 Export as CSV File - opens a filer window so you can export the 
current table of filtered transactions in a format suitable for loading into 
a spreadsheet (i.e. CSV)

 Filter Selector - view a filtered list of transactions 
based on your selection from this drop down menu

 Edit Report – if the filter is not one of the default filters, this button 
will let you edit it

 Add Report - click this if you want to add a new filter to the list (it 
opens the Report Builder covered in Appendix B)

 Remove Report - deletes the currently selected filter (provided it is 
not one of the default filters)

 Reload Transactions - – there are occasions where the time taken to 
update various fields and balances is too much overhead for the system, 
use this button to ensure you can see all the data

•

•

•

•

•

•

•

•
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Orders Tab

This tab contains details of any Purchase Orders sent to the selected supplier. 
You can choose which fields you want to see by right clicking on any column 
heading. 

  Click this to create a new purchase order 

There are a minimum number of fields that you must fill in to complete a 
transaction. These are: 

Tax Point

From Account

To Account

Total Amount

Description 

See Chapter 14, Appendix D for an explanation of Table Columns. 

There are more options above the table with the following buttons:

 Copy Transaction – makes a copy of the currently selected transac-
tion to the same table

 Insert Purchase Transaction based on this Purchase Order -  this 
inserts a transaction in the Purchases tab based on the selected Purchase 
Order

•

•

•

•

•

•

•
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 Preset Transaction Selector – lets you pick a preset from the 
drop-down menu to auto-insert commonly occurring transactions

 Delete Transaction – hides the currently selected transaction from 
view (use the default filter drop-down menu option from the Filter Selec-
tor to show all deleted transactions again – where you can also un-delete 
them if you wish)

 Print - (Professional, Enterprise only)– opens the Accountz Design-
er (see Appendix C) so you can select or design a suitable template for 
printing the current table of filtered transactions

 Export as CSV File - opens a filer window so you can export the 
current table of filtered transactions in a format suitable for loading into 
a spreadsheet (i.e. CSV)

 Filter Selector - view a filtered list of transactions 
based on your selection from this drop down menu

 Edit Report – if the filter is not one of the default filters, this button 
will let you edit it

 Add Report - click this if you want to add a new filter to the list (it 
opens the Report Builder covered in Appendix B)

 Remove Report - deletes the currently selected filter (provided it is 
not one of the default filters)

 Reload Transactions - – there are occasions where the time taken to 
update various fields and balances is too much overhead for the system, 
use this button to ensure you can see all the data

•

•

•

•

•

•

•

•

•
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Supplier Table 

Here you can see a sortable list of  your suppliers and their details. Above the 
table are the following icons: 

 Add a new record

 Export all records –  exports this table as a CSV file

 Reload all records - clicking this updates the Supplier Table

 To create a new entry for a supplier in this table, click the Add a new 
record icon and enter their details into the following fields, as required: 

Name

Address

Postcode 

Reference

VAT Number 

Notes 

Go To Supplier (Enterprise only) - Double-click this icon to go to Sup-
plier Records 

•

•

•

•

•

•

•

•

•

•
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Purchase Transactions

This is where all purchase and payment transactions are added, edited or de-
leted (hidden). These will typically include expenses (such as stationery and 
office rent) and purchases of capital items such as a new computer or office 
furniture. 

 To create a new purchase transaction, click on the Create a New Transac-
tion button and enter data into the following fields: 

Tax Point

From Account            

To Account 

Total Amount

VAT Code

VAT Amount

Amount Less VAT 

Ignore the VAT fields if you are not VAT registered. You may want to turn 
them off by right clicking in any column heading and choosing from the menu. 
There are many more columns you can turn on. 

•

•

•

•

•

•

•
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See Chapter 14, Appendix D for an explanation of Table Columns. 

There are more options above the table with the following buttons: 

 Copy Transaction – makes a copy of the currently selected transac-
tion to the same table

 Preset Transaction Selector – lets you pick a preset from the 
drop-down menu to auto-insert commonly occurring transactions

 Delete Transaction – hides the currently selected transaction from 
view (use the default filter drop-down menu option from the Filter Selec-
tor to show all deleted transactions again – where you can also un-delete 
them if you wish)

 Print - (Professional, Enterprise only)– opens the Accountz Design-
er (see Appendix C) so you can select or design a suitable template for 
printing the current table of filtered transactions

 Export as CSV File - opens a filer window so you can export the 
current table of filtered transactions in a format suitable for loading into 
a spreadsheet (i.e. CSV)

 Filter Selector - view a filtered list of transactions 
based on your selection from this drop down menu

 Edit Report – if the filter is not one of the default filters, this button 
will let you edit it

 Add Report - click this if you want to add a new filter to the list (it 
opens the Report Builder covered in Appendix B)

 Remove Report - deletes the currently selected filter (provided it is 
not one of the default filters)

•

•

•

•

•

•

•

•

•
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 Reload Transactions - – there are occasions where the time taken to 
update various fields and balances is too much overhead for the system, 
use this button to ensure you can see all the data

Purchase Order Transactions (Enterprise only) 

Select Purchase Order Transactions from the Purchases menu to open the 
component. 

 To create a Purchase Order, click the Create a New Transaction button 
and enter data into the relevant fields: 

Tax point

Supplier

Reference

From Account

To Account

Total Amount

VAT Code

•

•

•

•

•

•

•

•



Business Accountz User Manual

186

VAT Amount

Amount Less VAT

Order Document (double-click this field to launch the Accountz De-
signer)

Description 

There are more options above the table with the following buttons: 

 Copy Transaction – makes a copy of the currently selected transac-
tion to the same table

 Insert Purchase Transaction based on this Order - this inserts a trans-
action in the Purchases tab based on the selected Purchase Order

 Preset Transaction Selector – lets you pick a preset from the 
drop-down menu to auto-insert commonly occurring transactions

 Delete Transaction – hides the currently selected transaction from 
view (use the default filter drop-down menu option from the Filter Selec-
tor to show all deleted transactions again – where you can also un-delete 
them if you wish)

 Print - (Professional, Enterprise only)– opens the Accountz Design-
er (see Appendix C) so you can select or design a suitable template for 
printing the current table of filtered transactions

 Export as CSV File - opens a filer window so you can export the 
current table of filtered transactions in a format suitable for loading into 
a spreadsheet (i.e. CSV)

 Filter Selector - view a filtered list of transactions 
based on your selection from this drop down menu

•

•

•

•

•

•

•

•

•

•
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 Edit Report – if the filter is not one of the default filters, this button 
will let you edit it

 Add Report - click this if you want to add a new filter to the list (it 
opens the Report Builder covered in Appendix B)

 Remove Report - deletes the currently selected filter (provided it is 
not one of the default filters)

 Reload Transactions - – there are occasions where the time taken to 
update various fields and balances is too much overhead for the system, 
use this button to ensure you can see all the data

Automated Purchases (Enterprise only)

 

With Automated Purchases you can create recurring entries (e.g. Direct Deb-
its) which will be automatically inserted into Purchase Transactions.

 Select the Create a New Transaction button and complete the following 
fields:

Start Date

Period - press the space bar to see a choice of period lengths

•

•

•

•

•

•
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Total Insertions - the total number of times you wish this transaction to 
be inserted automatically

Supplier

From Account

To Account

Total Amount

VAT Code

Description

 See Chapter 14, Appendix D for an explanation of Table Columns.

There are more options above the table with the following buttons:

 Copy Transaction – makes a copy of the currently selected transac-
tion to the same table

 Delete Transaction – hides the currently selected transaction from 
view (use the default filter drop-down menu option from the Filter Selec-
tor to show all deleted transactions again – where you can also un-delete 
them if you wish)

 Filter Selector - view a filtered list of transactions 
based on your selection from this drop down menu

 Reload Transactions - – there are occasions where the time taken to 
update various fields and balances is too much overhead for the system, 
use this button to ensure you can see all the data

•

•

•

•

•

•

•

•

•

•

•
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Preset Purchases (Professional, Enterprise only)

Preset Purchases is a great labour-saving feature which enables you to quickly 
enter a transaction into any Purchase Transactions table with just two clicks of 
the mouse (by simply selecting the preset from the preset selector list), leaving 
you with only the Tax Point, and Total Amount fields to complete.

 Select the Create transaction button and enter data into any of the fol-
lowing fields:

Preset Name

From Account

To Account

Total Amount (this will usually be left blank)

VAT Code (as above)

Description

Once complete, your preset will be available for selection from any preset 
selector drop-down list.

See Chapter 14, Appendix D for an explanation of Table Columns.

There are more options above the table with the following buttons:

•

•

•

•

•

•
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 Copy Transaction – makes a copy of the currently selected transac-
tion to the same table

 Delete Transaction – hides the currently selected transaction from 
view (use the default filter drop-down menu option from the Filter Selec-
tor to show all deleted transactions again – where you can also un-delete 
them if you wish)

 Filter Selector - view a filtered list of transactions 
based on your selection from this drop down menu

 Reload Transactions - – there are occasions where the time taken to 
update various fields and balances is too much overhead for the system, 
use this button to ensure you can see all the data

•

•

•

•
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9. General

Transfer Transactions

This is where all transfer transactions are added, edited or deleted (hidden). 
A transfer transaction is where money is moved from one account to another 
internally. Typical examples are topping up petty cash or paying off the busi-
ness credit card.

 To create a new transfer transaction, click on the Create Transaction but-
ton and enter data into the following fields: 

Tax Point

Customer / Supplier (as applicable)

From Account

To Account 

Total Amount

Description

See Chapter 14, Appendix D for an explanation of Table Columns.

There are more options above the table with the following buttons: 

•

•

•

•

•

•
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 Copy Transaction – makes a copy of the currently selected transac-
tion to the same table

 Preset Transaction Selector – lets you pick a preset from the 
drop-down menu to auto-insert commonly occurring transactions

 Delete Transaction – hides the currently selected transaction from 
view (use the default filter drop-down menu option from the Filter Selec-
tor to show all deleted transactions again – where you can also un-delete 
them if you wish)

 Print - (Professional, Enterprise only)– opens the Accountz Design-
er (see Appendix C) so you can select or design a suitable template for 
printing the current table of filtered transactions

 Export as CSV File - opens a filer window so you can export the 
current table of filtered transactions in a format suitable for loading into 
a spreadsheet (i.e. CSV)

 Filter Selector - view a filtered list of transactions 
based on your selection from this drop down menu

 Edit Report – if the filter is not one of the default filters, this button 
will let you edit it

 Add Report - click this if you want to add a new filter to the list (it 
opens the Report Builder covered in Appendix B)

 Remove Report - deletes the currently selected filter (provided it is 
not one of the default filters)

•

•

•

•

•

•

•

•

•
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 Reload Transactions - – there are occasions where the time taken to 
update various fields and balances is too much overhead for the system, 
use this button to ensure you can see all the data

Automated Transfers (Enterprise only)

With Automated Transfers you can create future and recurring entries which 
will be automatically inserted into Transfer Transactions. This is useful, for 
example, for paying off your business credit card.

 Select the Create Transaction button and complete the following fields:

Start Date - the date when you would like the first transaction to be au-
tomatically inserted

Period - the regularity with which these transactions are automatically 
inserted (weekly,monthly etc.)

Total Insertions - the total number of times you wish this transaction to 
be entered

Customer / Supplier (if applicable)

From Account

To Account

Total Amount

•

•

•

•

•

•

•

•
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Description

 See Chapter 14, Appendix D for an explanation of Table Columns.

There are more options above the table with the following buttons:

 Copy Transaction – makes a copy of the currently selected transac-
tion to the same table

 Delete Transaction – hides the currently selected transaction from 
view (use the default filter drop-down menu option from the Filter Selec-
tor to show all deleted transactions again – where you can also un-delete 
them if you wish)

 Filter Selector - view a filtered list of transactions 
based on your selection from this drop down menu

 Reload Transactions - – there are occasions where the time taken to 
update various fields and balances is too much overhead for the system, 
use this button to ensure you can see all the data (e.g. where new Presets 
have been added, the reload button will ensure they are displayed in the 
Preset Selector drop-down menu)

Preset Transfers (Professional, Enterprise only)

This labour-saving feature enables you to quickly enter regularly occurring 
transactions.

•

•

•

•

•
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Simply put, here you can create what is called a ‘preset transaction’, a pre-
defined transaction containing every necessary detail about your entry, except 
(usually) Tax Point and Total Amount. 

Then, the next time you wish to enter this transaction in the Transfer Transac-
tions component (for example, paying money from your bank account to your 
cash account), instead of having to create a completely new transaction and 
fill in all the fields in the transaction line, all you need do is choose your preset 
transaction from the preset selector (a drop-down list available on the toolbar) 
and the transaction will be inserted into the table with just the Tax Point and 
Total Amount fields remaining to be completed. 

To create a new Preset Transfer, select the Create transaction button  and 
enter data into the following fields:

Preset Name

From Account

To Account

Total Amount (this will usually be left blank)

Description

See Chapter 14, Appendix D for an explanation of Table Columns.

There are more options above the table with the following buttons:

 Copy Transaction – makes a copy of the currently selected transac-
tion to the same table

 Delete Transaction – hides the currently selected transaction from 
view (use the default filter drop-down menu option from the Filter Selec-
tor to show all deleted transactions again – where you can also un-delete 
them if you wish)

•

•

•

•

•

•

•
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 Filter Selector - view a filtered list of transactions 
based on your selection from this drop down menu

 Reload Transactions - – there are occasions where the time taken to 
update various fields and balances is too much overhead for the system, 
use this button to ensure you can see all the data (e.g. where new Presets 
have been added, the reload button will ensure they are displayed in the 
Preset Selector drop-down menu)

Journal Transactions 

Here you can record Journal Transactions. The Journal is a traditional tool 
used most often to close a set of accounts. It is included in Business Accountz 
purely for those users who either use, or are, accountants. It follows traditional 
double-entry. That is, each row represents a part of a transaction; either the ac-
count the transaction came from (a credit) or the account it went to (a debit).

You do not need to use or understand the Journal at all in order to use Business 
Accountz. It is, however, used by the software in one particular area, and that 
is the Year Closing procedure. Please see the last section in the tutorial earlier 
in the manual for full details of how it is used.

•

•
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You may also like to read the introduction where double-entry is explained in 
more detail, and how it relates to Business Accountz and the other transaction 
tables in the software.

Create a New Transaction 

 Select the Create Transaction button and enter data into the following 
fields:

Tax Point

Account 

Debit [To]

Credit [From]

Reference

Cleared

Description

There are column total balances on the bottom of the table. If these show zero, 
your transaction balances. Important: please click on the Reload transactions 
button on the right of the Journal toolbar to view the current balance. See 
Chapter 14, Appendix E for an explanation on Table Columns.

There are more options above the table with the following buttons:

 Copy Transaction – makes a copy of the currently selected transac-
tion to the same table

 Preset Transaction Selector – lets you pick a preset from the 
drop-down menu to auto-insert commonly occurring transactions

 Delete Transaction – hides the currently selected transaction from 
view (use the default filter drop-down menu option from the Filter Selec-

•

•

•

•

•

•

•

•

•

•
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tor to show all deleted transactions again – where you can also un-delete 
them if you wish)

 Print - (Professional, Enterprise only)– opens the Accountz Design-
er (see Appendix C) so you can select or design a suitable template for 
printing the current table of filtered transactions

 Export as CSV File - opens a filer window so you can export the 
current table of filtered transactions in a format suitable for loading into 
a spreadsheet (i.e. CSV)

 Filter Selector - view a filtered list of transactions 
based on your selection from this drop down menu

 Edit Report – if the filter is not one of the default filters, this button 
will let you edit it

 Add Report - click this if you want to add a new filter to the list (it 
opens the Report Builder covered in Appendix B)

 Remove Report - deletes the currently selected filter (provided it is 
not one of the default filters)

 Reload Transactions - – there are occasions where the time taken to 
update various fields and balances is too much overhead for the system, 
use this button to ensure you can see all the data

•

•

•

•

•

•

•
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10. VAT Return

VAT Set-up
Follow the VAT Setup registration wizard to set your VAT details.

The VAT Setup wizard is only available if you un-ticked the VAT Regis-
tered box in the Company Setup wizard (when you first started Business Ac-
countz).

It will ensure you have VAT Control account added to the Current Liabilities 
group in the Chart of Accounts. All Vatable transactions are displayed in the 
VAT Control account. It is a simple way of checking your complete VAT 
history. The balance should always agree with the current VAT Return (see 
later).
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VAT Return – Configuration

In the VAT Configuration tab you have the following information:   

VAT Account - This is the account used to control your VAT input and 
output tax. By default it is called VAT Control Account.

Company - This is your company name taken from the My Business 
component. Press the Space key for a complete list to choose from (as-
suming you have more than one business name or address).

VAT Period - Select the VAT period for your VAT return (the UK de-
fault is 3 months).

Start Date - Enter the start date for your VAT return. This will be the start 
of the first period that contains your first entry for this set of accounts.

•

•

•

•
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Standard VAT / Cash Accounting (check box) – Use this to select your 
VAT scheme. If you select Cash Accounting, you must read the relevant 
section in the tutorial (see ‘cash accounting’ in the index).

Country Code - reflects the country code set for the VAT return (n.b. this 
is set in the company setup wizard and cannot be changed).

VAT Rates – Shows all the VAT codes and rates for the country se-
lected.

User Editable VAT – Set a different VAT rate from those listed above. 

VAT Return

•

•

•

•
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The VAT Return shows you exactly what you need to fill in your VAT return.  
Every transaction entry that you make with VAT associated with it, will be 
entered into the VAT Return.

The period selection drop-down box lets you choose which period you want to 
view (you can setup your VAT period in the VAT Configuration tab).

The Sales and Purchase Transactions sections below the return show the trans-
actions that make up the VAT return. You can select which columns you want 
to see by right clicking on any header column.

There are 2 buttons in the toolbar above the table: 

 Print (Professional, Enterprise only)

 Export as CSV File

The Print button will display the return in the Document Editor. From there 
you can use the default UK VAT 100 return and click on the Design/Print tab 
at the foot of the page to print your return.

•

•
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11. Your Business

This is where you store Your Business details. As well as your business name 
and address, you can also record your employees and/or contacts in the Con-
tacts tab on the right.

 Add New Record Button

This button will clear all fields so that you can enter your business details. Use 
this option if you have more than 1 business address (please note your details 
are auto-saved).

Each record consists of the following fields:

Name

Address

Postcode

•

•

•
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Country

Notes

VAT Number

Reference

Other Lookup

There are 2 further buttons at the bottom of the panel:

 Hide this record - hides the current record.

 Recently viewed records - shows recently viewed records in the 
database.

 Add Contact Button

Located at the bottom of the Contact panel.

Clicking this will clear the data fields for you to enter alternative contact de-
tails (please note that your entry is automatically saved). 

Each contact also has the following fields where you can enter extra details:

Position – The contact’s job (eg. sales, purchasing, admin etc.).

Telephone – The contact’s telephone number.

Fax – The contact’s fax number.

Mobile – The contact’s mobile phone number.

Email – The contact’s email address. Press the Email button to the right 
of it to open your default email editor.

Internet – The contact’s website if they have one. View it by pressing the 
Internet button to the right of it.

•

•

•

•

•

•

•

•

•

•

•

•

•
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Link fields – There are 4 link fields so you can associate other web pages 
or folders on your computer or specific documents with a specific con-
tact. Note this may not work with all document types.

Notes – Add any notes specific to this contact here.

•

•
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12. Tools

Configuration

Here you can configure various different areas and aspects of the software. 
The component itself consists of 2 panels. 

The panel on the left contains all the configurable options. The panel on the 
right tells you what the selected option does. The top of the right panel con-
tains a description of the option, and the bottom contains the option itself.

Clicking on any of the folder icons will open a more detailed set of options. 
The sign to the left of each folder shows you if the folder is open (minus sign) 
or closed (plus sign).

This particular screenshot shows you how to change the date format.
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Language Selection

Here you can choose the language in which you wish to view the software. 

Select your chosen language from the drop-down menu and click OK. You 
will need to restart the software for this change to take effect.

Multi-line Calculator

To calculate a figure, add a new line to the table using the  Add a new 
calculation line icon and  start typing in the ‘Calculation’ field. As you enter 
the figures the result is calculated in the adjacent ‘Result’ field.  You can add 
a description of calculation if you wish, in the ‘Description’ field.

You can add as many rows of calculations as you like, and they are all saved 
with your file. The most common use of the calculator is to add up cheques 
that you are about to pay into the bank, or to add up petty cash receipts. You 
can cut and paste the result into a transaction. 
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Error Report

The Error Report tool appears in the lower panel and contains 3 fields:

From

Subject

Message

The From field is for your email address (used to send you a reply email). This 
field will also remember the last email that you used, so you do not have to 
re-enter it again.

The Subject field is used to give the error report a short description. It would 
be more useful if it described something of the problem rather than just say 
something like ‘Help!’.

The Message field is where you can specify the error encountered fully, so 
that our technical support team can look into the problem and reply to you 
with a solution as fast as possible. Please always state the computer system 
and operating system version number if you know it, plus the version number 
of the software (see Help>About).

•

•

•
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Desk Diary (Enterprise only)
This is where you can keep track of your appointments.

The Desk Diary component consists of 2 panels. The left panel contains the 
calendar itself; today's date is outlined in black, and dates with entries relating 
to them are coloured in red. You can select a date by left clicking it. When you 
do so, the selected date is shaded in blue.

The right panel is where you can create,  edit and delete entries.  You can view 
all future diary entries and create a prioritised 'To Do list'. There are 4 tabs 
above this table:

Diary Entries 
This tab (see above) shows all your dairy entries for the date selected. Left 
clicking on a red date will take you directly to this tab. The Reminder Status 
field shows if you have any reminders set for these entries. To edit an entry, 
double-click it; this will take you to the next tab:

Update Diary
This is where you create/edit/delete calendar entries, and set reminders for 
them. The top half of the table has two fields, Title, where you enter the title of 
your new entry, and Notes, where you can enter a more in depth description of 
this entry. These fields are also where you would edit an existing entry (N.B. 
data entered in these fields is automatically saved).
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This table has the following icons above it: 

 Add Entry –  click this button when you wish to add a new diary 
entry for the selected date.

 Repeat Entry – lets you create recurring diary entries. You can set 
how often and how many times you would like an entry to be inserted.

 Remove Entry – here you can delete the entry being viewed, plus 
any recurring entries based on this one.

To create a diary entry, enter the Title of your entry in the Title field, and a 
more detailed description (if you wish) in the Notes field, then click the Add 
Entry icon. 

If you wish to create a repeat entry, go to an existing entry, then click the 
Repeat Entry icon. Select how often and how many times you would like this 
entry to be made, then click OK.

To delete an entry that you are viewing, click the Remove Entry icon, and 
select (as relevant) if you wish to remove just this entry, any repeated entries 
based on it, or both. 

The lower half of this table is where you can set Reminders for a calendar 
entry.  

It has two columns:

•

•

•
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Reminder Time 

Reminder Status

The Reminder Time shows you when your reminder is scheduled for. At the 
specified time, the reminder will pop-up on your screen.

Reminder Status: a tick in this field shows that a reminder has been set for 
this entry. 

To create a reminder, click the  'Add Reminder' button. A pop-up screen 
will appear where you can set the time and date for when you would like the 
reminder to occur.

At the allotted time a pop-up screen will appear to remind you about the se-
lected event.

Select 'OK' to acknowledge that you have seen the reminder, 'Go to Diary 
Entry' to view the relevant entry, or 'Snooze' if you wish to reset the reminder 
for a later time.

To delete a reminder, select a reminder by left clicking it once, and click the 

'Remove Reminder' button .

Future Entries

•

•
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This field shows a complete list of your future diary entries (relative to today's 
date). Double-clicking on any entry will take you to the Update Diary where 
you can edit/delete/set a reminder for this entry.

To Do List

Here you can create a list of pressing tasks and give them a priority value (on 
a scale of 1 to 10, 1 being most urgent).The table has 2 columns, 'To do' and 
'Priority'. The first details a description of any task you have added to this list, 
the second relates its level of urgency.

There are 2 buttons above this table:

 Add a To Do note

 Remove a To Do note

Click the former to create a new line in the list. Type a description of your 
new item, and select a priority for it by left clicking the number in the 'Priority' 
field. A pop-up field will appear in which you can select the item's priority. 

The list will automatically sort itself in order of priority. To edit an item, sim-
ply left-click in the field you wish to change.

To delete a To Do note, select the item you wish to delete, then click on the  
'Remove a To Do note' button. 

•

•
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13. Help

Help

Open the Help navigator from the Help menu option in Business Accountz. 

Help is available on all the components within Business Accountz. On the left, 
under the main toolbar are various tabs. The 2 most important are the magni-
fying glass tab and the book tab. 

The magnifying glass lets you search for any text within the help document. 
The book tab shows you the complete contents. 

Online Help
Clicking this opens our Business Accountz Help page within your internet 
browser. From here you can access information about Business Accountz 
Training days, a list of FAQs, a Glossary, and our Free Help Forums.
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Help Forums
Click this to access our support forums directly.

Check for Upgrade
Here you can check to see if your version of Business Accountz is up to date, 
and download a patch if necessary. 

Set Licence Wizard

Runs the Set Licence Wizard, where you can enter the unlock licence key 
provided in your copy of Business Accountz.  

At the top of the panel is a description of each page of the wizard. Please fill 
in the necessary fields as described on screen.
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You will need an internet connection in order to unlock and install your li-
cence. You can use the software for 30 days without needing to install the 
licence. 

Note you can only use the licence key once. You can still load Business Ac-
countz onto another computer and use it provided you copy your database 
files from your licensed version into the other computer.  

About
You can open the About window from the Help menu. This shows you which 
version of Business Accountz you are using (eg. Business Accountz Basic or 
Business Accountz Professional) plus the version number (see the lower left 
text in the window). 
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Appendix A Rapid Data Entry
All Accountz software includes the Rapid Data Entry system. This is designed 
to help you to enter your data more quickly. 

Most of it revolves around entering data directly into the transaction tables (all 
data is immediately auto-saved). That is, without having to use dialogue boxes 
and having to click on ‘OK’ and ‘Yes, I really did mean to do that’ buttons! 

Almost every column has some kind of helper attached to it. The date picker is 
interactive. Start typing a date and the calendar opens and reacts to everything 
you type. Press the Enter key when the date is what you want – even after 
entering only the day of the month. 

Entering Dates

Anywhere within the program where you can enter a date, if you press the 
Space bar or start typing a date then a small Calendar will popup allowing you 
to select a date to be entered into the field. 

You can enter the date using the keyboard, and as you enter the date the calen-
dar will jump to that point. You can use any type of punctuation as a separator 
(eg. a space, a full stop, a forward or backslash etc.) and you do not have to 
include zeroes for numbers less than 10.
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 Press the Enter key if the calendar shows the date you want or double-click 
on a day to select it with the mouse. 

Lookup Lists
There are many types of lookup lists including alphabetically organised 
lookup (used in Customer / Supplier Records):

  

Filtered drop-down lists:

 

The filtered drop-down lists work intelligently. If you press spacebar before 
you have typed anything, a list of all the names available will appear. The 
more you type the more the list filters the result. You can press Enter at any 
time to insert the currently highlighted entry in the list, or you can use the Up/
Down arrow keys on the keyboard to choose a different name from the list. 

This means you can keep your hands on the keyboard which will keep your 
speed of entry high. Finally you can also double-click directly on an item in 
the list with the mouse, if you prefer. 
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Presets (Professional, Enterprise only)

The three main transaction components (sales, purchase and transfers) have a  
feature called Presets (available from their respective main menu options). 

This enables the user to enter complete transactions into the relevant transac-
tion table with just a single mouse-click, leaving just the date and amount 
fields remaining to complete the transaction.

For presets where you know the amount (eg. the annual data protection charge) 
you can preset this, too.

Please see p.68 for a description of how to enter these.

Tables

Sorting
Click once on any column header and it will sort the table by that column. 
Click again and the sort will reverse. Click a third time to turn sorting off.

You can also right click on any column header and choose the sort option 
from the menu.

Sorting columns is a great way of finding items quickly. For example when 
trying to locate transactions of a certain value, sorting on, say, the Amount 
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column will not only put all the transactions of the same value together, you 
will also see those that are close to the value you are after. 

Columns - hide/show
By right clicking on any of the column headers within a table, then choosing 
‘Columns’ from the menu which appears, you can add and remove columns 
as you wish. By turning off the columns you don’t need (eg. VAT if you are 
not VAT registered) it will help speed up data input.

If you only have a single button mouse, press the Control (Ctrl) key at the 
same time. 

Swapping columns
You can drag any columns left or right thereby swapping the column order. 
One useful consequence of this is if you want Business Accountz to automati-
cally calculate and add VAT to a transaction. To do this swap the Amount 
Total and Amount less VAT columns over. Now when you type the amount 
less VAT and enter S for standard rated VAT the VAT will be calculated and 
added on (rather than the default of assuming the transaction includes VAT).
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Column widths
The column widths on any of the column headings within a table can be re-
duced or enlarged by dragging the mouse on the column separators. If you 
have a lot of columns turned on and are using a low resolution, this can keep 
the whole table in view (rather than having to use scroll bars to see your 
data).

Filtering

You can filter most of the tables in any way you like to either restrict the 
data to what is relevant to you at the time (eg. unpaid invoices) or for a 
report you want (eg. uncleared bank account entries). 

These filters are created in the Report Builder (see appendix B).  
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Appendix B Report Builder 

The Report Builder allows you to create an unlimited number of reports. You 
can switch between these reports with just 2 clicks of the mouse (by choosing 
a different filter from the drop-down filter selector list (found in any transac-
tion table)). 

By default, Business Accountz comes with a number of reports already set for 
you. However, the Report Builder is immensely powerful and will let you do 
almost anything provided you understand how it works. 

You can create a new report in any transaction table.

To do so, click the  Add New Filtered Report icon. This opens a pop-up 
window prompting you to enter the new report’s name. The name should re-
flect what the report is about. If you want to set it up to show unpaid invoices 
then naming it so will make it easier to find and use later on. 

Once you have named your report, the Report Builder will open. This contains 
a table with the following columns:

Add/Remove

Filters

Active

Operator

Parameter

Note

The Filters column mirrors all columns in the transactions tables. Reports are 
based on these columns by using different operators and parameters.

Here is a list of all column filters possible:

Transaction ID [ID filter]

•

•

•

•

•

•

•
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Transaction Number [Number filter]

Deleted Transaction [Deleted filter]

Transaction Date [Date filter]

Transaction Date Relative [Relative Date filter]

Transaction Group ID [ID filter]

Tax Point [Date filter]

Tax Point Relative [Relative Date filter]

Amount [Decimal filter]

Account [ID filter 2] 

Description [Text filter 2]

Reference [Text filter 2]

Cleared [Boolean filter]

Tax Code [ID filter]

Paid [Boolean filter]

Personal ID [ID filter]

VAT Date [Date filter]

VAT Date Relative [Relative Date filter]

Paid Date [Date filter]

Paid Date Relative [Relative Date filter]

Currency Code (Optional) [ID Filter}

Currency Amount (Optional) [Decimal filter]

Currency Rate (Optional) [Decimal filter]

•

•

•

•

•

•

•

•

•

•

•

•

•

•

•

•

•

•

•

•

•

•
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Quantity [Decimal filter]

Price [Decimal filter]

Price Less VAT [Decimal filter] 

The filter logic is in square brackets [eg. Text Filter]. It gives you an idea of 
how each filter works. For example, the Text Filter used in the Description 
field will filter by what you type into it. 

The Date Filter works on dates. The Boolean filter is a grand word that is sim-
pler than it sounds: any parameter associated with it can only be true or false. 

Worked example – Sales for January 2009 only

Select the  Add New Filtered Report button above the transaction 
table for which you wish to create a report.

Give the Report a name and click OK to open the Report Builder.

Select the  Add icon to the left of the Paid filter. A line will be 
inserted below it 

•

•

•

1.

2.

3.
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.  

Check the Active box to the right of the Tax Point filter.

Select the After or Equal To Date Operator by clicking in the Operator 
field (press the space bar to see all available options).

Select the date we wish the report to start, i.e. 1/1/09 and hit enter.

Hit the  Add icon once more to add a second condition for the filter.

Set the Operator for this line as ‘Before or Equal to Date’.

Enter the end date for the report, i.e. 31/1/09 and hit enter.

Click the Blue Books icon to return to Sales Transactions. 
 
 
 
 
 

4.

5.

6.

7.

8.

9.

10.
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The Report name ‘Sales January 09’ is now available for selection from 
the Filter Selector drop down list. 
 

Select ‘Sales January 09’ from the list by left clicking it - now only the 
sales for this month are displayed in the sales transactions table.

11.

12.
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Operators and Parameters 
Filters
 

Operator 
 

Parameter
 

Parameter 
Example
 

ID Filter
 

Equal To
Not Equal To

Letter and 
Numbers
 

A125S
 

Number Filter
 

Equal To
Not Equal To
Less Than
More Than
Less Than or Equal To
More Than or Equal To

Number
 

2500
 

Deleted Filter
 

Equal To
Not Equal To

True/False
 

True
 

Boolean Filter
 

Equal To
Not Equal To

True/False
 

False
 

Date Filter
 

Equal To
Not Equal To
Before Date
After Date
Before or Equal To Date
After of Equal To Date

Date
 

21-08-06
 

Relative Date 
Filter
 

Last Number of Days
Last Number of Weeks
Last Number of Months
Last Number of Years

Number
 

9
 

Text Filter
 

Equal To
Not Equal To

Text
 

Bank Account
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Decimal Filter
 

Equal To
Not Equal To
Less Than
More Than
Less Than or Equal To
More Than or Equal To

Decimal 
Number
 

20.66
 

ID Filter 2
 Equal To

Not Equal To

List of Ac-
counts
 

Enter the ac-
count name, or 
hit spacebar to 
see full list of 
accounts

Text Filter 2
 

Equal To
Not Equal To
Contains
Starts With
Ends With

Text
 

Tim Jones
 

Adding more filters to a report
The Add/Remove column within Report Builder allows you to add (or re-
move) further filters to the report you want to generate. You can add as many 
filters as you like for each column.

To do so click the  Add icon adjacent to the Filter to which you wish to 
add a condition (as per line 3 of our worked example above).

Next, add your condition (as per lines 5 and 6 above).

Before the new filter will effect the report you are building/editing, you must 
activate it by ticking the check-box in the Active column adjacent to relevant 
Filter (e.g. ‘date condition’).

When you have finished adding and editing the filters, close the report builder 

and click the  Reload/update all transactions icon. Your filtered report is 
now available for selection. You can create as many reports as you like and 
switch between them using the Filter Selector drop-down menu.
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Relative and Non Relative Dates 
There are two ways of specifying a date: Relative and Non Relative. These 
filters affect the Tax Point and VAT Date fields. 

1) Relative (now and before) 

Relative dates will show the current month and onwards if set to 0 (0 being 
this month). If you set it to 1 then this will display this month and plus 1 previ-
ous month.  Whatever number you set will be the number of previous months 
that will be displayed. You can set relative dates for days, weeks, months and 
years. 

2) Non Relative Dates (start and end) 

Filters a report by specific start and end dates. You set the start and end dates 
and only those transactions that are in between those dates will be displayed. 

Removing individual filters from a report

To remove a column filter press the  Remove icon next to the filter you 
want to remove (within Report Builder). 

Deleting all filters (removing the complete report)
To delete a report select it from the drop down list (within e.g. the Sales 

Transactions Table), then click the  Remove current report from list 
icon.
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Appendix C Accountz Designer (Professional, 
Enterprise only) 
The Accountz Designer allows you to design various different documents 
to suit your business needs. This appendix looks at how the designer works 
when creating an invoice for a customer. 

To create an invoice for a selected customer press the  Create NEW 
Invoice button (within the Customer Records component). This opens the 
View/Edit tab of the Accountz Designer within the Document Editor com-
ponent.

The View/Edit Tab

The View/Edit tab contains all the underlying invoice detail. At the top are 3 
fields containing information about this invoice.

Name •
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Template

Description

By default the invoice name will be ‘Invoice for customer.’ You can edit 
this if you wish (n.b. if you intend to turn this invoice into a template (see 
below), it will appear by this name in the templates list).

The Template field contains a drop-down list from which you can choose 
which template to use for this invoice.

The Description field is used if you wish to give this usage of the invoice 
a description (i.e. relating to this individual sales transaction) for your own 
reference.

Next is the Make into Template check box, which, if ticked, will make this 
invoice (and any design modifications you have made to it) available as a 
template for future invoices.

Date format - This will set the date format for the document. The case of 
each letter is important. Upper case ‘M’ is for ‘months’, lower case ‘m’ is for 
‘minutes’ (for a timed date). This feature allows great flexibility. For exam-
ple, dd MMMM yyyy will produce a date like this: 28 February 2007.

y = Year

M = Month

d = Day

Other examples:

UK: 23/10/2006  : dd/MM/yyyy

UK: 23/Jan/06   : dd/MMM/yy

USA: 10-23-2006 : MM-dd-yyyy

For further information on date formats please visit:

http://java.sun.com/j2se/1.4.2/docs/api/java/text/SimpleDateFormat.html

•

•
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There are 4 further fields:

Tax Point [defaults to today]

Customer [defaults to selected customer]

Delivery [empty]

Reference [taken from File>Documents>Invoice Tab]

Edit the date for the invoice if necessary. The customer field is automati-
cally completed for you. The Delivery field is left blank by default. If you 
wish the invoice to show a delivery address, firstly ensure you are using a 
template which does indeed show one (i.e. not ‘Template Invoice Document 
without Delivery Address’), then click within the Delivery field and press 
the spacebar to choose from a list of possible contacts.

The Reference field is used for the invoice number on the document itself. 
This field will be automatically filled for you starting with the value ‘1’ (and 
increasing incrementally). If you have a preferred invoice numbering system 
you can change to this by amending the figure for ‘Last Document Value’ 
within File>Documents>Invoice Tab.

A table follows where you can add items to the invoice (n.b. each line you 
add in the table also creates a transaction in the sales transactions compo-

nent). Click on  Add Transaction to add a new line.

The table has the following fields, the first five of which must be completed 
for each transaction line:

Description 

•

•

•

•

•
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From Account

To Account 

Total Amount 

VAT Code

VAT Amount

Amount Less VAT

Paid

You can also add and remove the following columns by right clicking 
anywhere on a column heading and selecting from the columns menu (see 
Appendix D for details of each column – these are the same as for Sales 
Transactions because this is what each line in an invoice creates).

Paid Date

Cleared To

Cleared From

Date Created

Error Code

Hide 

Transaction ID

Transaction Code

The final part of the View/Edit Tab, entitled ‘Column visibility and order in 
Document’ is where you can select which of the following columns will be 
visible in the finished document:

Description

Total Amount

•

•

•

•

•

•

•

•

•

•

•

•

•

•

•

•

•
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VAT Code

VAT Amount

Amount Less VAT

Paid

To Account

From Account

Simply tick or untick any of the check boxes next to each column name, then 

click the  Reload Column Names icon to update the document.

You can change the column order within the document using the following 
two icons:

 Move Column Left icon

 Move Column Right icon

Once you have entered the necessary details for the invoice, click the De-
sign/Print tab to view the document in the designer.

•

•

•

•

•

•
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The Design/Print Tab

The Design/Print tab shows the invoice in the designer view. This is how 
your invoice will look when you come to print it.

 The designer has 2 toolbars. The first, on the left side,consists of the follow-
ing tools:

 Selection tool 	

 Line tool		

 Square tool		

 Circle tool		
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 Ellipse tool		

 Text tool		

 Image tool		

These tools allow you to add new items to the document.

The second toolbar (at the top) consists of the following tools:

 Print Document		

 Scale Document Slider	

 Previous Page			

 Next Page			 

 Add Page 			 

 Remove Page		

These tools allow you to Print and Scale the document, as well as Add, 
Remove and Navigate through a multi-page document.

Left Toolbar

 Selection Tool

When the Design/Print tab first opens the selection tool is selected and you 
will see 2 properties fields on the right:
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Select Element

Copy Elements

 Select Elements allows you to select elements on the document and 
layer them on top of each other. The element at the top will be above all 
other elements and the element at the bottom will be below all other 
elements in the document. You can move the elements up and down using 

the   Move up and  Move down buttons. To delete the element press 
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the  Delete button. If you double click any element in this list then you 
will open the properties for that element so that you can edit them.

Copy Elements allows you to copy elements from one page to the same 
or another page. Double clicking on a blank area of the page opens the list 
showing all the elements on that page.

Pressing the  Copy To Page button will copy that selected element to the 
page. See the copied element in the Select Elements properties list.

 Line Tool

The Line tool allows you to draw lines on the document. Click and hold 
where you want the line to start then move the mouse to the point where you 
want the line to end.  When you release the mouse the line is created.

Line Properties

 Position and size

Start point from the left of the document

Start point from the top of the document

Alter these to edit the line’s start point.

End point from the left of the document

End point from the top of the document

Alter these to edit the line’s end point.

The line Start and End points are absolute to the points you specify (eg. 5cm 
from the left, whether it is the start or end of a line always means 5cm from 
the left of the page).

•

•

•

•
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 Line

Width - sets the width of the line.

Line Pattern - sets the pattern of the line.

 Line Colour

Colour - sets the colour of the line.

Opacity - sets the opacity of the line.

 Square Tool
The Square tool allows you to create a square/rectangle on the document.  
Click and hold the mouse where you want the square/rectangle to start.  
Move the mouse to where you want the opposite corner to be then release the 
mouse to create the object.

Square Properties

 Position and size
Start point from the left of the document

Start point from the top of the document

Sets the position of the square/rectangle.

Width

Height

Sets the width and height of the Square/Rectangle (relative to the start point).

Horizontal -Radius (rounded corners)

Vertical -Radius

•

•

•

•

•

•

•

•

•

•
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You can round the corners of the Square/Rectangle here.

 Line

Width - sets the line width of the Square/Rectangle.

Line Pattern - sets the line pattern of the Square/Rectangle.

 Line Colour

Colour - sets the colour of the Square/Rectangle.

Opacity - sets the opacity of the Square/Rectangle.

 Fill Colour

Colour - sets the fill colour of the Square/Rectangle.

Opacity - sets the opacity of the fill colour in the Square/Rectangle.

 Circle Tool
The Circle tool allows you to create Circles on the document.  The Circle has 
a red square box that it sits inside. When creating a Circle you click and drag 
the mouse for the two opposite corners of the square box and the Circle sits 
inside it.

Circle Properties

 Position and size

Start point from the left of the document

Start point from the top of the document

Sets the centre point of the Circle.

Radius - sets the radius of the Circle from the centre point.

•

•

•

•

•

•

•

•

•
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 Line

Width - sets the line width of the Circle.

Line Pattern - you can change the line pattern here

 Line Colour

Colour - sets the colour of the Circle.

Opacity - sets the opacity of the Circle.

 Fill Colour

Colour - sets the fill colour of the Circle.

Opacity - sets the opacity of the fill colour in the Circle.

 Ellipse Tool
The Ellipse tool allows you to create ellipses in the document.  The Ellipse 
has a red rectangular box that it sits inside. When creating an ellipse you 
click and drag the mouse for the two opposite corners of the rectangular box 
and the ellipse sits inside it.

Ellipse Properties

 Position and size

Start point from the left of the document

Start point from the top of the document

Sets the centre point of the ellipse.

Horizontal -Radius

Vertical -Radius

•

•

•

•

•

•

•

•

•

•
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Sets the Horizontal and Vertical radius from the centre point to make the 
ellipse.

 Line

Width - sets the line width of the ellipse.

Line Pattern - sets the line pattern of the ellipse.

 Line Colour

Colour - sets the colour of the ellipse.

Opacity - sets the opacity of the ellipse.

 Fill Colour

Colour - sets the fill colour of the ellipse.

Opacity - sets the opacity of the fill colour in the ellipse.

 Text Tool
The Text tool allows you to insert text onto the document. 

Select the Text Tool Button.

Click where you want the text to appear. A red box will appear on the 
document.

Enter the text in the Edit Text Properties field.

•

•

•

•

•

•

1.

2.

3.
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As you input the text into the Edit Text field you will see it appear in the red 
box in the document.

Text Properties

 Position and size

Start point from the left of the document

Start point from the top of the document

Sets the position of the text.

 Edit Text

Text Area field to enter text to the document.

•

•
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 Font

Font Family Name - sets the font for the text.

Size -sets the font size.

Style - you can set Bold, Italic and Underline styles here.

 Outline

Width - sets the outline width of the font. 

Line Pattern - sets the line pattern of the font.

 Outline Colour

Colour - sets the colour of the text.

Opacity - sets the opacity of the text.

 Fill Colour

Colour - sets the fill colour of the text.

Opacity - sets the opacity of the fill colour of the text.

•

•

•

•

•

•

•

•

•
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 Image Tool
Click where you want the image to appear in the document. This will open 
the file chooser dialog. Choose the file and press OK to insert the image in 
the document. The point where you click on the document to insert an image 
will be the top left point of the image, the other points will be relative to this.

Image Properties

 Position and size

Start point from the left of the document

Start point from the top of the document

Sets the position of the image. 

Width (optional checkboxes)

Height

If you check this checkbox then you can set the size manually.

Scale toolbar (optional checkboxes)

If you check this checkbox then you can use the slider to set the size.

Top Toolbar

 Print Button

Pressing the print button opens the print pop-up allowing you to print the 
document by selecting a printer from your system.

 Scale Tool Slider

The scale slider tool allows you to zoom in and out of the document.

•

•

•

•

•
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 Previous Page Button

 Next Page Button

The Previous and Next Page buttons allows navigating through your docu-
ment pages.

 Add Page Button

 Remove Page Button

The Add and Remove Page buttons allows you to add and remove pages to 
the document.

Table Properties
After you have inputted all the necessary details in the View/Edit tab, the 
designer creates a table for you. This table contains the invoice entries. You 
can edit the table properties by selecting the table on the document and edit-
ing the properties on the right.

 Position and Size

Start point from the left of the document

Start point from the top of the document

Sets the position of the table.

Width

Height

Sets the width and height of the table.

•

•

•

•
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 Vertical Line 

Width - sets the vertical line width.

 Line Pattern

Sets the vertical line pattern. 
 
Horizontal Line 

Width - sets the horizontal line width.

Line Pattern - sets the horizontal line pattern.

 Border Line 

Width - sets the border line width.

Line Pattern - sets the borderline pattern. 

 Header Fill Colour

Colour - Sets the header fill colour.

Opacity - Sets the opacity of the header fill colour.

 Vertical Line Colour

Colour - sets the vertical line colour.

Opacity - sets the opacity of the vertical line colour.

•

•

•

•

•

•

•

•

•
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 Horizontal Line Colour

Colour - sets the horizontal line colour.

Opacity - sets the opacity of the horizontal line colour.

 Cell Fill Colour

Colour - sets the cell fill colour.

Opacity - sets the opacity of the cell fill colour.

 Table Background Colour

Colour - sets the table background colour

Opacity Slider - sets the opacity of the table background colour

 Border Line Colour

Colour - sets the border line colour.

Opacity - sets the opacity of the border line colour.

 Header Font

Font Family Name - sets the header font type

Size - sets the header font size

•

•

•

•

•

•

•

•

•

•
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Style - sets the header font style

 Header Font Colour

Colour - sets the header font colour

Opacity Slider - sets the opacity of the header font colour

 Cell Font

Font Family Name - sets the cell font type

Size - sets the cell font size

Style - sets the cell font style

 Cell Font Colour

Colour - sets the cell font colour

Opacity Slider - sets the opacity of the cell font colour

•

•

•

•

•

•

•

•



Business Accountz User Manual

249

Worked Example – Create an invoice for a customer

1. Within Customer Records, select the Customer for whom you wish to 
produce an invoice (you can set the default To and From Accounts in the 
Customer database to save you time when creating invoices in the future).

2. Press the Create New Invoice button.
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3. Set the Tax Point for the invoice

4. Select the delivery address, if necessary.

5. Add invoice entries to the table. 
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6. Select the Design/Print tab.

7. Edit the design of the document if necessary

8. Select the Print button.

You can view/edit/print any invoice again either via Sales Transactions (dou-
ble-click the Sales Document field for the invoice) or via the File > Docu-
ment Editor menu option or via the File > Documents menu.



Business Accountz User Manual

252

Appendix D Table Columns
This is a list of all the available columns throughout the software, and descrip-
tions where necessary (please note that not all columns are available in all 
tables).

Amount less VAT – the net amount after VAT has been deducted

Backup time – when the backup was made

Cleared – used if the entry appears on, say, a bank statement (ticking/un-
ticking the box will update your Statement Balance accordingly)

Cleared (From)/Cleared (To) - does the same job as ‘Cleared’ (above)

Created - when the document was created

Credit (From) – equivalent to Account From except the amount is re-
corded

Customer - use this field to associate a customer with a transaction

Date Created – the actual creation date of this transaction (it may be dif-
ferent from the Tax Point or Paid Date)

Debit (To) – equivalent to Account To except the amount is recorded

Deleted – this is ticked if the entry has been ‘deleted’ (the entry will al-
ways be there, but just hidden from view and the chart of accounts)

Description - describes the nature of the transaction. This information is 
used if you create a document for the transaction.

From Account – where the money came from (a sales account for a sale, 
a payment account for a purchase or, say, a bank for a transfer)

Is Template – other documents can be based on this one

Order Document - if this field is empty, double-click within it to create a 
document for this Purchase Order Transaction. If not, double click in the 
field to view the existing document.

•

•

•

•

•

•

•

•

•

•

•

•

•

•
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Paid - ticking this box marks a transaction as paid for the purposes of the 
customer/supplier statement

Paid Date – the date on which this transaction was paid

Path on filesystem – the location and name of the backup

Period 1, 2 or 3 - shows total unpaid sales/purchase transactions relating 
to this period for a particular customer/supplier

Preset Name – enter a memorable name so you can choose it with ease 
from the preset drop-down menu in the Sales Transaction component

Quantity - used when a transaction comprises of multiples of the same 
item

Running Balance – shows how the balance changes as each transaction 
is taken into account

Sales Document - if this field is empty, double-click within it to create 
a document for this sales transaction. If not, double click in the field to 
view the existing document.

Show Customer - double clicking this icon takes you to the Customer 
Records Component (Professional, Enterprise only)

Show Supplier - double clicking this icon takes you to the Supplier 
Records Component (Enterprise only)

Supplier - use this field to associate a supplier with a transaction

Tax Point – the date of the transaction for tax purposes

To Account – where the money went to (the bank if a sale, some expense 
account if a purchase or some other monetary account if a transfer, eg. 
VAT Control if you are paying your VAT Return)

Total Amount – the full total of the transaction

Transaction ID – each transaction is automatically given a unique ID

•

•

•

•

•

•

•

•

•

•

•

•

•

•

•
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Transaction Number – an auto-generated number starting from 1 given 
to each transaction that should be written on to the source document that 
the transaction came from to aid later identification

Type / Description– who or what made the backup

Unit Price - sets the unit price for an item (use in conjunction with the 
Quantity field)

Unit Price less VAT - see above

VAT Amount – see the next entry (VAT can be edited manually if it is 
different from the auto-calculated amount)

VAT Code – the VAT code associated with this transaction (eg. S for 
Standard rate VAT), when a code is entered, the VAT is automatically 
calculated.

VAT Date - the date used for the relevant VAT return period.

•

•

•

•

•

•

•
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Appendix E Guide to Entering Transactions
Accountz has revolutionised double entry bookkeeping: every aspect of a 
transaction is entered in a single line. This means that provided you fill in the 
minimum required fields (‘Tax Point’, ‘From Account’, ‘To Account’, ‘Total 
Amount’ and ‘VAT Code’ - the software will tell you if you haven’t by turn-
ing the errant transaction line red), your books will always balance.

Let’s take a sale as an example. You have made a sale for £50 which has 
been paid for straight away.

You would enter this in Sales Transactions (Blue Books) like this (please 
note for these examples we will ignore the Customer, Sales Document and 
Description fields, as we are neither associating the transaction with a cus-
tomer, nor creating a document for it):

Click the green plus sign to add a new transaction line. In the Tax Point, set 
the date of the sale.

In the ‘From Account’ field, select where the money has come from. For this 
example we will use ‘Sales Account’ (this account is generated by default 
when you set up the Chart of Accounts) - hit the spacebar when your cursor 
is in this field to see a list of available options, and choose ‘Sales Account’ 
from this list (if you hit ‘s’, or start typing ‘sales’ you will see your options 
narrow down).

For the ‘To Account’ field, choose ‘Bank Account’, for Total Amount enter 
‘50’.

For the VAT Code (this column is available if you chose to be VAT regis-
tered – otherwise ignore this paragraph) press ‘s’ – ‘Standard VAT’ will be 
offered as an option – press enter to select it. The rest of the fields relating to 
VAT are filled in for you. 

Your line looks like this (Fig. 1):
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If you check the Chart of Accounts, you will see that the relevant accounts 
have been updated to reflect these figures.

This simple transaction structure is repeated across the software – once you 
learn this, you are almost there!

Complete process for entering transactions
Sales

1.If you have a paid sale as before, your transaction (in the blue books) looks 
like this (Fig. 1):

2. For an unpaid sale the entry in the Sales Transactions table looks like this 
(Fig. 2):

When the sale is paid, go to your Green Books (Transfer Transactions) and 
make another entry (Fig. 3):

Go back to your initial transaction (Fig. 2) and tick the Paid box. This also 
updates your customer statement (Professional, Enterprise only).

If you receive a cheque for this sale, but don’t pay it in separately (as you 
have some other cheques to pay in at the same time), then you would need to 
replace Fig. 3 with Fig 3a (below), which pays the money into a theoretical 
holding account, called Undeposited Funds:

Then, when you actually pay in the cheques together (let’s say they add up to 
140) you create another transfer transaction (Fig. 4):
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The reason for this is (a) it gives you a more accurate audit trail, and (b) it 
makes it easier to reconcile your bank account.

As you can see from the above, Accountz tracks the flow of money, from 
somewhere to somewhere else and so for all these examples the logic is that 
money has flowed from Sales Account to Bank Account.

In Example 1 this happens directly in one transaction line; in Example 2 
there are intermediate steps but the result is ultimately the same.

Purchases

1. For a completed purchase, say £100 for Equipment, your transaction in the 
Red Books (Purchase Transactions) table looks like this (Fig. 5):

2. For an unpaid purchase (i.e. on credit) your transaction in the Red Books 
looks like this (Fig. 6):

When the purchase is actually paid for, go to the Green Books (Transfer 
Transactions) and make another entry, thus (Fig. 7):

Go back to your initial transaction (Fig. 6) and tick the Paid box. This up-
dates your supplier statement (Enterprise only).
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Transfers

Aside from the usage described in Purchase and Sales above, you will tend 
to use Transfer Transactions for such tasks as topping up petty cash or pay-
ing off the company credit card:

1. Topping up petty cash (Fig. 8):

2. Paying off the company credit card (Fig. 9):
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Appendix F Multi-Currency (Licence Add-on)
If you install the Multi-currency licence, 6 new columns will become avail-
able in most of the tables. These are:

Currency Code: eg. EUR for Euro

Currency Rate: user-set for the rate at the time of the transaction

Currency Amount: the total amount including any taxes such as VAT

Currency Amount less VAT: the total amount less VAT

Currency VAT Amount: the VAT amount in the specified currency

Currency Unit Price: the total amount of each unit if more than 1 is speci-
fied as a quantity

You can turn on all or any of these columns as necessary. Do this in one go 
before dragging them to the desired position in the table. Right click (or Com-
mand + Click on a one button mouse on a Mac) on any column header to add 
or remove columns from any table.

You will also need to add these to an invoice if you need to invoice in another 
currency. The best idea is to set up a new invoice template from the menu op-
tion File > Documents > Invoices. Select a suitable  template, then click on the 
button on the bottom right. Give the template a new name (eg. Euro Default 
Invoice) so it is easy to select it in the future.

If you have a foreign currency account, you can open it in current assets and 
view all currency transactions by turning on the new currency columns in the 
right hand panel. Foreign currency transactions can directly affect your base 
currency bank account, or a specific foreign currency account.

All balances are displayed in the Chart of Accounts in your base currency.

•

•

•

•

•

•
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Appendix G Simple Guide to Bookkeeping

Introduction
This is a simple guide to double-entry bookkeeping, a pattern like all good 
patterns that has stood the test of time (modern double-entry was outlined 
in Benedetto Cotrugli's treatise Delia Mercatura et del Mercante Perfetto in 
1458 and expanded in Pacioli's Summa de arithmetica 36 years later). The 
problem with most guides (certainly all those I have read on the subject) is 
that they start off with the balance sheet. This is enough to put most people 
off for life. 

This guide takes an entirely different approach. By using a few transactions 
and some simple guidelines the logic behind double-entry becomes clear and 
the jargon falls into place. 

Words like nominal ledger and trial balance will become second nature. You 
will have no problem with your debits and credits. In short, you will be able to 
post a journal just as easily as you can now post a letter.

 By the end, you will be able to talk, and understand, the same language as 
your bank manager, accountant, and tax inspector.

Transactions
When we buy something there are two things to consider:

 Where the money came from (i.e. the account that is paying for it, e.g. 
bank or cash)

Where the money went to (i.e. what it was spent on, e.g. petrol, station-
ery, insurance)

 In a single-entry accounting system entries are recorded one after another in 
a book which typically has columns for the account used and the analysis of 
what was bought. Whilst we have no problem looking at the bank and cash 

1.

2.
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columns as accounts, we rarely think of the analysis headings as accounts in 
their own right. 

In a double-entry system all of these are referred to as accounts (e.g. a cash ac-
count, a petrol account etc.), and more importantly, separate entries are made 
for each account involved in a transaction. 

Suppose we pay for some petrol with cash. Two entries are required: 

One to show where the money came from (cash)

One to show where it went to (petrol). 

This from and to aspect of each transaction is known as crediting and debiting. 
It is what the term double-entry means. 

In order to record these entries we need somewhere to write them down. These 
are called Day Books or Journals.

The Journal
This is a book (similar to a diary) that contains various columns where day 
to day financial transactions are recorded. The minimum number of columns 
required is five: 

Date

Account

Reference

Amount to debit

Amount to credit 

All transactions are entered one after another in date order, therefore the book 
contains a complete history of transactions in chronological order. In practice, 
a business will use more than one book, each of which will be devoted to a 
certain aspect of the business and each will be given a name to reflect this (e.g. 
'sales' or 'purchases').

1.

2.

1.

2.

3.

4.

5.
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Let's start with the example given earlier: purchasing petrol with cash. Two 
accounts are involved in this transaction (petrol and cash) so we will need to 
make two entries. 

The entries show how the money flows from one account to another. To 
achieve this the first entry will credit one of the accounts and the second will 
debit the other. However, deciding which account to debit and which to credit 
is not particularly obvious (getting it the wrong way round is by far the most 
common error in double-entry). 

This is where our first helpful hint comes in: 

Every transaction must come from somewhere and go to somewhere else. The 
from side is the credit side and the to side is the debit side. 

So, from=credit and to=debit. You can remember this easily because the F 
in from comes before the T in to and C in credit is before the D in debit. Re-
member this single rule of wisdom and you always know your credits from 
your debits. 

Traditionally the debit column is shown to the left, and the credit column to 
the right. That is, double-entry goes to before it knows where it came from, 
hence the famous T-Shirt slogan Accountants do it Backwards! 

If you apply this from and to principle to our first transaction you will know 
which account to debit and which to credit: the money is coming from cash 
and going to petrol so we credit cash and debit petrol. 

Lets take a look at the cash account to understand exactly why we credit it 
when we are taking money from it. 

The cash account should be thought of as a real cash box. When you remove 
some money to buy some goods, you should replace it with a receipt or petty 
cash slip to say what the money was used for. A receipt or petty cash slip is 
a form of credit note, so the cash box now contains a credit note instead of 
the cash, hence we show the entry as a credit (logically, if you returned the 
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goods because they were faulty, the receipt would be given back in exchange 
for the cash). 

The exact same applies to any monetary account whether it is cash or a current 
bank account. When you take money from it, it is credited in your books.

Looking at the debit side (where the money went to), the petrol account now 
has the money (albeit in the form of half a tank of petrol!), it got the money 
from cash so it is in debt to cash - hence it is entered as a debit.

This is the fundamental principle of double-entry, we are keeping track of 
where the money came from (a credit) and where the money went to (a deb-
it). 

Furthermore the first rule of accounting states that all the debits must equal 
the credits. Therefore, provided all your entries are correct, no money can 
ever escape the system or be introduced into it without a complete record of it 
being shown in the journal.

The second example will be a sale. You will need one more account that we 
shall call Sales. In this example we will sell something for cash. Therefore the 
second set of entries will credit sales (where the money came from) and debit 
Cash (where it went to). 

As we enter more and more transactions it will become increasingly difficult 
to calculate our current cash balance (or for that matter our total sales). There-
fore we need a way of looking at each account separately. This is achieved 
by making exact copies of the entries in the journal to another book called the 
ledger. This is called posting. 

Posting
When posting you are not moving an entry, but making a copy of it some-
where else. Your original entries will always exist in the order you entered 
them in the journal.
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Posting is traditionally done at the end of each month but is entirely at your 
discretion - if you need to know what your sales figures are, then you will need 
to make sure all your transactions are entered in the journal and posted to all 
the relevant accounts in the ledger as we are about to see.

The Ledger
A ledger is just another book but with each page devoted to a single account. It 
is simply an alternative view of your journal entries - the journal entries are in 
date order, the ledger is a re-arrangement of the journal in account order.

The important thing to remember is that all your transactions are entered in 
the journal first. The ledger merely contains copies of them re-arranged by 
account.

Just like the journal, most businesses will use more than one ledger, each 
devoted to a certain aspect of the business and each given a different name to 
reflect this (e.g. 'Sales Ledger' and 'Purchase Ledger'), but whatever the case, 
a single general ledger will always be opened. This is called the Nominal 
Ledger (called the General Ledger in the US).

Although it is termed 'nominal' for reasons which will become clear later, it 
is nevertheless important to realise that it is the main ledger of a business (i.e. 
where other ledgers are also in use, the final balance of those ledgers will also 
be held in the nominal ledger). Therefore, the nominal ledger will hold the full 
picture of a business however many other ledgers are used.

In order to post (i.e. make copies of) the entries from the journal we must 
draw up a list of the accounts used so far and give each one its own page in 
the ledger.

We need three accounts at this stage: a cash account, a petrol account and a 
sales account.

The layout of each account in the ledger is identical to the journal with the 
exception that the 'account' column is no longer required - we are looking 



Business Accountz User Manual

265

at the entries of just one account so it can be included as the title of the page 
instead.

Once we have posted our entries into the ledger we can then begin to see how 
the business is doing.

Posted entries are exact copies of the original. If the entry was a debit entry 
in the journal then it is also a debit entry in the ledger. Although we can now 
see the relevant entries we don't yet know what the balance is; furthermore we 
don't know whether that balance means we have a surplus or a deficit of cash. 
To find out, follow this procedure: 

Start by adding up the debit and credit columns and show the totals on 
a new line.

Subtract one from the other to get the balance using the following rules: 

If the debit total is greater: the balance=debits-credits and the result is put 
in the debit column.

If the credit total is greater: the balance=credits-debits and the result is 
put in the credit column.

In other words, we are always going to get a positive balance, and it will 
always be placed under the highest total (this is the reason the columns 
were totalled first).

Because the balance of every account is always expressed as a positive value 
it doesn't tell us where we stand in relation to it (e.g. do we have a surplus of 
cash or is it overdrawn?).

We can overcome this by applying our from/to guide again (from=credit and 
to=debit). If the balance is in the debit column, then we have a positive cash 
balance (more money has gone to it than from it). If it shows a credit balance 
then it is overdrawn.

1.

2.

•

•

•
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How does it apply to the sales account? If it has a credit balance, then we have 
positive sales. Where has the money come from? Sales. And finally, look at 
the petrol account. Where has the money gone to? Petrol

The next step is to check that all the journal entries have been posted correctly 
to the ledger. This is called a trial balance.

The Trial Balance
The trial balance is a complete list of your account balances from the ledger. 
The layout is similar to the ledger except that only three columns are required: 
the account name and a debit and credit column.

Just the final balance line of each account is copied into the trial balance using 
the debit column if the account has a debit balance, or the credit column if the 
account has a credit balance.

The debit and credit columns are then totalled and checked that they match 
each other to satisfy the first rule of accounting (all the debits must equal the 
credits).

If they are not equal to each other it is proof that a mistake has been made. An 
audit is then carried out to find the error.

An audit simply means going through each entry in the journal to check that 
it matches the original paperwork (this is called an audit trail). If no error is 
found then it must be due to a mistake when posting the entries to the ledger. 
The audit then continues by checking each journal entry against the ledger 
entries.

OK, so lets discover if the business is making a profit or a loss. 

The Profit and Loss Account
The Profit and Loss account (aka P&L), as its name implies, tells us whether 
we are making a profit or a loss: are we earning more money than we are 
spending? (a profit), or vice-versa (a loss).
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The layout of the P&L account is just like any other account. To compile the 
P&L account copy the balances of the sales and expense accounts into it. We 
can then use our from/to guide on the resulting balance to determine if a profit 
or loss has been made. If more money has come from sales than has gone to 
expenses, we have made a profit. That is, if the credit side is greater than the 
debit side we have made a profit.

Having established the P&L account we must do one more thing: take a look 
at the business as a whole. For this we need to prepare the balance sheet. 

The Balance Sheet
We can now look at the main equation of a double-entry system which will 
show that the first rule of accounting (the debits must equal the credits) not 
only applies to each transaction but continues right up to the main financial 
statement of the business; the balance sheet.

The P&L account reflects the balance of a specific area of your business over 
a particular period of time. The balance sheet reflects the current balance of 
everything since the business began.

The ledger holds this information, so like the trial balance we can compile 
the balance sheet by copying all the account balances into a report. The only 
difference is that the accounts are re-arranged to show what the business owns 
and what it owes. These are broken down into 3 groups:

Assets
These are the things the business owns. They are usually broken down into 
two groups: Current Assets and Fixed Assets.

Current assets include money in the bank, petty cash, and money owed to the 
business by its customers.

Fixed assets include capital items like business premises (assuming they are 
not rented), company cars and office equipment.
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Liabilities
These are the things the business owes to third parties. They too are usually 
broken down into 2 groups: Current Liabilities (e.g. overdraft at the bank) and 
Fixed Liabilities (e.g. Long Term Loans).

Equity
Equity represents what the business owes to the owner of the business. This 
includes money paid for shares or capital introduced, any profits (or losses) 
brought forward from previous years as well as the current balance from this 
year's P&L.

These three groups make up what is known as the accounting equation:

Assets = Liabilities + Equity

Easily remembered by those who like a pint with the acronym: ALE.

Just like any mathematical equation a balance sheet can be re-arranged in any 
order you like:

Equity = Assets - Liabilities

Liabilities = Assets - Equity

Probably the most useful view is Equity. Since equity is what the business 
owes its owners, it represents the value of the business from the owners point 
of view. If this were your personal accounts, it would be your net worth.

Compiling a balance sheet is just more of what we have been doing so far; 
rearranging account balances by copying them into a different order. Assets 
first (bank balances, cash balances, debtors, unsold stock, buildings and com-
pany vehicles), then Liabilities (overdrafts, creditors, loans, mortgages), then 
Equity (P&L, Paid-up share capital, profit or losses brought forward from 
previous years). The Assets will have a debit balance, the liabilities (including 
equity) will have a credit balance. Add the two resulting columns up and they 
should both have the same balance.
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Although this is a very simplified view of accounting from an initial transac-
tion right through to its effect on a balance sheet, it shows just how simple the 
process really is. Before computers came along, the whole process was carried 
out manually exactly as above. Early software emulated this process, mak-
ing things only marginally quicker by automatically adding columns. Modern 
software takes things a stage further by eliminating the need to post anything. 
All you need to enter are the original transactions.
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